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About This Guide and Your Product 
This guide contains information and instructions necessary for the installation and configuration of the 
Scalar® i6000.

This guide is intended to be used by Quantum professional services and service personnel who will service 
the library.

Product Safety Statements

This product is designed for data storage and retrieval using magnetic tape. Any other application is not 
considered the intended use. Quantum will not be held liable for damage arising from unauthorized use of 
the product. The user assumes all risk in this aspect.

This unit is engineered and manufactured to meet all safety and regulatory requirements. Be aware that 
improper use may result in bodily injury, damage to the equipment, or interference with other equipment.

Note Be sure to read all operating instructions in this manual and in the System, Safety, and 
Regulatory Information Guide before operating this product.

CAUTION
Do not obstruct the top or bottom airflow by placing objects above or 
below the library. Do not cover ventilation areas on the library.

Do not expose the library to moisture or store the library in 
temperatures higher than 60°C (140°F) or extremely low 
temperatures. For information about operating temperatures and 
humidity, see the Scalar i6000 Planning Guide.

WARNING
CREATING A HIGH LEAKAGE CURRENT EARTH CONNECTION IS 
ESSENTIAL BEFORE YOU CONNECT THE POWER SUPPLY.

WARNING
BEFORE POWERING ON OR USING THIS EQUIPMENT, READ THE 
SYSTEM, SAFETY, AND REGULATORY INFORMATION GUIDE. KEEP 
THE GUIDE FOR FUTURE REFERENCE.
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Mechanical Locks
The access and service doors can only be opened with a key. The key should be kept by an authorized 
person at your company. Access to the interior of the library is both a data integrity and a safety issue.

Door Interlock Switches
Door interlock switches detect when the access door has been opened and automatically remove power 
from the picker.

Power Button on the Library’s Indicator Panel
Switching off the Power button on the indicator panel, located on the front of the library, removes power 
from the electronics, which causes the picker to stop immediately. This button also removes power from the 
drives.

Physically Accessing the Library
The library is completely enclosed in a housing that serves as a guard, separating the danger area of the 
library from the normal working area. You can access the internal components of the library through the 
access and service doors only. When the library is powered on, the interlock on the access door is active.

WARNING
DOOR INTERLOCK SWITCHES ARE PROVIDED FOR YOUR SAFETY. 
YOU SHOULD NOT INTERFERE WITH THEIR NORMAL OPERATION.

WARNING
THIS POWER BUTTON FUNCTIONS AS A POWER INTERRUPT ONLY. 
TO COMPLETELY REMOVE ALL POWER BEFORE SERVICING OR IN 
AN EMERGENCY, TURN OFF THE CIRCUIT BREAKER ON THE 
POWER DISTRIBUTION UNIT, AND THEN DISCONNECT THE POWER 
CORD FROM THE ELECTRICAL SOURCE.

WARNING
MOVEMENTS OF MECHANICAL PARTS IN THE LIBRARY CAN CAUSE 
SERIOUS INJURY OR DEATH. ACCESS TO INTERNAL LIBRARY 
COMPONENTS IS RESTRICTED TO AUTHORIZED PERSONNEL. DO 
NOT ENTER THE LIBRARY UNLESS YOU ARE AUTHORIZED BY 
YOUR COMPANY AND TRAINED ON HOW TO ENTER THE LIBRARY 
SAFELY.

WARNING
WHEN DRIVE SLED POSITIONS ARE EMPTY, DRIVE COVER PLATES 
MUST BE INSTALLED AND IN PLACE AT ALL TIMES TO PREVENT 
ACCESS INTO THE EMPTY DRIVE SLED POSITIONS.
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Authorized persons can access the library only when one or more of the following conditions are true:

• The library has been taken offline and the Robotics Enabled button on the library’s indicator panel 
has been turned off.

• The access door has been opened.

• The Power button on the Library’s indicator panel has been turned off.

• The AC line cord has been disconnected from the main power source.

Performing Mechanical Maintenance
Observe the following safety guidelines while performing maintenance on the library.

General Guidelines
Before you begin performing maintenance on the library, perform the following tasks:

• Locate escape routes and emergency exits, and clear them of obstacles.

• Identify a safe location for library components and other parts that you will remove from the library. 
Unauthorized persons should not have access to this location.

• Have a plan to keep components and equipment clean during work. Maintaining a clean working 
environment promotes safety.

Clothing must be in compliance with the following safety guidelines:

• Clothing must not have metal fasteners.

• Clothing must be close-fitting so that it cannot be caught in moving machine parts.

• Long sleeves must be buttoned up or rolled up.

• Scarves must be removed or the ends must be tucked into other clothing.

• Long hair must be fully covered.

• Remove watches, rings, jewelry, badges, and other items that could get caught in or damage 
equipment.

Wear safety glasses when you do any of the following tasks:

• Use a safety drill.

• Work on springs, retaining rings, and so forth.

• Solder or work on cables.

• Clean with chemical agents.

• Perform any other work that could endanger the eyes.

Wear safety shoes when handling heavy components.

Before you begin work and after you finish, be careful to remove or reinstall all safety provisions as 
appropriate (covers, hazard alert messages, warning signs, grounding wires, and so forth).

WARNING
THE AC POWER CORD MUST BE INSTALLED NEAR THE LIBRARY 
AND MUST BE EASILY ACCESSIBLE AT ALL TIMES.
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Working on Live Components

When performing work on live parts, observe the following guidelines:

• Be thoroughly familiar with accident prevention rules.

• Use only suitable tools and measuring devices in good working condition.

• Verify that measuring devices are adjusted correctly and operating within specified measuring 
ranges.

• Work with only one hand, which can prevent internal injuries if electrical shock occurs.

• Avoid contact with conducting floors (especially metal) or equipment parts, covering the working 
area with suitable protective rubber mats if necessary.

Mercury Statement

WARNING
CONTACT WITH ELECTRICAL PARTS CAN CAUSE ELECTRICAL 
SHOCK, RESULTING IN POSSIBLE SEVERE OR FATAL BURNS AND 
INTERNAL INJURY. A PERSON WHO COMES INTO CONTACT WITH A 
LIVE PART OFTEN CANNOT BREAK LOOSE FROM THE PART. A 
SECOND PERSON MUST STAND NEAR THE MAIN CIRCUIT 
BREAKER, READY TO IMMEDIATELY SWITCH IT OFF IF A 
HAZARDOUS SITUATION OCCURS.

NEVER ASSUME THAT A CIRCUIT IS WITHOUT POWER. ALWAYS 
CHECK THE CIRCUIT. WHEN WORKING ON AC POWER 
COMPONENTS, ANOTHER PERSON MUST SUPERVISE YOUR WORK.

THIS SYSTEM HAS MORE THAN ONE POWER SUPPLY CABLE. TO 
REDUCE THE RISK OF ELECTRICAL SHOCK, DISCONNECT ALL 
POWER SUPPLY CABLES WHEN PERFORMING SERVICE 
PROCEDURES THAT REQUIRE POWER TO BE TURNED OFF.

Projectors, LCD displays, and some multifunction printers may use lamp(s) that 
contain a small amount of mercury for energy-efficient lighting purposes. Mercury 
lamps in these products are labeled accordingly. Please manage the lamp 
according to local, state, or federal laws. For more information, contact the 
Electronic Industries Alliance at www.eiae.org. For lamp-specific disposal 
information check www.lamprecycle.org.
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Disposal of Electrical and Electronic Equipment

This symbol on the product or on its packaging indicates that this product should 
not be disposed of with your other waste. Instead, it should be handed over to a 
designated collection point for the recycling of electrical and electronic equipment. 
The separate collection and recycling of your waste equipment at the time of 
disposal will help to conserve natural resources and ensure that it is recycled in a 
manner that protects human health and the environment. For more information 
about where you can drop off your waste equipment for recycling, please visit our 
Web site at: http://qcare.quantum.com or contact your local government authority, 
your household waste disposal service or the business from which you purchased 
the product.
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Product Model Number

The Scalar i6000 Regulatory Model Numbers are as follows: 

SCi2000 Control Model

SCi2000 Expansion Model.

Explanation of Symbols and Notes

The following symbols appear throughout this document to highlight important information.

Other Documents you Might Need

The following documents are also available for this product. These documents can be found on the product 
CD or at www.quantum.com/support.

• Scalar i6000 Planning Guide (6-66882-01

• Scalar i6000 Release Notes i8 (6-66883-01)

• Scalar i6000 User’s Guide (6-66879-01)

• Scalar i6000 Unpacking Instructions (6-66934-01)

• Scalar i2000/i6000 Maintenance Guide (6-66880-01)

• System, Safety, and Regulatory Information Guide (6-00618-11)

WARNING
INDICATES A POTENTIALLY HAZARDOUS SITUATION WHICH, IF NOT 
AVOIDED, COULD RESULT IN DEATH OR BODILY INJURY.

CAUTION
Indicates a situation that may cause possible damage to equipment, loss of 
data, or interference with other equipment.

Note Indicates important information that helps you make better use of your system.

Note Release Notes are also available for this product. The Release Notes describe changes 
to your system or firmware since the last release, provide compatibility information, and 
discuss any known issues and workarounds. The Release Notes can be found in the 
product box or at www.quantum.com/support
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Getting More Information or Help

More information about this product is available on the Service and Support Web site at  
www.quantum.com/support. The Service and Support Web site contains a collection of information, 
including answers to frequently asked questions (FAQs). You can also access software, firmware, and 
drivers through this site.

For further assistance, or if training is desired, contact Quantum:

For the most updated information on Quantum Global Services, please visit: www.quantum.com/support

Global Call Handling: 1-800-284-5101

For additional contact information: www.quantum.com/support

To open a Service Request: www.quantum.com/osr
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Getting Started
This chapter describes how to get started with setting up the library. The information includes:

• Unpacking and Inspecting on page 9

• Checking the Accessories on page 10

• Initial Setup Procedure Road Map on page 11

• Required Tools on page 13

• Illustrations of Modules on page 14

Unpacking and Inspecting

Use the instructions supplied with the library to unpack. All boxes packed around the library on the pallet 
contain parts needed to install the library. When you remove the packing material from the parts in the base 
of the module, put the parts in a safe area so they will not get damaged or lost.

Make sure you have read the Scalar i6000 Planning Guide before you start the installation procedure.

Two silver and two gold keys are shipped with each module. The gold keys (FRU ID 401) open the service 
door. The silver keys (FRU ID 402) work on both the access and service doors. All modules are keyed the 
same, so there is no chance that a customer who has two or more modules could end up with different keys. 
All keys are to be left with the customer.

Note Access to the interior of the library is both a data integrity and a safety issue.
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Checking the Accessories

The library can be ordered in different configurations. Based on your configuration, check to make certain 
that the following items are included with the library and that none of them are damaged.

Libraries with native SCSI drives:

• Ordered number of SCSI LVD drives

• One terminator

• One library power cord (two power cords if you ordered redundant power supplies)

Libraries with native Fiber Channel (FC) drives:

• Ordered number of native FC drives

• One library power cord

Libraries with I/O management unit with FC drives:

• Ordered number of FC drives 

• FC I/O blades (1 per 4 drives)

• Optional 2m optical cable (one per drive, connects drive to FC I/O blade)

• 30m multi-mode optical cables LC-LC (two per FC I/O blade, connects FC I/O blade to SAN)

• One library power cord

Libraries with Ethernet Expansion blades with LTO-5 drives:

• Ordered number of LTO-5 drives

• Ethernet Expansion blade (1 per 6 drives)

• One shielded Ethernet cable per drive

Library field service kit (delivered with each control module):

• Ethernet crossover cable (RJ45 to RJ45)

• Service kit

• Velcro cable clamps (3)

• Velcro hook and loop straps (2)

• Electrostatic discharge (ESD) wrist strap

Library documentation (delivered with each control module):

• CD-ROM that contains online versions of documentation

• Scalar i6000 Installation Guide (this manual)

• Scalar i6000 Unpacking Instructions

• Scalar i6000 Release Notes
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Initial Setup Procedure Road Map

This section provides a road map for initial installation of a library. A library includes one control module and 
may include up to eleven expansion modules. The proper sequence for setting up a library is illustrated in 
the following flowchart. Pointers to the instructions are provided to the right of the flowchart.

start

prepare and
inspect library

install

add expansion
module

Getting Started on page 9, describes how to prepare and 
inspect the library. You will use the instructions supplied 
with the modules to perform the unpacking procedures.

Installing a Stand-Alone Control Module on page 19, 
provides instructions for installing the control module. 
Each configuration must contain one control module.

Preparing to Install a New Multi-Module Library on 
page 28 and Adding an Expansion Module to an 
Existing System Unit on page 36 contain the 
instructions for installing a control module and up to a 
total of eleven expansion modules.

install tape
drives and

Installing Drives and Blades on page 97 provides 
instructions for installing and connecting the tape 
drives in the drive modules.

Applying Power on page 93, contains instructions for 
applying power to your library.

turn on power

blades

A

type
of

installation?

install new

stand-alone
control module

multi-module
library

Adding an Expansion Module to an Existing System 
Unit on page 36 contains the instructions for adding 
expansion modules to an existing library, up to a total 
of eleven expansion modules.
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A

verify the 
hardware

configure library

configuration

Verifying the Hardware Installation on page 307 has 
the procedure you should use to verify the hardware 
configuration. Installation Verification Test Overview 
on page 309 must also be performed.

Configuring the Library on page 153 tells you how to 
set up the library.

Installing Cartridges on page 131 gives the 
instructions for installing the cartridges in the two 
supported methods.

install

Completing the Installation Verification Checklist on 
page 332, provides a checklist that helps you 
determine if all necessary steps have been completed 
during the installation of the library.

complete the 
installation
checklist

cartridges

done

add 
optional 

hardware?
Adding Optional Hardware on page 231 provides 
instructions for the following optional hardware:

yes

no

install optional
hardware
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Required Tools

Table 1 provides a list of the tools needed to install a library.

Table 1 Required Tools for Installing a Library

Tool Type Tool Sizes

Open end wrenches • 24 mm 
• 16 mm 
• 13 mm 
• 8 mm 
• 7 mm

Hex wrenches • 6 mm 
• 4 mm
• 3 mm
• 2.5 mm
• 2 mm

Screw drivers • #1 Phillips
• #2 Phillips
• Flat head

Pliers and wire cutters • Needle nose pliers
• Standard pliers
• Wire cutters

Nut drivers • 8 mm
• 7 mm

Miscellaneous tools • Measuring tape
• Laptop computer
• Digital volt meter
• Digital level
• X-axis rail alignment tool (part number 3-00147-01)
• ESD wrist strap
• Metric ruler
• Small zip ties (quantity 100)
• Flashlight
Scalar i6000  Installation Guide 13



Illustrations of Modules

An illustration of an 8-module configuration along with figures of the front and back of both the control 
module and expansion modules are shown on the following pages.

Figure 1 Front View of an 8-Module Library

control module

expansion modules
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Figure 2 Front View of a Two-Module Library

expansion module

control module

access door

service door

I/E station

top cable entry

touch screen

indicator panel

fire suppressant access
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Figure 3 Control Module, Front View Component Location

fire suppressant access

magazine

access door

I/E station

picker

drive sled

leveling foot
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Figure 4 Control Module, Rear View Component Location

top cable entry

power supplies

drive clusters

bottom cable entry

power distribution units

library
management
module

I/O management
unit

service door
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Figure 5 shows the back of an expansion module. Only expansion modules that contain drives will be 
delivered with power supplies, which enables them to support the tape drives. Expansion modules in 
positions 9 -12 are LTO storage-only modules.

Figure 5 Expansion Module, Back View Component Location

the I/O management unit
is installed and blades are

power chassis are

the library management
module is not installed
in expansion modules

drives are installed
in these clusters

installed only when
required to support drives

installed only if there
are drives in the 
expansion modules
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Installing a Stand-Alone Control Module
This chapter describes how to install a stand-alone control module. To install a new multi-module library or 
add expansion modules to an existing control module or multi-module library, see Installing a Multi-Module 
Library on page 27.

To install a stand-alone control module, complete the following procedures:

• Positioning the Stand-Alone Control Module on page 20

• Lowering the Leveling Legs on page 20

• Raising the Control Module Off the Casters on page 21

• Testing the Digital Level on page 22

• Verifying Level Condition on page 23

• Additional Leveling on page 24

• Setting the Leg Lock Nuts on page 25

Required tools:

• 24 mm open end wrench

• 16 mm open end wrench

• 6 mm hex wrench

• Digital level
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Positioning the Stand-Alone Control Module

The first steps in setting up a stand-alone control module involve locating and positioning the control 
module. For more information on location specifications, see the Scalar i6000 Planning Guide.

1 Verify the placement of the control module.

2 Verify the following:

• There is an AC outlet within 10 feet (3.05 m) of the control module’s location.

• There is adequate clearance for the access and service doors.

• The selected location is level using the instructions in Verifying the Level of the Install Location on 
page 321.

• All raised floor tiles have been cut out accordingly to accommodate the power, SCSI, Fibre, and 
Ethernet cables to the control module.

3 Position the control module in its intended location.

4 Verify that the control module is positioned correctly.

5 Ensure that the leveling legs are not resting on tiles that will need to be raised to accommodate cables 
after the control module has been installed.

Lowering the Leveling Legs

Required tools: 24 mm open end wrench, 6 mm hex wrench or 16 mm open end wrench.

1 Use the 24 mm open end wrench to loosen the four locking nuts on the four corner legs.

2 Lower the four corner legs by hand until they touch the floor. 

You may have to use the 6 mm hex wrench or 16 mm open end wrench to turn the legs if the threads 
do not turn freely.

CAUTION
If you do not loosen the locking nuts, you may strip the threads on the 
leveling legs during movement.

Note To ensure even weight distribution on the legs, it is very important that all 
legs be brought into contact with the floor without lifting the module. 
You can verify whether a leg is in contact with the floor by attempting to 
slide a piece of paper underneath it.
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Raising the Control Module Off the Casters

Required tools: 6 mm hex wrench or 16 mm open end wrench

1 Open the access and service doors of the control module.

2 Using the 6 mm hex wrench or 16 mm open end wrench, raise the control module at each of the four 
corner legs seven (7) half turns after initial contact with the floor.

During this process one or two leveling legs may raise off of the floor. This is not a concern. Even if a 
leg is lifted off the floor, only give that leveling leg seven (7) half turns. This should raise the whole 
control module off of the casters seven (7) half turns.

3 Check each corner leg to ensure that there is pressure on the foot and you cannot turn it by hand.

• If you have correctly given each corner leg seven (7) half turns you should not be able to turn the 
feet by hand.

• If you can turn one of the feet by hand, lower the control module back onto the casters and restart 
this procedure at Lowering the Leveling Legs on page 20. The goal is to have the control module 
weight evenly distributed across all four leveling legs when it is properly raised. The module may or 
may not be level at this time.

Note Making a mark on the top of the leg will help you keep track of the half 
turns.

leveling foot

leveling leg

make mark here to keep
track of seven half turns
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Testing the Digital Level

Required tools: digital level

Perform this test before each use of the digital level and any time the digital level has been dropped or is 
being used in an environment that varies ±9°F from the environment in which it was last calibrated. If the 
digital level fails the accuracy test you must re-calibrate the level before use.

1 Turn on the level by pushing the ON/OFF button. Position the level with the display facing you and the 
text on the face of the level right-side up. Ensure that the level is on a clean, flat, and horizontal surface. 
This surface does not have to be exactly level. Wait 10 seconds for the level to completely settle and 
take note of the angle on the display.

2 Rotate the level end-for-end so the display is facing away from you. The screw on the back of the level 
should be on the left side. Be sure to set the level in the exact spot as in Step 1. Wait 10 seconds for 
the level to completely settle and take note of the angle on the display.

3 Roll the level toward you so that the display is facing you, but the lettering on the face of the unit is 
upside down. Be sure to set the level in the exact spot as in Step 1. Wait 10 seconds for the level to 
completely settle and take note of the angle on the display.
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4 Rotate the level end-for-end so the display is facing away from you. The screw on the back of the level 
should be on the right side. Be sure to set the level in the exact spot as in Step 1. Wait 10 seconds for 
the level to completely settle and take note of the angle on the display.

5 Compare the level display readings that you captured from Steps 1 through 4. If any of the four readings 
vary from one another more than 0.1 degree, you must re-calibrate the level. For more information, see 
Calibrating the Digital Level on page 339. If the variance between the readings are within the 0.1 degree 
limit, the level is within compliance and is ready to be used.

Verifying Level Condition

Required tools: digital level

1 Verify the module is level front to back and left to right by placing the digital level at the following 
locations:

 a. Inside the access door

 b. Inside the service door

 c. On the left side inside the access door

A reading on the digital level that is 0.00 +/- 0.30 is to be considered level. 

If the module does not meet the 0.00 +/- 0.30 leveling requirement, go to Additional Leveling on page 
24. If the module is sufficiently level, go to Setting the Leg Lock Nuts on page 25.

Note Make sure the digital level is not resting on any frame welds or debris that 
would cause an inaccurate reading. To find the small circular frame welds, 
run your finger tips over the spot where you are going to place the level

placements of level 
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Additional Leveling

Customer floors may be such that further leveling is required. The goal in leveling the control module is to 
adjust the leveling legs to achieve a digital level reading that is 0.00 +/- 0.30.

1 Place the digital level inside the access door. Use the following rules when leveling from left to right:

• Rule 1: Always make your leveling adjustments to raise the control module (turn the legs clockwise 
looking from the top).

• Rule 2: Since the control module frame is very stiff, adjust the appropriate left or right leg pair the 
same amount when leveling left to right.

• Rule 3: Use small adjustment increments; no more than one half (½) turn at a time.

• Rule 4: If the leveling adjustment has raised any of the other leveling legs off the floor, take out the 
adjustment and work on the opposite end of the control module (front to back).

• Rule 5: Wait at least 10 seconds for the digital level to settle between adjustments.

2 Place the level on the left side inside the access door. Use the following rules when leveling from front 
to back:

• Rule 1: Always make your leveling adjustments to raise the control module (turn the legs clockwise 
looking from the top).

• Rule 2: Since the control module frame is very stiff, adjust the appropriate front or rear leg pair the 
same amount when leveling front to back.

• Rule 3: Use small adjustment increments; no more than one half (½) turn at a time.

• Rule 4: If the leveling adjustment has raised any of the other leveling legs, take out the adjustment 
and work on the other side.

• Rule 5: Wait at least 10 seconds for the digital level to settle between adjustments.

Note Make sure the digital level is not resting on any frame welds or debris that 
would cause an inaccurate reading. To find the small circular frame welds, 
run your finger tips over the spot where you are going to place the level.

access doordigital level position #1

service door

digital level position #2
front to back

left to right
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Setting the Leg Lock Nuts

Required tools: 24 mm open end wrench

1 Verify that all four leveling legs are carrying load and that the control module does not rock.

2 Use the 24 mm open end wrench to raise the four leveling leg lock nuts to the top and tighten them 
against the welded nut.

Note Ensure that you do not take the leveling legs out of adjustment during this 
process.
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Installing a Multi-Module Library
This chapter describes how to install a new multi-module library and how to add expansion modules to an 
existing control module or existing multi-module library. 

To install a stand-alone control module, see Installing a Stand-Alone Control Module on page 19.

If you are installing a new multi-module library, see Preparing to Install a New Multi-Module Library on page 
28.

If you are adding an expansion module to an existing system unit, see Installing Expansion Modules after 
Installing the System Unit on page 37.

If you are adding one or more expansion modules to an existing control module, first go to Preparing an 
Existing Library to Receive an Expansion Module on page 74

Required tools:

• 24 mm open end wrench

• 16 mm open end wrench

• 13 mm open end wrench

• 8 mm nut driver or open end wrench

• 6 mm hex wrench

• 3 mm hex wrench

• 2.5 mm hex wrench

• X-axis alignment tool (part number 3-00147-01)

• digital level
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Preparing to Install a New Multi-Module Library

To prepare to install a new multi-module library, complete the following procedures:

• Attaching Control and Expansion Modules as System Units on page 28

• Testing the Digital Level on page 31

• Positioning the System Unit on page 30

• Verifying Level Condition on page 33

• Additional Leveling on page 34

• Setting the Leg Lock Nuts on page 35

Attaching Control and Expansion Modules as System Units
If you are installing four frames or less, you can bolt the frames together while the frames are on their 
casters, and then raise and level the frames as one system unit.

Aligning and Bolting the Frames
1 Using the corner edges of the frames as a rough alignment, position the frames together so the 

attachment bolt holes are aligned. 

Verify that the attachment holes are aligned. If necessary, adjust the frame legs to better align the 
attachment bolt holes.

2 Repeat the following steps for the front lower bolt, front upper bolt, back lower bolt, and back upper bolt, 
in that order: 

 a. Insert the attachment bolt from right to left into the attachment hole

 b. If the bolts do not slide smoothly into the holes, raise the appropriate leveling legs until they do.

 c. Once the bolts are inserted, loosely thread the nuts onto the bolts.

Note For older libraries, you may need to insert the back lower bolt from left to 
right. See Technical Bulletin 6-00925, “Change in Procedure for Joining 
i2000 Frames”.
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3 Tighten the bolts using the 6 mm hex wrench and the 13 mm open end wrench.

4 Once the frames are aligned and bolted properly together, proceed to Positioning the System Unit on 
page 30.

Note Do not overtighten the bolts. Overtightening can damage the vertical frame 
post structure.

front upper bolt

front lower bolt

back upper bolt

back lower bolt
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Positioning the System Unit
For more information on location specifications, see the Scalar i6000 Planning Guide.

1 Verify the placement of the system unit.

2 Verify the following:

• There is an AC outlet within 10 feet (3.05 m) of the control module’s location.

• There is adequate clearance for the access and service doors.

• All raised floor tiles have been cut out accordingly to accommodate the power, SCSI, Fibre, and 
Ethernet cables to any of the modules.

3 Position the system unit in its intended location.

4 Verify that the system unit is positioned correctly.

5 Ensure that the leveling legs are not resting on tiles that will need to be raised to accommodate cables 
after the system unit has been installed.

Lowering the System Unit Leveling Legs
Required tools: 24 mm open end wrench, 6 mm hex wrench or 16 mm open end wrench.

1 On only the four outer edge corner legs of the system unit, use the 24 mm open end wrench to loosen 
the four locking nuts.

2 Lower the four outer edge corner legs by hand until the legs touch the floor. You may need to use the 
6 mm hex wrench or 16 mm open end wrench to turn the legs if the threads do not turn freely.

Note The control module is at the left end of a multi-module library.

CAUTION
If you do not loosen the locking nuts, you may strip the threads on the 
leveling legs during movement.

Note To ensure even weight distribution on the legs, it is very important that the 
lowered legs be brought into contact with the floor without lifting the system 
unit. You can verify whether a leg is in contact with the floor by attempting 
to slide a piece of paper underneath it.
30 Installing a Multi-Module Library



Raising the System Unit Off the Casters
Required tools: 6 mm hex wrench or 16 mm open end wrench

1 Using the 6 mm hex wrench or 16 mm open end wrench, raise the entire system unit by only the four 
outer edge corner legs seven (7) half turns during the system raising process. If a leg is lifted off the 
floor, give only that leg seven (7) half turns. This should raise the entire system unit off of the casters 
seven (7) half turns.

2 Check each corner leg to ensure that there is pressure on the foot and you cannot turn it by hand.

• If you have correctly given each outer edge corner leg seven (7) half turns you should not be able 
to turn the feet by hand.

• If you can turn one or more of the feet by hand, lower the system unit back onto the casters and 
restart this procedure at Lowering the Leveling Legs on page 37. The goal is to have the system 
unit weight evenly distributed across all four outer edge leveling legs when it is properly raised. The 
system unit may or may not be level at this time.

Testing the Digital Level
Required tools: digital level

Perform this test before each use of the digital level and any time the digital level has been dropped or is 
being used in an environment that varies ±9°F from the environment in which it was last calibrated. If the 
digital level fails the accuracy test, you must re-calibrate the level before use.

1 Turn on the level by pushing the ON/OFF button. Position the level with the display facing you and the 
text on the face of the level right-side up. Ensure that the level is on a clean, flat, and horizontal surface. 

Note Making a mark on the top of the leg will help you keep track of the half 
turns. It is important to track the total number of turns, especially if you are 
installing additional expansion modules.

leveling foot

leveling leg

make mark here to keep
track of seven half turns
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This surface does not have to be exactly level. Wait 10 seconds for the level to completely settle and 
take note of the angle on the display.

2 Rotate the level end-for-end so the display is facing away from you. The screw on the back of the level 
should be on the left side. Be sure to set the level in the exact spot as in Step 1. Wait 10 seconds for 
the level to completely settle and take note of the angle on the display.

3 Roll the level toward you so that the display is facing you, but the lettering on the face of the unit is 
upside down. Be sure to set the level in the exact spot as in Step 1. Wait 10 seconds for the level to 
completely settle and take note of the angle on the display.

4 Rotate the level end-for-end so the display is facing away from you. The screw on the back of the level 
should be on the right side. Be sure to set the level in the exact spot as in Step 1. Wait 10 seconds for 
the level to completely settle and take note of the angle on the display.

5 Compare the level display readings that you captured from Steps 1 through 4. If any of the four readings 
vary from one another more than 0.1 degree, you must re-calibrate the level. For more information, see 
Calibrating the Digital Level on page 339. If the variance between the readings are within the 0.1 degree 
limit, the level is within compliance and is ready to be used.
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Verifying Level Condition
Required tools: digital level

1 In the control module only, verify the system unit is level front to back and left to right by placing the 
digital level at the following locations:

 a. Inside the access door

 b. On the left side inside the access door

A reading on the digital level that is 0.00 +/- 0.30 is to be considered level.

If the module does not meet the 0.00 +/- 0.30 leveling requirement, go to Additional Leveling on page 
34.

If the module is sufficiently level, go to Lowering All Other Leveling Legs on page 35.

Note Make sure the digital level is not resting on any frame welds or debris that 
would cause an inaccurate reading. To find the small circular frame welds, 
run your finger tips over the spot where you are going to place the level

placements of level 
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Additional Leveling
Customer floors may be such that further leveling is required. The goal in leveling the system unit is to adjust 
the leveling legs to achieve a digital level reading that is 0.00 +/- 0.30.

1 Place the digital level inside the control module access door (positions 1). Use the following rules when 
leveling from left to right:

• Rule 1: Always make your leveling adjustments to raise the system unit (turn the legs clockwise 
looking from the top).

• Rule 2: Since the frames are very stiff, adjust the appropriate left or right leg pair the same amount 
when leveling left to right.

• Rule 3: Use small adjustment increments; no more than one half (½) turn at a time.

• Rule 4: If the leveling adjustment has raised any of the other leveling legs off the floor, take out the 
adjustment and work on the opposite end of the system unit (front to back).

• Rule 5: Wait at least 10 seconds for the digital level to settle between adjustments.

2 Place the level on the left side inside the control module access door (position 2). Use the following rules 
when leveling from front to back:

• Rule 1: Always make your leveling adjustments to raise the system unit (turn the legs clockwise 
looking from the top).

• Rule 2: Since the frames are very stiff, adjust the appropriate front or rear leg pair the same amount 
when leveling front to back.

• Rule 3: Use small adjustment increments; no more than one half (½) turn at a time.

• Rule 4: If the leveling adjustment has raised any of the other leveling legs, take out the adjustment 
and work on the other side.

• Rule 5: Wait at least 10 seconds for the digital level to settle between adjustments.

Note Make sure the digital level is not resting on any frame welds or debris that 
would cause an inaccurate reading. To find the small circular frame welds, 
run your finger tips over the spot where you are going to place the level.

access doordigital level position #1

service door

digital level position #2
front to back

left to right
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Lowering All Other Leveling Legs
1 Lower all remaining frame leveling legs until the legs touch the floor.

2 To support the weight of the system, give each non-leveling leg 1/4 turn.

3 Check all leveling legs to verify that all the legs are on the floor.

4 Use the digital level to double-check the levelness of the library.

Setting the Leg Lock Nuts
Required tools: 24 mm open end wrench

1 Verify that all leveling legs are carrying load and that the system unit does not rock.

2 Use the 24 mm open end wrench to raise the leveling leg lock nuts to the top and tighten them against 
the welded nut.

If you are installing additional expansion modules to the system unit, proceed to Adding an Expansion 
Module to an Existing System Unit on page 36.

Proceed to Attaching the X-Axis Rails on page 41.

Note Ensure that you do not take the leveling legs out of adjustment during this 
process.
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Adding an Expansion Module to an Existing System Unit

If you are adding one or more expansion modules to an existing library, first go to Preparing an Existing 
Library to Receive an Expansion Module on page 74, prior to completing the procedures below. 

To add an expansion module to an existing system unit during a new installation process, complete the 
following procedures:

• Installing Expansion Modules after Installing the System Unit on page 37

• Positioning the New Expansion Module on page 37

• Lowering the Leveling Legs on page 37

• Aligning the New Expansion Module with the System Unit on page 39

• Inserting the Attachment Bolts on page 39

• Tightening the Attachment Bolts on page 40

• Setting the Leg Lock Nuts on page 40

• Attaching the X-Axis Rails on page 41

• Attaching and Aligning the Upper and Lower X-Axis Rails on page 41

• Attaching the Middle X-Axis Rail on page 43

• Aligning the Middle X-Axis Channel on page 45

• Aligning the Middle X-Axis Rail on page 46

• Verifying the Middle X-Axis Rail Alignment on page 47

• Attaching the Tensioner Bracket and Hard Stop on page 50

• Installing the X-Axis Belt on page 53

• Installing the X-Axis Chain Assembly on page 58

• Installing the X-Axis Chain Trough on page 63

• Assembling the Last Expansion Module on page 70
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Installing Expansion Modules after Installing the System Unit
Only use the following procedures if you are adding expansion modules to a newly installed system unit (a 
system unit consists of four or less frames). For more information on system units, see Attaching Control 
and Expansion Modules as System Units on page 28.

Positioning the New Expansion Module
The first steps in adding a new expansion module to a system unit involve locating and positioning the 
expansion module. For more information on location specifications, see the Scalar i6000 Planning Guide.

Required tools: none

1 Position the expansion module next to the last module in the system unit.

2 Verify the following:

• There is adequate clearance for the access and service doors.

• All raised floor tiles have been cut out accordingly to accommodate the power, SCSI, Fibre, and 
Ethernet cables to any of the modules.

3 Verify that the expansion module is positioned correctly.

4 Ensure that the leveling legs are not resting on tiles that will need to be raised to accommodate cables 
after the expansion module has been installed.

Lowering the Leveling Legs
Required tools: 24 mm open end wrench, 6 mm hex wrench or 16 mm open end wrench.

1 Use the 24 mm open end wrench to loosen the four locking nuts on the four corner legs.

2 Lower the legs by hand until the pads touch the floor. You may need to use either a 6 mm hex wrench 
or 16 mm open end wrench to turn the legs if the threads do not turn freely.

Note A label placed on the floor in the rear of the expansion module shows the order 
in which to place the module.

CAUTION
If you do not loosen the locking nuts, you may strip the threads on the 
leveling legs during movement.

Note To ensure even weight distribution on the legs, it is very important that all 
legs be brought into contact with the floor without lifting the module. 
You can verify whether a leg is in contact with the floor by attempting to 
slide a piece of paper underneath it.
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Raising the Expansion Module Off the Casters
Required tools: 6 mm hex wrench or 16 mm open end wrench

Use either the 6 mm hex wrench or 16 mm open end wrench to raise each of the four corner legs of the 
module seven (7) half turns. If a leg is lifted off the floor, give only that leg seven (7) half turns. This 
should raise the entire module off of the casters seven (7) half turns, unless the turn count was different 
during the CM installation. If you know the CM installation turn count, use that count.

3 Check each leg to ensure that there is pressure on the foot and you cannot turn it by hand. 

• If you have correctly given each leg seven (7) half turns, you should not be able to turn any of the 
feet by hand.

• If you can turn one or more of the feet by hand, lower the module back onto the casters and restart 
this procedure at Lowering the Leveling Legs on page 37. The goal is to have the module weight 
evenly distributed across all four leveling legs when it is properly raised. The module may or may 
not be level at this time.

Note Making a mark on the top of the leg will help you keep track of the half 
turns. 

leveling foot

leveling leg
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Aligning the New Expansion Module with the System Unit
Modules use a four-bolt attachment method with close-clearance 8 mm bolt holes. The tight clearances 
allow the bolts to act as module-to-unit alignment pins.

1 Push the new expansion module toward the system unit until the frames touch.

2 Adjust the expansion module leveling legs until the frame corners and the attachment bolts are aligned.

Inserting the Attachment Bolts
1 Verify that the adjacent sides of the receiving unit and the new expansion module are parallel. 

If not, adjust the leveling legs on the opposite side of the new module until the adjacent sides are 
parallel. Be sure to turn the front and back legs the same number of turns.

2 Verify that the attachment holes are aligned. If not, adjust the leveling legs of the new module until the 
attachment holes align. Be sure to turn the front and back legs the same number of turns.

 a. Repeat these steps for the front lower bolt, front upper bolt, back lower bolt, and back upper 
bolt, in that order:  
Insert the attachment bolt from right to left into the attachment hole

.

 b. If the bolt does not slide smoothly into the hole, raise or lower the leveling legs until it does.

 c. Once the bolt is inserted, loosely thread the nut onto the bolt. Do not tighten the nut.

Note For older libraries, you may need to insert the back lower bolt from left to 
right. See Technical Bulletin 6-00925, “Change in Procedure for Joining 
i2000 Frames”.

front upper bolt

front lower bolt
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Tightening the Attachment Bolts
Once the bolts have been inserted, tighten the bolts using the 6 mm hex wrench and the 13 mm open end 
wrench.

If this is the last new expansion module, go to Setting the Leg Lock Nuts on page 40.

If you are installing a seventh or eighth module, go to Installing the X-Axis Chain Trough on page 63. 
 
To install additional expansion modules, repeat these procedures, Installing Expansion Modules after 
Installing the System Unit on page 37, for each additional expansion module. 

For libraries with seven or eight modules, see Installing the X-Axis Chain Trough on page 63.

Setting the Leg Lock Nuts
Required tools: 24 mm open end wrench

1 Verify that all legs are carrying load and that the library does not rock. 

2 Use the 24 mm open end wrench to raise all of the leveling leg lock nuts to the top and tighten them 
against the welded nut.

 

Note Do not overtighten the bolts. Overtightening can damage the vertical frame 
post structure.

Note Ensure that you do not take the leveling legs out of adjustment during this 
process.

back upper bolt

back lower bolt
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Attaching the X-Axis Rails

Attaching and Aligning the Upper and Lower X-Axis Rails
Repeat the following procedure for each additional expansion module, starting with the first new expansion 
module and working to the right.

Required tools: 2.5 mm hex wrench

1 Attach the upper X-axis rail as follows:

 a. Use the 2.5 mm hex screws to attach the upper X-axis rail loosely.

 b. Push the rail to the left and align it front to back with the previous rail so that the joint is smooth.

 c. Tighten each screw on the rail beginning at the left end. Do not tighten the screw that is on the 
next rail at the junction between the current module and the module to the right.

Note The X-axis rails are shipped in a package secured in the back of the expansion 
module with the cable management ties. Remove the packages and unpack 
them in a convenient location before beginning the following procedures.

Note For expansion modules in positions 9 through 12, the X-axis upper and lower 
rails contain longer slots. Check for the rail identification hole which signifies 
the replacement X-axis upper or lower rail.

2.5 mm hex screws

2.5 mm hex screw
attached to module on left
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2 Attach the lower X-axis rail as follows:

 a. Use the 2.5 mm hex screws to attach the lower X-axis rail loosely.

 b. Push the rail to the left and align it front to back with the previous rail so that the joint is smooth.

 c. Tighten each screw on the rail beginning at the left end. Do not tighten the screw that is on the 
next rail at the junction between the current module and the module to the right.

2.5 mm hex
screws

2.5 mm hex screw
attached to module on left

elongated slot

rail identification mark (hole)

expansion modules 9 - 12
X-axis upper and lower rails contain 
longer slots 
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Attaching the Middle X-Axis Rail

1 Use a 3 mm hex wrench to attach the middle X-axis rail loosely to the X-axis channel with screws 1 
through 10.

Note If you are adding expansion modules onto an eight module library, the new 
expansion modules ship with a special center X-axis rail that must be installed 
in module eight of the existing library. This rail is 7mm shorter then standard X-
axis rails. The shorter X-rail is etched with a part number and description. You 
must remove the previous middle X-axis rail to install the new rail. See Remov-
ing the Middle X-Axis Rail from Module Eight on page 81.

1
2

3
4

5
6

7
8

9
10

X-axis channel

middle X-axis rail

Etched part
number
identifying
special rail
for adding EM to eight or more library configuration
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When attached, the middle X-axis rail must appear as shown below. 

Note The holes will appear slightly shifted on the 7mm shorter rail.

middle X-axis
X-axis rail channel

1 2 3 4 5 6 7 8 9 10
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Aligning the Middle X-Axis Channel
If you are installing a new library, go to Aligning the Middle X-Axis Rail on page 46.

If you are adding one or more expansion modules to a system unit, do the following:

1 With the middle X-axis rail completely loose, do the following:

 a. Place the centering tool over screw 3 and into the counterbore of the X-axis rail.

 b. Holding the centering tool in place, tighten screw 3.

 c. Repeat for screw 8.

Note You only need to perform this procedure on expansion modules being added to 
the system unit. Complete systems ship from the factory with the middle X-axis 
channel already aligned.

counterbore

3 mm screw

in middle X-axis rail

middle X-axis rails

junction

x-axis channels

1 2 3 4 5 6 7 8 9 10
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2 Loosen the eight 2.5 mm screws attaching the X-axis channel to the module.

3 Push the X-axis channel and middle X-axis rail to the left until the X-axis rail of the expansion module 
contacts the X-axis rail of the module on the left.

4 Hold the X-axis channel so that the adjacent X-axis rails are touching each other and tighten the eight 
2.5 mm screws.

5 Loosen the X-axis rail 3 mm screws that were tightened Step 1 on page 45.

Aligning the Middle X-Axis Rail
1 Loosen the five 8 mm nuts on the X-axis rail alignment tool (part number 3-00147-01). Once the nuts 

are loose, separate the two metal bars of the tool and insert the back bar into the X-axis rail.

2 Position the middle of the X-axis rail alignment tool over the junction point in the rails.  
If the X-axis rail tool is positioned correctly you should be able gain access to the 3 mm screws through 
the holes in the tool.

2.5 mm screws2.5 mm screws

alignment pins

8 mm nuts

X-axis alignment tool

middle X-axis rails

junction 3 mm screws

x-axis channels
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3 Push the loose middle X-axis rail in the expansion module towards the X-axis rail in the control module 
or expansion module to verify that there is no gap in the junction between the two rails. 

4 While holding the X-axis rail against the adjoining rail use an 8 mm nut driver or open end wrench to 
tighten the five 8 mm nuts on the X-axis rail alignment tool. This will align the two separate rails.

5 Working from left to right, tighten the ten 3 mm screws on the middle X-axis rail.

6 Use an 8 mm nut driver or open end wrench to loosen the five 8 mm nuts on the X-axis rail alignment 
tool. Remove the tool from the X-axis rail.

7 Manually move the accessor over the rail junction points to verify that you cannot feel the junction.

Verifying the Middle X-Axis Rail Alignment
1 Place the digital level on the lower side of the control module X-axis rail between screws 3 and 4 as 

counted from the left. Record this value.

2 Place the level against the lower side of the expansion module X-axis rail between screws 5 and 6 as 
counted from the left.

3 Verify that value for the expansion module middle X-axis rail is within +/- 0.05 degrees of the value 
recorded for the control module. Make note of this value.

4 If the rail is not within this tolerance, align it as follows:

Note There may be a slight clunk sound as you pass over the junction, but you 
should not feel the transition between the rails in the accessor.

Note Do not place the level on the control module X-axis rail alignment pins.

middle X-axis
X-axis rail channel

1 2 3 4 5 6 7 8

level
location

Control Module Rail

middle X-axis
X-axis rail channel

1 2 3 4 5 6 7 8 9 10

level
location

Expansion Module Rail
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 a. Loosen screws 3 through 10 on the middle X-axis rail that is out of alignment.

 b. Adjust the X-axis rail until the level matches that of the control module, then tighten screw 10.

 c. Verify that the rail is still within tolerance, then tighten the remaining screws.

 d. Repeat Step 4 for each expansion module. The X-axis rails should now be level.

If you need to attach and align the middle X-axis rail in another expansion module, go to Attaching the 
Middle X-Axis Rail on page 43.

Note Do not loosen screws 1 and 2 or the rail-to-rail alignment will be lost.

middle X-axis
X-axis rail channel

1 2 3 4 5 6 7 8 9 10
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Verifying Accessor Assembly Alignment
1 Verify that the accessor assembly is aligned correctly as follows

 a. Position the front edge of the Y-drive mount so that it is aligned with the scribe mark on the lower 
left end of the control module’s upper and lower X-axis rail.

 b. Verify that the upper X-axis bearing is within one mm of the scribe mark on the upper X-axis rail.

Y-axis rail

scribe mark
on lower X-axis rail

front edge of
Y-drive mount

Y-axis rail

scribe mark
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2 If the accessor assembly is not aligned correctly, do the following:

 a. Loosen the five screws that hold the accessor to the X carriage.

 b. Position the front edge of the Y-drive mount so that it is aligned with the scribe mark on the lower 
X-axis rail.

 c. Align the upper X-axis bearing with the scribe mark on the upper X-axis rail.

 d. Tighten the five screws.

 e. Move the accessor assembly to the right about 100 mm away from the scribe marks.

 f. Repeat Step 1 above to verify alignment.

Attaching the Tensioner Bracket and Hard Stop
Determine library configuration requirements:

• If the library configuration will be less than eight modules, use the tensioner bracket and hard stop 
you removed previously. Proceed to Eight Modules or Less Configuration on page 50.

• To add expansion modules onto an existing eight module library configuration, you must use the 
new tensioner bracket which is provided in the installation kit. The new tensioner bracket has a 
vertical slot instead of a hole on the bottom left. Proceed to Nine Modules or More Configuration on 
page 51.

For information on removing the tensioner bracket, see Removing the Tensioner Bracket and Hard Stop on 
page 80.

Eight Modules or Less Configuration
1 On the expansion module that will be the last in the configuration, use a 3 mm hex wrench to attach the 

X-axis tensioner bracket to the X-axis channel.

3 mm screws
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2 On the expansion module that will be the last in the configuration, use a 3 mm hex wrench to attach the 
hard stop.

Nine Modules or More Configuration
To add expansion modules onto an existing eight module library configuration, you must use the new 
tensioner bracket which is provided in the installation kit. The new tensioner bracket has a vertical slot 
instead of a hole on the bottom left.

1 Confirm the tensioner assembly in the installation kit is anodized black and that it has the FRU ID 939. 

2 On the X-axis tensioner that you removed earlier, use a 3 mm hex wrench to remove the 4 screws that 
attach the tensioner assembly to the tensioner assembly bracket.

3 mm screw

3 mm screws

Removed tensioner mounting
bracket with hole instead of slot

black tensioner assembly
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3 Using a 3 mm hex wrench install the 4 screws that attach the tensioner assembly to the replacement 
tensioner bracket.

4 Use a 3 mm hex wrench to install the fours screws that attach the X-axis tensioner to the substrate of 
the last expansion module in your library configuration.

3 mm screws

Replacement tensioner mounting
bracket with slot

black tensioner assembly

3 mm screws

substrate

tensioner mounting
bracket

black tensioner assembly
52 Installing a Multi-Module Library



5 Use a 3 mm hex wrench to attach the hard stop to the substrate below the X-axis center rail.

Installing the X-Axis Belt
Determine the library configuration requirements:

If the library configuration will be less than eight modules, follow the Eight Modules or Less Configuration 
on page 53.

If the library configuration will be nine modules or more, follow the Nine Modules or More Configuration on 
page 56.

Tools required: 2.5 mm hex wrench, 4 mm hex wrench, 3 mm hex wrench 

Eight Modules or Less Configuration
1 Thread the belt around the back side of the X-axis pulley assembly.

3 mm screw

belt

thread belt through the
back of the pulley assembly
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2 Thread the end of the belt through the back opening in the tensioner.

3 Locate the X-axis belt clamp. 

The X-axis belt clamp was removed as part of the disassembly procedure on an existing library. See 
Step 5 on page 79. The clamp is connected to the X-axis carriage on a new library.

4 To attach the belt to the right side of the X-axis belt clamp, use a 2.5 mm hex wrench to tighten the first 
screw.

belt

thread belt through opening

tensioner

in the back of the tensioner

2.5 mm hex screw
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5 Pull the belt tight and mark where it should be cut. You must leave three belt teeth extra on the belt so 
it can be attached to the left side of the clamp.-

6 Cut off the excess length from the belt.

7 Insert three teeth of the X-axis belt into the left side of the clamp and tighten the 2.5 mm screw to secure 
the belt in place. 

8 Secure the belt clamp to the X-axis carriage by installing the two 4 mm screws through the X-axis 
carriage into the belt clamp. If your library configuration involves nine or more modules, see Nine 
Modules or More Configuration on page 56. Otherwise, proceed to step Step 9 on page 56.

marking point

2.5 mm hex screw

X-axis carriage

4 mm belt clamp 

belt clamp bracket screws
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9 Use the 4 mm hex wrench to turn the spring-load screw counter clockwise to uncompress the tensioner. 
Note that the gap cannot exceed 5 mm between the score mark and the tensioner base.

10 Continue to unscrew the compression screw (turning counterclockwise) until there is a 10 mm gap 
between the screw head and tensioner base.

11 Move the accessor over the full length of the X-axis to verify that the belt is not twisted.

12 Return the accessor to the home position in the control module so you can install the X-axis chain 
assembly. 

Nine Modules or More Configuration
To add expansion modules onto an existing eight module library configuration you must follow steps 1-6 in 
the Eight Modules or Less Configuration on page 53 and then complete the steps below. The longer belts 
have an initial stretch on install. You must make certain the tensioner arm is to the left of the 5mm mark and 
that the gap does not exceed 3.5mm.

1 Use the 4 mm hex wrench to turn the spring-load screw counter clockwise to uncompress the tensioner. 

2 Verify the gap does not exceed 3.5mm. 
If the gap does not exceed 3.5 mm, go to Step 12 on page 58. 
If the gap exceeds 3.5 mm, go to Step 3 on page 56.

3 Use the 4mm hex wrench to turn the spring-load screw clockwise to re-compress the tensioner.

4 Remove the three screws from the tensioner bracket and loosen the screw in the vertical slot 1/4 turn.  
This allows the X-axis tensioner to drop down and rotate clockwise generating additional slack in the 

4 mm spring-load screw

tensioner base

5 mm mark

tensioner arm

10 mm gap

4 mm spring-load screw

tensioner base

5 mm score mark

tensioner arm

10 mm gap

3.5 mm gap
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belt, making it possible to cut off excess. Remove only one tooth at a time as you adjust the belt for 
length.

5 Use a 2.5 mm hex wrench to remove the belt from the left side of the X-axis belt clamp.

6 Cut off one tooth and then reinstall the belt to the left side of the X-axis belt clamp using the 2.5 mm hex 
wrench.

7 To reinstall the x-axis tensioner assembly, rotate it counter-clockwise and then push it upwards.

8 Use a 3mm hex wrench to install the remaining three screws and tighten the loosened screw in the 
vertical slot.

9 Use the 4mm hex wrench to turn the spring-load screw counter clockwise to uncompress the tensioner.

10 Verify that the tensioner gap does not exceed 3.5mm
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11 If necessary, repeat steps 3 -10 and remove one belt tooth.

12 Once the tensioner has been uncompressed and the 3.5mm gap has been achieved, secure the belt 
clamp to the X-axis carriage by installing the two 4mm screws through the X-axis carriage into the belt 
clamp.

13 Move the accessor over the full length of the X-axis to verify that the belt is not twisted.

14 Return the accessor to the home position in the control module so you can install the X-axis chain 
assembly.

Installing the X-Axis Chain Assembly
The X-axis chain that has been removed will not be used in the new configuration. Follow the procedure 
below to install the X-axis chain assembly that shipped in the installation kit.

Required tools: 3 mm hex wrench

1 Thread the X-axis chain assembly into the slot behind the lower X-axis rail. 

It is easier to fold over a large chain and feed it through from the last expansion module in the library if 
the side panel is not installed.

X-axis carriage

4 mm belt clamp 

belt clamp bracket screws
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2 Using the 3 mm hex wrench, secure the X-axis chain assembly (W8) to the bottom of the control module 
using two 3 mm screws.

3 Connect the X-axis chain (W8) connector from the control module bulkhead.

X-axis chain 
assembly (W8)

3 mm screws

X-axis chain (W8) connection
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4 Connect the X-axis chain connector (W8) to the control module bulkhead using Velcro straps. 

5 Use a 3 mm hex wrench to attach the X-axis chain assembly (W8) to the Y-axis drive mount assembly 
using two 3 mm screws.

Velcro straps

Y-axis drive
mount assembly

3 mm screws

X-axis chain
assembly
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6 Connect the Y-axis motor/home sensor cable to the X-axis chain assembly (W8). 

7 Connect the Y-axis chain (W9) to the X-axis chain assembly (W8). 

X-axis chain 
assembly (W8)

X-axis sensor cable

Y-axis chain
assembly (W9)

connector

X-axis chain
assembly (W8)
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8 On the top of the X-axis chain assembly, lock down the Y-axis home sensor cable by pressing down on 
the hold-down.

9 Test the Y-axis assembly by moving the accessor assembly to its home position and verifying the cables 
do not have contact with the cables routed up the bulkhead. If they do, reposition the cables along the 
bulkhead with the Velcro straps.

Y-axis home
sensor cable

hold down
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Installing the X-Axis Chain Trough

Required tools: 2.5 mm hex wrench

1 Locate the X-axis cable trough (part number 3-01740-01).

2 Use the 2.5 mm hex wrench to remove the clip from the end of the trough.

Note The X-axis chain trough is installed only in 7- 12 module configurations. Skip 
this procedure if the configuration you are installing has six or fewer modules.

Note Center the trough in modules 3, 4, 5, and 6 with a slight left offset.

Library Configuration Trough Locations

CM + 6 EM module 3

CM + 7 EM module 3

CM + 8 EM module 3 and 4

CM + 9 EM module 3, 4 and 5

CM + 10 EM module 3, 4, and 5

CM + 11 EM module 3, 4, 5, and 6

cable trough

2.5 mm hex screw
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3 Place the trough between the top and bottom portions of the X-axis chain. Clip the end of the trough 
over the bottom chain of the X-axis cable in the middle of the third module (second expansion module).

4 Lay the trough flat on the X-axis cable. Clip the end of the trough that was removed onto the cable and 
attach it using the 3 mm hex wrench.

expansion module in 
position 3

into a lower link of the X-axis cable
hook the clipped end of the trough

clip that was removed

3 mm hex screw 
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Routing and Connecting Module Cables
Required tools: Phillips screwdriver

1 On the back of the existing control module or last expansion module, do the following:

 a. Loosen the thumbscrew on the LBX/IEX cover plate and remove the plate.

 b. Use a #2 Phillips screwdriver to remove the four thumbscrews that retain the cover plate 
between the top and bottom drive positions.

Note The cables will be preinstalled on the LBX board in the expansion modules. 
You must route them through the hole in the bulkhead to either the control 
module or previous expansion module.

LBX/IEX cover 
plate thumbscrew

thumbscrews 
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2 On the new expansion module, loosen the thumbscrew on the LBX/IEX cover plate and remove the 
plate.

3 Locate the W1 and W2 cables on the new expansion module.

LBX/IEX cover 
plate thumbscrew

W2 cable

W1 cable (large ribbon cable)

(Ethernet)
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4 Route the W1 and W2 cables from the new expansion module through the opening in the left bulkhead 
of the control module or last expansion module in the existing configuration.

5 Connect the W1 ribbon cable to the J2 connection on the LBX board on the control module or last 
expansion module in the existing configuration. 
 
This connects the J1 connection on the LBX board in the new expansion module to the J2 connection 
on the LBX board in the control module or last expansion module in the existing configuration.

Note The LBX board has three versions and the terminator has two versions. For 
more information, see LBX Board on page 345 and LBX Terminator on 
page 349. Make certain you have the correct version LBX based on the 
library configuration you are installing. 

route the W1 and W2 cables
through opening in the left
bulkhead

LBX board on 
expansion module

LBX board on 
control module orW1 cable

J2J1J2

J17

J1

expansion module(large ribbon cable)
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6 Connect the W2 Ethernet cable to the J3 connection on the LBX board on the control module or last 
expansion module in the existing configuration. 
 
This connects the J4 connection on the LBX board in the new expansion module to the J3 connection 
on the LBX board in the control module or last expansion module in the existing configuration.

7 Determine the LBX terminator installation:
• Determine your library configuration and verify what style of terminator is needed. There are two 

versions of the LBX terminator board (card). For more information, see LBX Terminator on page 
349. 

• Once you have determined what style of terminator you need, install it into the J17 connection on 
the LBX board in the last expansion module.

Note The LBX board has three versions and the LBX terminator has two 
versions. For more information, see LBX Board on page 345 and LBX 
Terminator on page 349.

LBX board on 
expansion module

LBX board on 
control module orW1 cable

J2J1J2

J17

J1

expansion module(large ribbon cable)

J3J4

W2 cable (Ethernet)

J17 connection
LBX terminator
68 Installing a Multi-Module Library



8 Use the cover plate thumbscrew to replace the LBX/IEX cover plates on the modules.

9 Use a #2 Phillips screwdriver to replace the cover plate between the drive positions.

LBX/IEX cover 
plate thumbscrew

thumbscrews 
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Assembling the Last Expansion Module
Required tools: 2.5 mm hex wrench, 

1 Remove the magazine storage on rack # 1 in sections 1 - 5 on Column 4 in the last expansion module. 

drive cluster

top view of module

rack 1 (back)

rack 2 (front)

column 4

section 1

section 2

section 3

section 4

section 5

rack 1 (back)

drive cluster
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2 Install the L brackets. Each bracket is attached to the module frame by two 2.5 mm hex screws.

3 Locate the right side panel that was removed from the control module or previous expansion module.

2.5 mm screws
that retain the
L-brackets 
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4 Align the side cover with the screw holes in the expansion module.

screw holes

screw holes
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5 From inside the expansion module, use a 2.5 mm hex wrench to install the nine (9) screws that attach 
the side panel to the module.

6 Reinstall the removed magazines removed in Step 1 on page 70.

7 Reattach all of the service doors.

8 Repeat steps Step 1 on page 70 through Step 3 on page 71 on each expansion module.

9 Once the components are installed, if applicable, perform the procedures detailed in Installing Drives 
and Blades on page 97.

2.5 mm screw

2.5 mm screw

2.5 mm screw

2.5 mm screws

front of module

2.5 mm screws

2.5 mm screws

back of module
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Preparing an Existing Library to Receive an Expansion Module

To prepare an existing library to receive an expansion module, complete the following procedures:

• Positioning the Existing Library on page 74

• Removing the Right Side Panel from the Last Existing Module on page 75

• Removing the X-Axis Belt on page 79

• Removing the Tensioner Bracket and Hard Stop on page 80

• Removing the X-Axis Chain Assembly on page 82

• Removing the LBX Terminator Board on page 85

• Removing and Replacing the LBX Board on page 86

Positioning the Existing Library
If you must move the existing library prior to installing a new expansion module, follow the preceding steps 
to locate and position the modules. For more information on location specifications, see the Scalar i6000 
Planning Guide. 

Required tools: 24 mm open-end wrench, 2.5 mm hex wrench, 3 mm hex wrench, 4 mm hex wrench

1 Verify the quantity and placement of new expansion modules.

2 Verify the following:

• There is adequate clearance for the access and service doors.

• The selected location the new modules is level. See Verifying the Level of the Install Location on 
page 321.

• All raised floor tiles have been cut out accordingly to accommodate the power, SCSI, Fibre, and 
Ethernet cables to any of the modules.

3 Verify that the existing library is level. See Verifying Level Condition on page 33.

4 Remove all of the service doors by opening them and then lifting them off the hinges. Set the doors 
aside.

5 Open all access doors.

Note To ensure Ethernet communication, control management blades (CMB) must 
be installed in each expansion module of a multi-module configuration. If the 
last expansion module does not contain FC I/O blades, a CMB is not necessary
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Removing the Right Side Panel from the Last Existing Module
1 On the control module or far right expansion module, remove the storage magazines in sections 1- 5 of 

column 4 of rack 1.

This will enable you to access the 2.5 mm hex screws that attach the right side panel to the control 
module or last expansion module.

Magazines must be removed in a top-down order. To remove the magazines:

 a. Remove any cartridges from the magazine. 

 b. Starting at the top-most magazine, use both hands to push the magazine upwards until it 
unsnaps.

 c. Pull the magazine toward you to remove it.

drive cluster

top view of module

rack 1 (back)

rack 2 (front)

column 4

section 1

section 2

section 3

section 4

section 5

rack 1 (back)

drive cluster
Scalar i6000  Installation Guide 75



2 Remove the nine (9) 2.5 mm screws that attach the right side panel to the module.

Note Three screws are located at the front corner post, three at the back corner post, 
and three at the storage wall.

2.5 mm screw

2.5 mm screw

2.5 mm screw

2.5 mm screws

front of module

2.5 mm screws

2.5 mm screws

back of module
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3 Lift the right side panel off the module and set it aside until the expansion module install procedure calls 
to reinstall it on the last expansion module.

screw holes

screw holes
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4 Use a 2.5 mm hex wrench to remove the three L-brackets that mount the side panel to the storage wall 
and set them aside.

The L-brackets will be reused to attach the side panel to the last expansion module.

5 Reinstall the magazines that were removed in Step 1 on page 75.

2.5 mm screws
retaining
L-brackets
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Removing the X-Axis Belt
1 Use the 4 mm hex wrench to turn the spring-load screw clockwise until the two parts of the tensioner 

assembly touch.

2 Use a 4 mm hex wrench to remove the two screws on the X-axis belt clamp bracket. The belt clamp 
bracket will be removed from the X-axis carriage.

3 Turn the X-axis belt clamp assembly over.

4 Use a 2.5 mm hex wrench to loosen the two screws on the belt clamp assembly.

5 Take the X-axis belt off the X-axis belt clamp assembly and pull the belt free from the pulleys. 
Set the belt clamp assembly aside. The assembly will be reused in later steps. 
Discard the belt. It will not be used in the new configuration.

spring-load screw

tensioner base 5 mm mark

tensioner arm

X-axis carriage

4 mm screws

belt clamp assembly

2.5 mm hex screws
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Removing the Tensioner Bracket and Hard Stop
1 Use a 3 mm hex wrench to remove the four (4) screws that are attaching the X-axis tensioner bracket 

to the X-axis channel in the control module or last expansion module. 

2 Use a 3 mm hex wrench to remove the X-axis hard stop.

Note Do not use ball drivers to remove the hex screws because the screws 
could be stripped.

3 mm screws

3 mm screw
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Removing the Middle X-Axis Rail from Module Eight

1 Use a 3 mm hex wrench to remove screws 1 through 10.

2 Lift the rail from the frame, and set aside.

Note You only need to remove the middle X-axis rail from module eight if you are 
adding expansion modules to an existing eight module library. Later, you will 
replace this rail with a special rail for the expanded configurations.

1
2

3
4

5
6

7
8

9
10

X-axis channel

middle X-axis rail
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Removing the X-Axis Chain Assembly
1 On the top of the X-axis chain assembly, release the Y-axis home sensor cable by flipping up the hold-

down.

2 Disconnect the Y-axis chain (W9) from the X-axis chain assembly (W8). 

3 Disconnect the Y-axis home/motor cable from the X-axis chain assembly (W8). 

hold down

Y-axis home sensor cable

X-axis chain
assembly (W8)

connector

Y-axis chain
assembly (W9)

X-axis chain
assembly (W8)

Y-axis 
motor cable
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4 Using the 3 mm hex wrench, remove two 3 mm screws attaching the X-axis chain assembly (W8) to the 
Y-axis drive mount assembly.

5 Using the 3 mm hex wrench, remove the two screws securing the X-axis chain assembly (W8) to the 
bottom of the control module.

3 mm screws

X-axis 
chain assembly

Y-axis drive
mount assembly

X-axis chain
assembly (W8)

3 mm screws
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6 Remove Velcro straps (or zip ties) holding the X-axis chain (W8) to the control module bulkhead.

7 Disconnect the X-axis chain (W8) connector from the control module bulkhead. 

8 Remove the X-axis chain from the module and discard it appropriately. It will not be used in the 
configuration. 

Velcro straps

X-axis chain (W8) connector
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Removing the LBX Terminator Board

1 Unscrew the thumbscrew and remove the LBX/IEX cover plate from the control module or last 
expansion module in the existing configuration.

2 Remove the LBX terminator from the J17 and J2 connections on the LBX board.

3 Determine your library configuration and verify what version of LBX terminator is needed.  
There are two versions of the LBX terminator board (card). For more information, see LBX Terminator 
on page 349. 

Note There are three versions of the LBX board (card) and two versions the LBX 
terminator board (card). For more information, see LBX Board on page 345 
and LBX Terminator on page 349.

LBX/IEX cover 
plate thumbscrew

J17 connection
LBX terminator
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Removing and Replacing the LBX Board
If you are adding one or more expansion modules to an existing eight-module library, you must remove the 
LBX2 Gen 2 board from expansion module seven and replace it with the LBX2 GEN 3 version (red sticker 
identifier). Only do this for expansion module seven.

Removing the LBX Board
Required Tools: None 
FRU ID: 104

1 Shut down the library.

For more information, see Shutting Down the Library on page 232.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Unscrew the thumbscrew and remove the LBX/IEX cover plate.

4 Disconnect all cables from the LBX: the LBX cable (W1), internal Ethernet cable (W2), LBX-drive cluster 
cable (W3), power supply status cable (W5), I/E station cable (W6), CAN cable (W7), Ethernet cluster 

CAUTION
Only use this procedure if you are preparing to install expansion modules 
to an existing eight-module library.

Note The LBX2 GEN 3 boards are identified by red stickers. 
Additional storage-only expansion modules in positions 9 -12 of a library 
configuration ship with the latest LBX board versions. Check to make 
certain the LBX2 GEN 3 boards with red stickers are installed. 

thumbscrew
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cable (W11), power distribution cable to library (W12), power distribution cable to drive cluster (W13) 
door interlock cable (W15), power supply status cable (W16), and I/O management unit cable (W17).

5 Use your thumb to unsnap the IEX board from the standoffs, and then unplug it from the LBX board. 
Then use your thumb to unsnap the LBX board from the standoffs.

To avoid damage to the backside of the LBX board, you should use care when removing the LBX board 
from the space above the metallic standoffs.

6 Remove the IEX and LBX boards.

connector: J14
plug: W3 to lower drive cluster

connector: J1 
plug: W1 to BPI or
from previous LBX

connector: J4 
plug: W2 to BPI or
from previous LBX

connector: J8 
plug: IEX board 

connector: J15
plug: W3 to upper drive cluster

connector: J11

connector: J7
plug: W6 to I/E station

plug: W15 to door interlock

connector: J10
plug: W11 to I/O management unit;

connector: J16 
plug: W16 to I/O management unit

connector: J13
plug: W7 to I/O management unit;

connector: J9 
plug: W5 to power enclosure

connector: J2
plug: W1 to LBX extended

connector: J3 
plug: W2 to J4 of next LBX

connector: J17 
plug: LBX terminator 

CAN interface

Ethernet

plug: J19
connector: 1 x 2 aisle light
 cable
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Replacing the LBX Board

Required Tools: None 
FRU ID: 104

1 If the library is not shut down, shut down the library.

For more information, see Shutting Down the Library on page 232.

1 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

2 Remove the new LBX board from the anti-static bag. 

3 Use your thumb to snap the LBX and IEX boards onto the standoffs. 

To avoid damage to the backside of the LBX board, you should use care when inserting the LBX board 
into the space above the metallic standoffs.

4 Plug the IEX board into the new LBX board.

Reconnect all cables to the LBX: the aisle light cable, the LBX cable (W1), internal Ethernet cable (W2), 
LBX-drive cluster cable (W3), power supply status cable (W5), I/E station cable (W6), CAN cable (W7), 
Ethernet cluster cable (W11), power distribution cable to library (W12), power distribution cable to drive 
cluster (W13) door interlock cable (W15), power supply status cable (W16), and I/O management unit 
cable (W17).  

Note Red stickers identify the LBX2 GEN 3 board required in the expansion 
modules added to a library configuration greater than eight.
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Removing and Replacing the IEX Card
If you are adding one or more expansion modules to an existing eight-module library, each expansion 
module you are adding must contain an IEX2 card. The IEX2 card is identified by a red sticker. If an 
expansion module you are adding contains an earlier version of the IEX card, you must remove the earlier 
version and replace it with an IEX2 card.

Removing the IEX Board
Required Tools: None 
FRU ID: 105 (IEX board)

1 If the library is not shut down, shut down the library.

For more information, see Shutting Down the Library on page 232.

2 Open the service door.

3 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

4 Unscrew the thumbscrew and remove the LBX/IEX cover plate.

CAUTION
Only use this procedure if you are preparing to install expansion modules 
to an existing eight-module library.

Note New IEX2 cards are identified by red stickers. Earlier IEX card versions 
have no stickers.

thumbscrew
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5 Use your thumb to unsnap the IEX board from the two standoffs.

6 Unplug the IEX board from the LBX board.

7 Remove the IEX board.

Replacing the IEX Board
Required Tools: None 
FRU ID: 105

1 If the library is not shut down, shut down the library.

For more information, see Shutting Down the Library on page 232.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Remove the new IEX board from the anti-static bag.

standoffs

IEX board

connection between IEX
and LBX boards
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4 Plug the IEX board into the new LBX board.

5 Use your thumb to snap the IEX board onto the two standoffs.

6 Replace the LBX/IEX cover plate and tighten the thumbscrew.

7 Detach the ESD strap and close the door.

standoffs

IEX board

thumbscrew
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Applying Power
The instructions in this chapter tell you how to apply power to a library. Before applying power, you should 
perform a voltage check. The information in this chapter includes:

• Supported AC Power Cables on page 93

• Powering on the Library on page 94

Supported AC Power Cables

Each library is configured with a single AC power source, but redundant power is an option. If redundant 
power is chosen, the control module and all expansion modules that contain tape drives require two 
independent AC power sources.

The power cable length for each of these inputs is 14 feet (4.26 m). See Table 2 on page 93.

Table 2 Electrical Specifications for Control and Expansion Modules

CAUTION
You must install your library with two independent power sources to 
have redundant power. You will NOT have redundant power if you use 
only one AC power source.

Location Voltage (Single 
Phase, 50 - 60 Hz)

Required Protective 
Service

Delivered Power 
Connector AMPs

North America 110 30 NEMA L5 - 30 30

North America 208 15 NEMA L6 - 15 15

International 240 16 IEC60309 2P+E 20a or 16b

a. 20 amps in North America 
b. 16 amps international
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Powering on the Library

Required tools: None

1 Verify that the circuit breaker on the power distribution units is down in the off (O) position.

2 Plug an AC power cable into each of the power distribution units.

3 Plug the other end of all AC power cables into power sources.

Independent power sources for the power distribution units in each module are needed if you want 
redundant power.

4 On each of the power distribution units, set the circuit breaker switch to the up (I) position. Fan power 
supplies will start but library power is not fully on.

5 Verify that the power supply status LEDs are on. 

• AC OK - Green

• DC OK - Green

• Fault - Blue

6 Close and latch the service door and access door.

power supply

power distribution unit

AC power cable
connection

redundant
power supply
(optional)

redundant power
distribution unit (optional)

circuit breaker

circuit breaker

status LEDs
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7 On the indicator panel, press Power button to turn on power.

The library will power on.

Note Make sure the service and access doors are closed and latched.

Note Depending on the size of the configuration it can take more than 90 minutes for 
the library to fully power on and the Library Management Console to be 
displayed on the touch screen. During this time, Working ... will be displayed 
on the screen.

During the power-on sequence, the Robotics Enabled indicator will flash. 

Anytime the library is powered Off (I), you must wait 10 seconds before power 
On (O).

Robotics Enabled
indicator/button

Status indicator

Power indicator/button

touch screen
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Once the library powers on, the Library Management Console (LMC) will be displayed on the touch screen 
on the operator panel. The following illustration shows the boot screen on the operator panel. Wait until the 
system is fully powered up and running, and then continue with the instructions in Configuring the Library 
on page 153. 

Figure 6 Library Management Console Touch Screen

You are now ready to connect the drives and the library using the instructions in Cabling on page 111.

Note Make sure you review the information in Cabling on page 111 before 
connecting the drives and blades.
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Installing Drives and Blades
This chapter provides the step-by-step instructions for installing and connecting the drives in the library. The 
information in this chapter includes:

• Numbering Sequences on page 101

• Installing Drives on page 105

• Installing Blades in the I/O Management Unit on page 108

Note The installation instructions in this chapter assume that you are installing drives 
and blades in a new library.

• If you are installing drives in a new library, the library is shipped with the 
frames preconfigured to accept the drive quantity that has been 
ordered. For example, if a customer orders 10 drives, 10 drive positions 
will be ready to accept the drives. See Installing Drives on page 105.

• If you are adding drives to an existing library, see Adding Drives to an 
Existing Installation on page 233.

• If you are removing and replacing failed drives in an existing library, see 
the Scalar i2000/i6000 Maintenance Guide.
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Referencing Tape Drive Compatibility

Tape drives are enclosed in a universal drive sled. You can hot swap and hot add all supported drives, 
regardless of type. The library supports the following types of tape drives:

• IBM LTO-1 or LTO-2 LVD–SCSI

• IBM LTO-1, LTO-2, LTO-3, LTO-4

• HP LTO-3, LTO-4, LTO-5 FC Multi-mode

• Quantum SDLT-320 LVD–SCSI

• Quantum SDLT-600 FC

• Quantum DLT-S4 FC

LTO drives can be connected directly to hosts, to the storage area network (SAN), or to FC I/O blades in 
the I/O management unit. SCSI drives must be connected directly to hosts or the SAN.

For detailed information on tape drive compatibility, WORM support, and mixed media rules, see the Scalar 
i6000 User’s G
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LTO Drives
Five generations of LTO drives are supported, but they are not fully compatible as shown in Table 3.

All LTO cartridges are the same size, which means they use the same magazines in the library.

LTO drives can be directly attached to hosts, attached to the SAN, or connected to FC I/O blades in the  
I/O management unit. SCSI drives must be directly attached to hosts or to the SAN.

Table 3 LTO Drive and Cartridge Compatibility

LTO-1 
Cartridges

LTO-2 
Cartridges

LTO-3 
Cartridges

LTO-3 
WORM

LTO-4 
Cartridges

LTO-4 
WORM

LTO-5 
Cartridges

LTO-5 
WORM

LTO-1 
Drives

Reads/
Writes

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

LTO-2 
Drives

Reads/
Writesa

a. LTO-2 drives do not reformat LTO-1 cartridges. The drives will write to the cartridges in the LTO-1 format (100 GB
capacity).

Reads/
Writes

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

LTO-3 
Drives

Readsb

b. LTO-3 drives read LTO-1; they do not write to the LTO-1 cartridges.

Reads/
Writesc

c. LTO-3 drives do not reformat LTO-2 cartridges to contain the same density as the LTO-3 cartridges (400 GB). The 
LTO-3 drives will write to the LTO-2 cartridges in the LTO-2 format (200 GB capacity).

Reads/
Writes

Write 
Once, 
Read 
Manyd

d. LTO-3 WORM requires the installation of library firmware and WORM-supported LTO-3 tape drive code.

Not 
compatible

Not 
compatible

Not 
compatible

Not 
compatible

LTO-4 
Drives

Not 
compatible

Reads Reads/
Writes

Write 
Once, 
Read 
Many

Reads/
Writes

Write 
Once, 
Read 
Many

Not 
compatible

Not 
compatible

LTO-5 
Drives

Not 
compatible

Not 
compatible

Read Read 
Many

Reads/
Writes

Write 
Once, 
Read 
Many

Reads/
Writes

Write 
Once, 
Read 
Many
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DLT Drives
Five generations of DLT cartridges are supported in the library, but the drives are not fully compatible as 
shown in Table 4.

The SDLT-600 tape drives support reading and writing to SDLT II cartridges. They also have a backward-
read compatibility (BRC) mode. When in this mode, the SDLT-600 is capable of reading SDLT-220 and 
SDLT-320 tape formats in a SDLT I data cartridge, as well as the SDLT-VS160 tape format in the DLT tape 
VS1 data cartridge. The SDLT-600 tape drive will eject a data cartridge written in DLT formats other than 
DLT-VS160. All DLT cartridges are the same size, which means they will use the same magazines in the 
library.

SDLT-320 SCSI tape drives are supported in the library. They can be directly connected to a host.

Table 4 DLT Drive and Cartridge Compatibility 

SDLT-600 
Cartridges

SDLT-320 
Cartridges

SDLT-220 
Cartridges

SDLT-VS 160 
Cartridges

DLT-S4 
Cartridges

DLT-S4 
Drives

Reads Reads Reads Not compatible Reads/Writes

SDLT-600 
Drives

Reads/Writes Reads Reads Reads Not compatible

SDLT-320
Drives

Not compatible Reads/Writes Reads/Writes Not compatible Not compatible
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Numbering Sequences

This section describes the numbering sequences used in the library for the following:

• Drives—corresponds with the drive sections in rack 1, column 1 of a module.

• FC I/O blade ports—the order of the ports on the I/O blade.

• Ethernet expansion blade ports—the order of the ports on the Ethernet expansion blade.

• I/O management unit—the bays within the unit.

These sequences are used to determine where to locate blades in the I/O management unit and how to 
connect drives to blades. See Table 5 on page 114 for more information.

Drive Numbering Sequence
An example of the numbering sequence for all drives except SDLT-320 SCSI drives is shown in Figure 7 
below.

For information on the library’s coordinate system, see Storage Addressing System Overview on page 132.

Figure 7 Drive Numbering Sequence in the Control Module and Expansion Modules

Note Gaps between drive locations are not supported. Drives must be installed in 
each module in the order shown in Figure 7 . The control module must be fully 
populated with 12 drives before installing any drives in the first expansion 
module. Each expansion module must be fully populated before installing any 
drives in subsequent expansion modules.

1,1,1,12,1,1
1,1,1,11,1,1

1,1,1,9,1,1
1,1,1,8,1,1
1,1,1,7,1,1

1,1,1,10,1,1

1,1,1,6,1,1
1,1,1,5,1,1

1,1,1,3,1,1
1,1,1,2,1,1
1,1,1,1,1,1

1,1,1,4,1,1
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FC I/O Blade Numbering Sequence
Quantum has requirements for connecting FC I/O blades to drives. Figure 8  shows the numbering (bottom 
to top) on the FC I/O blades. There can be a maximum of four drives connected to each FC I/O blade 
installed in the I/O management unit. FC-1 and FC-2 are reserved for connections to the SAN or hosts.

Figure 8 Fibre Channel I/O Blade Connection Numbering Sequence

reserved for connections
to Fibre Channel drives

reserved for connections to the
storage area network (SAN) or
directly to hosts

FC
-2

FC
-3

FC
-4

FC
-1

FC
-6

FC
-5

LEDs
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Ethernet Expansion Blade Numbering Sequence
Quantum has requirements for connecting the Ethernet Expansion blades (EEB) to drives. Figure 9  shows 
the numbering (bottom to top) on the Ethernet Expansion blade. There can be a maximum of six drives 
connected to each EEB installed in the I/O management unit. 

Figure 9 Ethernet Expansion Blade Connection Numbering Sequence

LED status lights

EEB connection ports to LTO-5 drives
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I/O Management Unit Bay Numbering Sequence
Figure 10  shows the numbering sequence and the bay positions in the I/O management unit. 

Figure 10 I/O Management Unit Bay Layout

Note Bay 2 is reserved for the control management blade (CMB). Bay 1 is not used.
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Installing Drives

Use the procedure in this section to install LTO-1, LTO-2, LTO-3, LTO-4, LTO-5, SDLT-600, SDLT-320, and 
DLT-S4 drives in either the control module or an expansion module in a new library. See Adding Drives to 
an Existing Installation on page 233 to add drives to an existing library.

These instructions assume that you have not yet turned on power to the library.

For instructions on how to install drives in an existing library, see the Adding Drives to an Existing Installation 
on page 233.

Required tools: #2 Phillips screwdriver, ESD strap

1 Open the service door of the control module or expansion module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Use the #2 Phillips screwdriver to remove the necessary number of cover plates from the drive sled 
positions. Remove the cover plates starting at the bottom and working towards the top of the library.

Note The library supports mixing the FC and SCSI drives in any order in the drive 
sled positions. However, gaps between drive locations are not supported. 
Drives must be installed in each module in the order shown in Figure 7 on 101. 
The control module must be fully populated with 12 drives before installing any 
drives in the first expansion module. The first expansion module must be fully 
populated before installing any drives in additional expansion modules. Each 
additional expansion module must be fully populated before installing any 
drives in subsequent expansion modules.

Note If you are installing a SCSI drive, you must attach the SCSI terminator to the 
drive before you insert it into drive slot when the library power is on.

Note LTO-5 Drives
The LTO-5 FC drive can be connected either through an Ethernet Expansion 
blade or through a 7404 FC I/O blade.
 
An LTO-5 FC drive connected to an Ethernet Expansion blade provides the 
following: 

• 8 Gbps data speed maximum 
• Full data path services—drive brick firmware autoleveling, LUN mapping, 

channel zoning, capturing drive logs 
• Not a data path for drives
 
An LTO-5 FC drive connected to a 7404 FC I/O blade provides the following:

• 4 Gbps data speed maximum
• Limited data path services—drive brick firmware autoleveling
• Serves as a data path for drives
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Either discard the cover plates or leave them with the customer for future use.

4 Remove the drives from the anti-static bag and place them in a location where they cannot be damaged.

Figure 11 LTO drive examples

5 Using the notches and markings on the drive sled position, slide the drive in slowly so the guide rails 
engage.You might need to tilt the drive up or down in order to engage the rails. Once inserted, the drive 
should be flush with no gaps above, below, or on either side. The screws must line up with the screw 
holes.

6 Use the #2 Phillips screwdriver to tighten the two thumbscrews on the drive.

7 Follow the numbering scheme shown in Figure 7 on 101 when installing any additional drives.

8 Detach the ESD strap.

cover plates

thumbscrew

guide rail
FC connector

FC LED status LEDs 

LTO-5 tape drive

thumbscrew

LTO-3 tape drive

 FC Ports (use Port 1 on left)EEB port connector
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9 If you are installing FC I/O blades in the I/O management unit, proceed to Installing Blades in the I/O 
Management Unit on page 108.

If you are not installing FC I/O blades, proceed to Applying Power on page 93, and then follow one of 
these paths:

• If you are going to directly attach either the FC or SCSI drives to a host, proceed to Attaching FC 
and SCSI Drives Directly to Hosts on page 124.

• If you are connecting the FC drives to I/O blades, you will first follow the instructions in Installing 
Blades in the I/O Management Unit on page 108 and then complete the procedure in Drive Cabling 
Considerations and How Drive Connection Model Affects Library Control Paths on page 112.

Note Make sure you review the information in Cable Connection Requirements 
for FC Drives on page 114 before connecting the cables.
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Installing Blades in the I/O Management Unit

This subsection provides step-by-step instructions for installing a control management blade (CMB), Fibre 
Channel (FC) I/O blades, and Ethernet Expansion blades into the I/O management unit. 

• Each FC I/O blade supports 4 tape drives. 

• There are two different FC I/O blade types: 6404 that auto-negotiates up to 2 Gbps and 7404 that 
auto-negotiates up to 4 Gbps. Each FC I/O blade has an embedded controller that provides 
connectivity and features that enhance the performance and reliability of tape operations. Each 
blade provides two host communication ports and four connection ports to drives. 

• Each Ethernet expansion blade supports 6 LTO-5 tape drives. 

If there are FC I/O blades or Ethernet Expansion blades in the I/O management unit of an expansion 
module, a CMB must also be present. 

Required tool: ESD strap

1 Open the service door of the control module or expansion module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Determine the designation for the blade based on the locations shown below.
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4 Remove the necessary number of cover plates from the I/O management unit by pressing to the left and 
pulling out on the latchhooks. 

Either discard the unused cover plate or leave it with the customer for future use.

5 Remove the blade from the anti-static bag.

6 Press up and out to open the latchhooks on each side of the blade.

7 Evenly apply pressure to both sides of the blade and slide it into the I/O management unit until the 
latchhooks begin to move towards the middle of the blade. Push the latchhooks towards the middle of 
the blade and into the lock position. You will feel the blade pins connect with the I/O management unit’s 
backplane as the blade locks into place.

CAUTION
Forcing the blade into the bay can cause the pins to bend.

cover plates

latchhooks
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8 Make sure cover plates are installed over any unused bays in all of the I/O management units. If any 
are missing, insert the cover plate with the latchhooks on the right side and evenly apply pressure to 
both side of the plate until the latchhooks begin to move towards the middle of the blade. Push the 
latchhooks towards the middle. You will feel the latchhooks lock into place.

9 Detach the ESD strap.

If you are not adding any optional hardware, you are now ready to power up the library. Applying Power on 
page 93 provides step-by-step instructions for powering up the library. If you are adding optional hardware, 
see Adding Optional Hardware on page 231.

CAUTION
Slots that are not populated with blades must contain a cover plate. If 
the cover plate is not installed, blade temperature errors will occur.

cover plates
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Cabling
This chapter contains instructions for connecting the library to the SAN or hosts. The library can be 
connected in the following ways:

• FC and SCSI drives can be directly attached to host systems or to the SAN. In these configurations, 
the MCB has one library control port (FC or SCSI) connecting to the controlling host computer.

• Attachment of the FC drives to the FC I/O blade in the I/O management unit. There are two ports 
on each FC I/O blade that can be connected directly to the host or to the SAN.

• A partition can be LUN mapped through a direct-attached LTO-5 drive.

This chapter contains the following sections:

• Drive Cabling Considerations and How Drive Connection Model Affects Library Control Paths on 
page 112

• Attaching Drives to FC I/O Blades on page 113

• Attaching FC LTO-5 Drives to Ethernet Expansion Blades on page 119

• Attaching FC and SCSI Drives Directly to Hosts on page 124

• Attaching Hosts to FC Ports on page 124

The instructions in this chapter assume you have installed the tape drives and FC I/O blades using the 
instructions in Installing Drives and Blades on page 97.
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Drive Cabling Considerations and  
How Drive Connection Model Affects Library Control Paths

Cabling of the library depends largely on the drive configuration that is purchased for installation. Each drive 
purchased is to be either Storage Networking (SNW) or native attach. These two drive purchase options 
create different customer physical connection options and library configuration options. There are two types 
of connections to define: drive data path connection and library control path connection. 

Each library partition has its own library control path to consider, see Working with Library Control Paths on 
page 180.

Cabling Configuration for Storage Networking Drives

Pre LTO-5 SNW Drives
Pre LTO-5 SNW drives are automatically accompanied by FC I/O blades. The FC I/O blade becomes an 
aggregation point for each drive FC connection (four drive ports total per I/O blade). Two ports on each FC 
I/O Blade are designated as Host or SAN ports. 

• Drive Data Path Physical Connection - connect FC cable direct from drive to FC I/O blade

• Library Control Path Physical Connection – The two host/SAN ports on each FC I/O blade are the 
recommended connection point for all partitions in a library. When possible, if there are multiple 
partitions and therefore multiple Library Control Paths, the configuration should spread the Library 
Control Paths across several FC I/O blades to minimize the single point of failure. It is logical to 
combine drives from a particular partition and the Library Control Path for a particular partition on 
one FC I/O Blade.

LTO-5 SNW Drives
LTO-5 SNW drives are automatically accompanied by an Ethernet Expansion blade (EEB). The EEB is NOT 
a drive data path connection point. The EEB provides the library with a high speed connection point to the 
tape drive. This high speed connection point allows the drive to become a “bridge” for the library control path 
to the customer SAN or hosts through the drive data port.

• Drive Data Path Physical Connection – connect the primary drive data cable to the customer SAN 
or host.

• Library Control Path Physical Connection – the drive data cable becomes the physical connection 
for a library control path. Part of setting up a partition is to designate the control path drive for that 
partition. The control path drive for a partition must be a drive that is assigned to that partition. 

Cabling Configuration for Native Attach Drives

Pre LTO-5 Native Attach Drives
Pre LTO-5 native attach drives DO NOT come with any auxiliary FC I/O Blades or EEB’s

• Drive Data Path Physical Connection - connect the primary drive data cable to the customer SAN 
or host

• Library Control Path Physical Connection – The primary method of connecting any library control 
path is through the physical SCSI or FC connector on the library MCB.
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LTO-5 Native Attach Drives 
LTO-5 native attach drives are similar to Storage Networking drives because they are automatically 
accompanied by an EEB. The EEB is NOT a drive data path connection point.   Native attach drives differ 
from Storage Networking drives because they do not have a Storage Networking License to enable the 
Storage Networking feature set. An LTO-5 native attach drive still allows the drive to become a “bridge” for 
the library control path to reach the customer SAN or hosts.

• Drive Data Path Physical Connection – connect the primary drive data cable to the customer SAN 
or host.

• Library Control Path Physical Connection – the drive data cable becomes the physical connection 
for a library control path. Part of setting up a partition is to designate the control path drive for that 
partition.

Interaction of Physical Cabling and Library Configuration Options
• The maximum hosts mapped to a single FC I/O blade is 64 per port. This same limitation applies to 

the data port of a Storage Networking LTO-5 drive.

• The FC I/O blades have active channel zoning that can affect which hosts have access to which 
drives. Ensure that you define your channel zoning to match the physical cabling of the drives.

• When cabling drives, ensure that they are cabled to the correct hosts for the defined partitions. The 
physical cabling must allow connection of desired hosts to desired library partition(s) and drives.

• LTO-5 drives should never be connected to both a FC I/O blade and an EEB. Certain library 
features can work over either physical connection, but do not work properly if both connections are 
present.

• LTO-5 drives connected to FC I/O blades are limited to a 4 Gbps connection speed because the FC 
I/O blade is a 4 Gbps device.

Attaching Drives to FC I/O Blades

The FC I/O blades support connections to LTO-1, LTO-2, LTO-3, LTO-4, LTO-5,. DLT-S4, and SDLT-600 
drives.

Libraries that have control management blade (CMB) in the I/O management unit support connection to the 
drives and library controller through FC I/O blades. The hosts communicate with the drives via the FC I/O 
blades. The drives are represented by their own unique FC_LUN ID assigned by its respective I/O blade 
(data path). 

Although direct host connection to the MCB is possible, communication through the library partition to I/O 
blade fibre ports is the recommended standard practice unless special requirements exist. Each library 
partition will have a respective LUN ID mapped to a user selectable FC I/O blade port.The library partition 
LUN is mapped to a host port on the same FC I/O blade to which the partition's drives are connected. Host 
connectivity. Direct attached LTO-5 drives can be configured using control path and SNW functionality. See 
Working with Library Control Paths on page 180.
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Table 5 shows which FC I/O blades must be connected to the FC drive in each of the 12 drive coordinates 
in either a control module or expansion module. For information on the library’s coordinate system, see 
Storage Addressing System Overview on page 132.

Table 5 Cable Connection Requirements for FC Drives

FC I/O Blade Positions in the 
I/O Management Unit FC Connection on I/O Blade Drive Coordinates

Bay 3 FC-3 1,1,1,1,1,1

Bay 3 FC-4 1,1,1,2,1,1

Bay 3 FC-5 1,1,1,3,1,1

Bay 3 FC-6 1,1,1,4,1,1

Bay 4 FC-3 1,1,1,5,1,1

Bay 4 FC-4 1,1,1,6,1,1

Bay 4 FC-5 1,1,1,7,1,1

Bay 4 FC-6 1,1,1,8,1,1

Bay 5 FC-3 1,1,1,9,1,1

Bay 5 FC-4 1,1,1,10,1,1

Bay 5 FC-5 1,1,1,11,1,1

Bay 5 FC-6 1,1,1,12,1,1
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Figure 12  shows an example of drives connected to the FC I/O blades.

Figure 12 Example of Drives Connected to FC I/O Blades

Drives can only be connected to ports FC-3 through FC-6. Host connections are made through ports FC-1 
and FC-2.

connection to host or SAN

cable from FC-3 to drive coordinate 1,1,1,1,1,1

cable from FC-4 to drive coordinate 1,1,1,2,1,1

cable from FC-5 to drive coordinate 1,1,1,3,1,1

cable from FC-6 to drive coordinate 1,1,1,4,1,1
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Connecting FC Drives to FC I/O Blades
Use these instructions to install the Fibre optical cables that connect the FC drives to the FC I/O blades.

Required tools: ESD strap

1 Open the service door of the control module or expansion module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Remove and discard the white plastic LC covers from the FC connectors on the tape drives.

4 Remove and discard the necessary number of the black rubber protective covers from the ports on the 
FC I/O blades.

5 Carefully unwrap the six-foot Fibre optical cables and remove the two white plastic protective caps from 
each end of the cable.

6 Connect the Fibre optical cable to port FC-3 on the FC I/O blade that is installed in bay 3 of the I/O 
management unit. See Table 5 on page 114 for information about the cable connection requirements.

Note • See Table 5 on page 114 to see the correct location where the Fibre optic 
cables will be connected.

• The goal when installing the FC cables is to keep the cables out of the way of 
the other components in the control module or expansion module. Use the 
cable keepers and Velcro straps to accomplish this.

• A maximum of four FC drives can be connected to one FC I/O blade.

CAUTION
Fibre optical cables will be damaged if they are bent at more than a 
four inch arc. 

port FC-3 on the 
FC I/O blade in
in bay 3
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7 Route the cable through the cable keepers and down the right side of the control module or expansion 
module.

8 Insert the Fibre optical cable into the Fibre Channel connection on the drive. 

9 Repeat Step 5 on page 116 through Step 8 on page 117 for each drive that will be installed.

Note The FC port and drive numbers will change according to Table 5 on page 
114.

cable connected to FC 3 on
FC I/O blade in bay 3 of the
I/O management unit

Fibre optic cable routed
through cable keepers

Fibre optic cable connected
to drive in coordinate 1,1,1,1,1,1
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10 Gather the fibre optical cables and put them inside the Velcro straps that are attached to the right side 
of the module.

11 Connect the designated host to the FC-1 or FC-2 port on the FC I/O blade.

12 Detach the ESD strap.

use Velcro straps
to secure cables
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Attaching FC LTO-5 Drives to Ethernet Expansion Blades

The Ethernet Expansion blade (EEB) provides the option for Ethernet connectivity to each LTO-5 drive for 
library-to-drive communication purposes only. The EEB is not in the data path as the FC I/O blade, but 
provides a control path to the LTO-5 drive for partition move medium commands as well as functionality. 
Each EEB has six Ethernet ports to allow attachment to six LTO-5 drives. The EEB provides Ethernet 
connectivity to the library's internal Ethernet and should not be connected to an external Ethernet source. 
External Ethernet cables should not be connected to your LTO-5 drives.

Note An LTO-5 tape drive cannot be connected to both an EEB and a FC I/O blade. 
See Installing Drives on page 105.

Table 6 Cable Connection Recommendations for Ethernet Expansion Blades

EEB Positions in the 
I/O Management Unit LTO-5 Connection on EEB Drive Coordinates

Bay 7 ETH-1 1,1,1,1,1,1

Bay 7 ETH-2 1,1,1,2,1,1

Bay 7 ETH-3 1,1,1,3,1,1

Bay 7 ETH-4 1,1,1,4,1,1

Bay 7 ETH-5 1,1,1,5,1,1

Bay 7 ETH-6 1,1,1,6,1,1

Bay 8 ETH-1 1,1,1,7,1,1

Bay 8 ETH-2 1,1,1,8,1,1

Bay 8 ETH-3 1,1,1,9,1,1

Bay 8 ETH-4 1,1,1,10,1,1

Bay 8 ETH-5 1,1,1,11,1,1

Bay 8 ETH-6 1,1,1,12,1,1
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Figure 13 Example of LTO-5 Drives Connected to Ethernet Expansion Blades

LTO-5 Drive 

1,1,1,1,1,1

1,1,1,2,1,1

1,1,1,3,1,1

1,1,1,4,1,1

1,1,1,5,1,1

1,1,1,6,1,1

1,1,1,7,1,1

1,1,1,8,1,1

1,1,1,9,1,1

1,1,1,10,1,1

1,1,1,11,1,1

1,1,1,12,1,1

EEB port connection
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Connecting LTO-5 Drives to Ethernet Expansion Blades
Use these instructions to install the Ethernet Expansion blade cables that connect the LTO-5 drives to the 
Ethernet Expansion blades.

Required tools: ESD strap 
Use Quantum provided cables: FRU ID 834

1 Open the service door of the control module or expansion module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Remove and discard the protective covers from the Ethernet connector on the tape drives.

4 Remove and discard the protective covers from the ports on the Ethernet Expansion blades.

5 Carefully unwrap the EEB cables.

6 Connect the EEB cable to ETH 1 on the EEB that is installed in bay 7 of the I/O management unit. See 
Table 6 on page 119 for information about the cable connection requirements.

Note • See Table 6 on page 119 to see the correct location where the EEB cables 
will be connected.

• The goal when installing the EEB cables is to keep the cables out of the way 
of the other components in the control module or expansion module. Use the 
cable keepers and Velcro straps to accomplish this.

• A maximum of six LTO-5 drives can be connected to one Ethernet expansion 
blade.

port 1 on the 
EEB in
in bay 7
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7 Route the cable through the cable keepers and down the right side of the control module or expansion 
module.

8 Insert the EEB cable into the EEB port connection on the drive.

9 Repeat Step 5 on page 121 through Step 8 on page 122 for each drive that will be installed and 
connected to an EEB.

Note The EEB port and drive numbers will change according to Table 6 on page 
119.

EEB cable routed
through cable
keepers

EEB cable connected
to drive coordinate 1,1,1,1,1,1
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10 Gather the EEB cables and put them inside the Velcro straps that are attached to the right side of the 
module.

11 Detach the ESD strap.

use Velcro straps
to secure cables
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Attaching Hosts to FC Ports

Each FC I/O blade installed in the library has two ports reserved for connection to hosts or the SAN. These 
ports are FC-1 and FC-2. By default, ports FC-1 and FC-2 are in target mode. The other four ports (FC-3, 
FC-4, FC-5, and FC-6) are in initiator mode by default.

A library that has multiple FC I/O blades may have many connections to several hosts. 

One way to manage these connections is through the use of FC persistent binding, which enables the 
administrator to control the devices that are to be presented to the hosts.

Persistent binding permanently maps a device to the following:

• Binding type (world wide port name (WWPN), world wide node name (WWNN), or a destination 
identifier (D_ID)

• SCSI bus

• SCSI ID

The driver on the host detects all devices attached to the host bus adapters (HBA). By default global 
automapping assigns a binding type, target ID, SCSI bus, and SCSI ID to the device. The binding type, SCSI 
bus, and SCSI ID may change when the library is rebooted. When persistent binding is applied to one of 
these targets, the binding type, SCSI bus, and SCSI ID remain the same whether the library is rebooted or 
whether Global Automap All Targets is subsequently disabled. The automap is enabled by default.

The binding information is permanent because it is stored in the host registry or configuration file on a UNIX 
host. The driver refers to the binding information when the library boots.

You are now ready to configure the library using the instructions in Configuring the Library on page 153.

Attaching FC and SCSI Drives Directly to Hosts

In direct attached library configurations, the controlling host system connects directly to either the SCSI or 
Fibre Channel (FC) drives in the library.

In the direct attached configurations, the management control blade (MCB) has one library control port 
(SCSI or FC) connecting to the controlling host computer. The MCB SCSI control port provides its own 
termination.

Tape drives attach directly to host computers and are represented by their own unique SCSI ID or world 
wide node name/world wide port name (WWNN/WWPN) and FC_LUN ID. For information on LTO-5 

There are limitations on the number of hosts that can access a single drive. Limitations are summarized 
below: 

• SCSI-attached drives support a maximum of two initiators on the same bus

• Fibre Channel-attached drives support a minimum of one initiator

The Fibre Channel LTO-1 tape drive is an arbitrated-loop-only device (also known as an NL ports). The drive 
supports Fibre Channel Arbitrated Loop (FC-AL) protocol, and uses Class 3 Service frames. The drive also 
supports both public (switch-attached) and private loops. This is not true for the LTO-2 and LTO-3 drives.

Note Persistent binding must be redone if the fibre optical cables connected to the 
FC I/O blades are changed.
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The library uses a LUN ID which is configured by using the Library Management Console (LMC) FC host. 
Library partitions as well as drives are presented as devices to be mapped. SCSI IDs or cabling may affect 
which SCSI device map LUN is associated with which FC host or SCSI host LUN ID; therefore, caution is 
required to ensure that the device order is not altered when swapping drives, cables, or locations. The 
partition should map to a higher priority LUN than the drives.

Examples of the direct attach cabling for SCSI and Fibre Channel drives are shown in Figure 14 on page 
126 and Figure 15 on page 127.

Note • To connect a SDLT-600 to a SAN Fabric, you must either connect that drive 
to designated port on the FC I/O blade or directly attached the drive to a host.

• Cabling may be affected by partitioning or zoning changes done as part of 
configuration. 

• When cabling to drives, ensure that they are cabled to the correct hosts for 
the defined partitions.
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Figure 14 Example of Direct Attached Library With SCSI Drives

The MCB has one library control Fibre Channel port, which connects directly to the controlling host 
computer. This Fibre Channel port is located on the MCB that is installed into the control module.

Note In the example shown in Figure 14 , the SCSI drives 2, 4, 6, 8, 10, and 12 must 
be terminated by installing an appropriate terminator on the ports shown.

CAUTION
Do not cable a drive to the MCB. The library does not support using the 
MCB as a terminating device on a chain of drives.

library controller
to host

install
terminators

install terminators

secure cables with 
Velcro straps

cables routed to
the SAN or hosts

Ethernet
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Figure 15 Example of Direct Attached Library with FC Drives

cables routed

library controller

directly from the

secure the cables

drives to hosts 

to host cable

or the SAN

to the sides of the
modules using the
Velcro straps

Ethernet
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Connecting FC Drives to Hosts
The procedure in this subsection tells how to directly attach compatible tape drives to the host computers.

Required tools: ESD strap

1 Open the service door of the control module or expansion module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Remove and discard the white plastic covers from the FC connectors on the tape drives.

4 Carefully unwrap the Fibre optical cables and remove the two white plastic protective caps from each 
end of the cable.

5 Label each end of the cables with the drive number and the destination host name. You should label 
the end that connects to the tape drive with the name of the host and the end that connects to the host 
with the name and location of the tape drive. This will help you find the correct cable if there is a cable 
problem in the future.

6 Connect the fibre optical cable to the Fibre port on the drives.

7 Connect a fibre optic cable to the port of the MCB in the control module. 

8 If e-mail notification is going to be used to monitor the library, connect the Ethernet cable that is provided 
with the library to the Ethernet port on the MCB in the control module. 

9 Route all cable to the right side of the module and either up through one of the three holes in the top or 
down through the opening at bottom of the control module. Secure the cable to the right side using the 
Velcro straps.

10 Connect the fibre optical cable from the MCB to the server that has been designated to interface with 
the library.

11 Connect the fibre optical cables from the drives to the designated hosts.

12 Connect the Ethernet cable to the customer network.

13 Detach the ESD strap.

Note The goal when installing the FC cables is to keep the cables out of the way of 
the other components in the control module or expansion module. Use the 
cable keepers and Velcro straps to accomplish this.

CAUTION
Fibre optical cables will be damaged if they are bent at more than a 
four-inch arc. 

Note Make sure the cables are out of the way of other equipment and not in a 
position where they can be damaged
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Connecting SCSI Drives to Hosts
The procedure in this subsection tells how to directly attach SCSI tape drives directly to the host computers. 

Required tools: ESD strap

1 Open the service door of the control module or expansion module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Unwrap the SCSI cables.

4 Label each end of the cables with the drive number and the destination host name. You should label 
the end that connects to the tape drive with the name of the host and the end that connects to the host 
with the name and location of the tape drive. This will help you find the correct cable if there is a cable 
problem in the future.

5 Connect the SCSI cable to the port on the drives.

6 Install the SCSI terminators.

Note The goal when installing the SCSI cables is to keep the cables out of the way of 
the other components in the control module or expansion module. You will use 
the cable keepers and Velcro straps to accomplish this.

secure cables using

install terminators if you

the Velcro straps

Ethernet

library controller
to host cable

are “daisy-chaining” the
SCSI drives
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7 Connect a SCSI cable to the port of the MCB in the control module. 

8 If e-mail notification is going to be used to monitor the library, connect the Ethernet cable that is provided 
with the library to the Ethernet port on the MCB in the control module. 

9 Route all cable to the right side of the module and either up through one of the three holes in the top or 
down through the opening at bottom of the control module. Secure the cable to the right side using the 
Velcro straps.

10 Connect the SCSI cables from the drives to the designated hosts.

11 Connect the SCSI cable from the MCB to the server that has been designated to interface with the 
library.

12 Connect the Ethernet cable to the internal network.

13 Detach the ESD strap.
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Installing Cartridges
This chapter gives instructions for loading cartridges into the library. The information provided includes:

• Loading Cartridges on page 131

• Installing Barcode Labels on page 137

• Importing Cartridges Using the I/E Station on page 139

• Manually Bulk Loading Cartridges on page 142

Loading Cartridges

Loading cartridges into a large library configuration can be time consuming.

Cartridges can be loaded two ways:

• Import: If the library will have more than one partition, insert cartridges in the I/E station and use 
the Library Management Console (LMC) to import the cartridges. For more information, see 
Importing Cartridges Using the I/E Station on page 139.

• Bulk Load: If the library will only have one partition, open the access door and manually insert 
cartridges in the magazines that are licensed for access by the customer. If you cannot locate the 
license keys shipped with the library, you can obtain them by contacting Quantum Technical 
Assistance Center. For more information, see Manually Bulk Loading Cartridges on page 142.
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Storage Addressing System Overview

The library uses a coordinate addressing system that defines the location of cartridges using six 
coordinates. The coordinates are represented by the library in a comma separated list. For example:

Each of the variables are explained in the following bulleted list:

• Aisle - There is only one aisle in the library. This value will always be 1.

• Module - There are from one to twelve modules, the control module and up to eleven expansion 
modules. The value will be between 1 and 12.

• Rack - There are two rack designations inside each module. These will always be either 1 or 2, with 
2 being the inside of the access door.

Figure 16 Aisle, Module, and Rack Numbering Locations

• Section - There are 10 sections in a rack, numbered from top to bottom as you face the rack.

• Column - There are four columns in a rack, numbered from left to right as you face the rack. These 
are numbered between 1 and 4.

• Row - This is equal to one cartridge slot. The number of rows per section can vary depending on 
the size of the cartridge. The rows are numbered between 1 and 6 for LTO cartridges and 1 and 5 
for DLT cartridges.

1,1,1,1,2,1 = aisle 1, module 1, rack 1, section 1, column 2, row 1

aisle value
is always 1

back of modules

front of modules

modules 1 through 4

racks 1 and 2

(from left to right)
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Figure 17 shows the section, column and row numbering for rack 1 of a module with LTO cartridges. See 
Figure 16 on 132 to review the rack numbering. 

Figure 17 Section, Column, and Row Numbering Locations for Rack 1 Using LTO Cartridges 

Note When tape drives are installed on rack 1 of a control module or expansion 
module, they replace the storage in columns 1 and 2. Because drives are 
installed from the bottom to the top you will lose the storage starting in section 
10 first. You do not lose the magazine in column 2 of section 5. 
 
Column 1 does not contain storage in the control module. 
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Figure 18 shows the section, column and row numbering for rack 2 of a module using LTO cartridges. See 
Figure 16 on 132 to review the rack numbering. 

Figure 18 Section, Column, and Row Numbering Location for Rack 2 Using LTO Cartridges

Note The cartridges in the 24-slot LTO I/E station are addressed as part of column 3 
and are in sections 1 through 4 (top to bottom). When you have an I/E station 
installed on rack 2, there are no cartridges in columns 3 and 4 of sections 1-5. 
See Figure 18 for an illustration.

Note In Figure 18 on 134, the five magazines shown in column 4, sections 6-10 do 
not exist in a control module. The magazines do exist in expansion modules.

1 432

2

1

8

5

7

3

4

6

9

10

1 432

2

1

8

5

7

3

4

6

9

10

se
ct

io
n

column

I/E station

this column of magazines are 
not present in a control module

column 3, section 1

column 3, section 2

column 3, section 4

column 3, section 3
134 Installing Cartridges



Figure 19 on 135 shows example location coordinates. The examples assume that the linear storage are 
located in aisle 1, module 1, and rack 1. That is why the first three numbers in the comma separated list are 
1,1,1. The last three numbers represent the address on the linear storage assembly.

Figure 19 Example Location Coordinates 
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The Library Management Console (LMC) uses dialog boxes like the one in Figure 20 that enable you to 
specify cartridge locations. These coordinates are reported in parenthetical format, each element separated 
by commas. In parenthetical format, the location for the device listed in the Load Drives dialog box below 
would be written (1,1,2,2,2,2).

Figure 20 Location Coordinates Used in the Load Drives Dialog Box
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Installing Barcode Labels

Each cartridge in the library must have an external label that is operator and machine readable to identify 
the barcode number. Most manufacturers offer cartridges with the labels already applied or with the labels 
included that can be attached at the customer site.

All barcode labels are applied to the front of a cartridge. Figure 21 on 137 shows an example of a barcode 
label being applied to a LTO cartridge.

Figure 21 Applying Barcode Labels to LTO Cartridges 

Note Duplicate barcodes are not supported even if you have mixed media or multiple 
partitions in the library. If the library has cartridges with identical barcode labels, 
the library will issue a ticket notifying you of the problem. Areas in the LMC 
where media IDs are listed will show information for the first cartridge, but the 
cartridge with the duplicate barcode label will not be listed. 

Note To ensure the proper operation of tape cartridges, pickers, and drives, make 
sure your hands are dirt- and grease-free before handling tape cartridges. 
Clean the sides of all tape cartridges with a clean, dry paper towel or cloth 
before installing them in the library.

CAUTION
Do not place a barcode label on top of a cartridge. Placing a barcode 
label on top of a cartridge can cause an inventory to fail or damage 
the drive.

top of cartridge

write protect lock

barcode label
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Barcode Requirements
Cartridges must have an external barcode label that is machine-readable to identify the volume serial 
number. A barcode must use only uppercase letters A to Z and/or numeric values 0 to 9. The library supports 
Code 39 (3 of 9) type barcode labels.

For LTO media barcodes, the library dynamically supports 1 to 14 characters for volume serial number plus 
a two-character media type identifier. See the image below for an example of a supported LTO barcode 
label.

For SDLT I media barcodes, the library dynamically supports 1 to 6 characters for volume serial number 
plus a one-character media type identifier. The image below is an example of a supported SDLT I barcode 
label.

For SDLT II media barcodes, the library dynamically supports 1 to 6 characters for volume serial number 
plus a one-character media type identifier. The image below is an example of a supported SDLT II barcode 
label.

For DLT-S4 media barcodes, the library dynamically supports 1 to 6 characters for volume serial number 
plus a one-character or two-character media type identifier. The media identifier should be either “4”.

Quantum-supplied barcode labels will provide the best results. Barcode labels from other sources can be 
used, but they must meet the following requirements:

• ANSI MH10.8M-1983 Standard 

• Number of digits: 6+1 (DLT) or 6+2 (LTO)

• Background reflection: greater than 25 percent 

• Print contrast: greater than 75 percent 

• Ratio: greater than 2.2 

• Module: >= .254 mm

• Print tolerance: ±57 mm 

two character media
identifier (L1, L2, L3, LT, L4, LU, L5, LV)

character media identifier
must be an “S”

character media identifier
must be a “2”
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Additional Requirements: 

• Height of the visible portion of the barcode: 10 mm ±2 mm

• Length of the rest zones: 5.25 mm ±0.25 mm 

• No black marks should be present in the intermediate spaces or rest zones

• No white areas should be present on the bars 

Importing Cartridges Using the I/E Station

These instructions assume that you have already entered your license key, set up your partitions, and 
attached the barcode labels to the cartridges. You will use the I/E station to load cartridges.

1 Make sure that you are viewing the partition into which you want to import a cartridge. 

2 From the View menu, select a partition.

3 Click Operations > Import to add cartridges into the partition.

The Import Media dialog box appears.

4 Click Yes if you are prompted to take the partition offline.

Note To ensure the proper operation of tape cartridges, pickers, and drives, make 
sure your hands are dirt- and grease-free before handling tape cartridges. 
Clean the sides of all tape cartridges with a clean, dry paper towel or cloth 
before installing them in the library.
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5 Insert cartridges into appropriate I/E station magazines. 

You can insert multiple cartridges up to the maximum number of slots in your I/E station. You must insert 
cartridges in the correct I/E stations magazines based on how you created the partitions. As the 
cartridges are inserted into the I/E station, the scanner automatically reads the barcodes.

To see which I/E stations are associated with a particular partition, click Monitor→ I/E Station.

6 Select Operations→ Import or use the Import toolbar button.

The Import Media dialog box appears with a list of cartridges in the I/E station displayed. The following 
table describes the elements on the Import Media dialog box.

Element Description

IE Station # The number of the I/E station, which is the same as the control 
module or expansion module that contains it. 
All 24-slot single door I/E stations are numbered starting with 1 at 
the control module. All 72-slot double door I/E stations are 
numbered with a number and a letter . “A” indicates the first 36 slots 
on the left side of the I/E station. “B” indicates the right side.

Magazine # The number of the I/E station magazine (numbered from top to 
bottom in the I/E station). 

Media ID The cartridge barcode or the word EMPTY. 

Slot Type Media type, for example LTO.

Partition Name The name of the partition to which the I/E station is assigned.
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7 Click Import.

The accessor moves the cartridge automatically from the I/E station to the first available empty slot in 
that partition. You cannot manually specify the destination slot.

Designation Description

Media ID The volume serial number of the cartridge

Slot The row where the cartridge located.

I/E station The number of the I/E station, which is the same as the control 
module or expansion module that contains it. 
All 24-slot single door I/E stations are numbered starting with 1 at 
the control module. All 72-slot double door I/E stations are 
numbered with a the module and a letter. “A” indicates the first 36 
slots on the left side of the I/E station. “B” indicates the right side.

Magazine The number of the magazine (section) where the slot is located, 
numbered from the top down

Results “Imported” or “Failed”
Scalar i6000  Installation Guide 141



Manually Bulk Loading Cartridges

This section provides instructions for bulk loading cartridges into the library.

Figure 22 Cartridge Insertion Into Magazine

Bulk loading of cartridges must be done with caution. When bulk loading cartridges make certain:

• All cartridges have a valid barcode label.

• The barcode side is facing out of the slot.

• The cartridge is completely seated in the slot. The accessor assembly motion can be impeded if the 
cartridge is not completely seated within the slot.

• The media is not inserted in the slot upside down (see Figure 22 ).

• The media is not dropped while loading it into the library.

Note To ensure the proper operation of tape cartridges, pickers, and drives, make 
sure your hands are dirt- and grease-free before handling tape cartridges. 
Clean the sides of all tape cartridges with a clean, dry paper towel or cloth 
before installing them in the library.

CAUTION
Do not bulk load cartridges into a library that will have more than one 
partition because there is a risk the cartridges will not be accessible 
by a specific partition.

Also, it is possible to insert cartridges into unlicensed slots when 
they are installed manually.

top of cartridge

front of cartridge

magazine
142 Installing Cartridges



Follow these instructions to bulk load the magazines.

1 From the LMC, select a partition using the View menu.

You are prompted to take the partition offline.

2 When prompted to take the partition offline, click Yes.

3 Press the Robotics Enabled button.

4 Open the access door of the control module or expansion module.

5 When you have completed your bulk load, make sure all cartridges are inserted completely.

6 Close the access door of the control module or expansion module.

7 Press the Robotics Enabled button.

8 Run the Inventory command by clicking Operations→ Inventory from the LMC. 

Click OK to start the inventory. You are prompted when the inventory is complete.

You are now ready to continue installation with the instructions in Setting up Your Library for Access on page 
145.
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Setting up Your Library for Access
This chapter contains the compatibility requirements and instructions for setting up a computer for remote 
library access. The instructions include:

• Configuring Library Security on page 146

The same Library Management Console (LMC) available from the local library touchscreen is also available 
as a Java applet using a Web browser.

Launching the Remote Client

In order to manage your library remotely, point your client to the IP address of the library. Only one 
administration user should be logged on and performing library configuration at any one time. 

Use one of the following procedures to start the LMC, depending on the operating system being used.

Note • Only one LMC session should be running on a single host at the same time.
• Only one LMC session should be run against a single library at one time.
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Configuring Library Security

You can change the internal IP address of the library and other library security settings, including enabling 
or disabling network services, enabling or disabling remote access to the library, setting up firewall access 
for server callbacks to remote clients, and enabling or disabling SNMP or SMI-S access.

Changing Internal IP Network Addressing
The default internal network subnet setting for the Scalar i6000 is 10.10.X.X. Attaching the library to a 
10.10.X.X external network can cause library and network problems. The Change Internal IP dialog box 
enables you to change the library’s internal IP addressing so that conflicts do not occur. This dialog box is 
accessible only from the library’s touch screen. You must be logged in as a Service user to access this 
feature.

Keep in mind the following considerations:

• You only need to change the default internal IP setting if your external network is 10.10.X.X.

• Do not set up internal IP addressing to conflict with existing external IP addressing. If you set up the 
same IP subnet for both the internal and external IP networks (for example, 10.10.X.X), the library 
will become unusable.

• If you change the internal IP addressing, and then later a user opens the Network Configuration 
dialog box (Setup→ Network Configuration) to assign a static IP address to the library that 
conflicts with the internal network, the assignment request will fail and the library will issue a ticket.

• If you change the internal IP addressing, and if Dynamic Host Configuration Protocol (DHCP) is 
enabled and DHCP assigns to the library an IP address that conflicts with the internal network, 
address conflicts could occur between internal library devices and external customer devices and 
the library will issue a ticket.

1 Log on as the service user.

2 Click Service→ Change Internal IP.

The Change Internal IP dialog box appears.

By default, the internal IP subnet address that is automatically selected on this dialog box is not the one 
to which your internal network is currently set. In the example shown, the current internal network IP 
setting is 10.10.X.X, and the automatic selection by default is 10.20.X.X. If this selection is accepted, 
the internal IP setting will change to 10.20.X.X.
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3 To accept the automatic internal IP setting, click OK.

The following message appears.

4 If you are sure that you want to make the change, click Yes.

5 After the library processes the request successfully, a message appears that asks you whether you 
want to shut down the library. You must shut down and restart the library.

CAUTION
Setting the internal IP network to be on the same subnet that the 
external IP network is on causes library failure and results in the 
management interface (the management control blade (MCB)) 
becoming unusable. For example, if you set 10.10.X.X as the internal 
IP network and your external IP network is also 10.10.X.X, a conflict 
occurs. If you are unsure about whether the change is appropriate, 
click No.
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Changing the Library Security Configuration
The Security Configuration dialog box enables you to restrict external users and various remote services 
from accessing the library through the Ethernet port on the MCB. It also enables you to configure the 
session timeout. 

Accessing the Security Configuration
1 Log on as the service user.

2 Click Setup→ Security.

The Security Configuration dialog box appears with the Services tab displayed.

Configuring Access for Network Services
The Services tab on the Security Configuration dialog box enables you to entirely prevent all external 
access to the library or allow access according to other security settings on this dialog box. It also enables 
you to allow or prevent access by SSH, SSHv1, and to allow or prevent external attempts to discover the 
library by pinging it.

1 Click the Services tab on the Security Configuration dialog box.

Note Changing security configuration settings using the remote client might cause a 
loss of connectivity. If this happens, use the local touch panel to reset the 
security configuration settings and restore remote connectivity.
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2 You can change the security settings for any of the following items:

• Network Interface — To entirely prevent all external access to the library through the MCB 
Ethernet port, regardless of other settings on the Security Configuration dialog box, select 
Disable. To allow external access to the library in accordance with other security settings on 
the Security Configuration dialog box, select Enable. (The Network Interface option is 
unavailable when accessing the LMC remotely.)

• ICMP — To prevent external attempts to discover the library by pinging it (by means of Internet 
Control Message Protocol [ICMP] Echo packets), select Disable. Using this setting can prevent 
denial-of-service (DoS) attacks, which can flood the library with pings and cause loss of network 
connectivity and services.

If Dynamic Host Configuration Protocol (DHCP) is enabled for your library on the Network 
Configuration dialog box (Setup→ Network Configuration), you also should enable ICMP. 
This ensures that the DHCP server can determine whether the IP address that is assigned to 
the MCB is still valid. (ICMP is enabled by default.)

• SSH—To prevent Secure Shell access to the library, select Disable. To allow SSH to run on 
the library, select Enable. 

• SSHv1—To prevent Secure Shell version 1 protocol from running on the library, select Disable. 
To allow SSH v1 to run on the library, select Enable. 

• HTTP—To prevent access to library using the remote Java browser, select Disable. If you 
choose disable HTTP, access to the library is limited to the library’s operator panel. To permit 
access to the library GUI using a remote Java browser, select Enable.(The Network Interface 
option is unavailable when accessing the LMC remotely.)

3 If you want to apply the changes, but you do not want to close the dialog box, click Apply. Otherwise, 
click OK to apply the changes and close the dialog box.

Configuring Access for Remote LMC Clients
You can use the LMC tab on the Security Configuration dialog box to configure the following options:

• To allow or prevent remote LMC client access to the library. 

• To set up firewall access for server callbacks to remote clients. 

• To enable or disable service login.

• To set up the length of time before a session timeout.
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1 Click the LMC tab on the Security Configuration dialog box.

2 Change the security settings for any of the following items:

• Remote Access — To prevent all remote LMC clients from accessing the library, select 
Disable. To allow them to access the library, select Enable. (The Network Interface option is 
unavailable when accessing the LMC remotely.).

Select Use SSL to enable secure communication between the LMC client and the library.

• Callback Port Range — To configure firewall access for server callbacks to remote clients, 
type the first port number of a range of ports that you want to be used for callbacks in the 
Starting text box, and then type the last port number in the Ending text box. Valid port ranges 
must fit within the range 1024 to 65535. Remote client service ports must be within the range 
of ports specified here. Otherwise, callbacks fail because the library’s firewall blocks outbound 
packets designated for out-of-range ports.

• Service Login — To allow service login, select Enable. To prevent service login, select 
Disable. The Admin user can enable or disable the service user login on both the front panel 
access and the remote client access.

• Session — To configure the length of the session’s timeout, type or use the arrow buttons to 
specify the length of a session before it times out. Valid session timeouts are 1-1440 minutes 
(1 minute - 24 hours), where the default is 30 minutes.

3 If you want to apply the changes, but you do not want to close the dialog box, click Apply. Otherwise, 
click OK to apply the changes and close the dialog box.

Note Enabling SSL can impact the network performance of remote operations 
(for example, downloading new library software).

Note The default service login through the service port is still available for use. 
For security purposes, the service port can be physically locked down by 
locking the back door of the i6000.
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Configuring Access for SNMP and SMI-S
The SNMP/SMI-S tab on the Security Configuration dialog box enables you to allow or prevent SNMP or 
SMI-S traffic across the MCB Ethernet port.

1 Select the SNMP/SMI-S tab on the Security Configuration dialog box.

2 Change the security settings for any of the following items:

• SMI-S — To enable SMI-S traffic (port 5988), select the Enable SMI-S check box. To allow 
encryption of SMI-S traffic (SSL, port 5989), select the Enable Secure SMI-S check box.

• SNMP — To prevent all SNMP traffic across the MCB Ethernet port, select Disable. To allow 
SNMP GET operations, select Enable.

If SNMP traffic is allowed, then SNMP v3 is always available. If you want to permit less secure 
SNMP access, select Enable SNMP v1 and v2. If you decide you do not want to use SNMP v1 
and v2, clear the Enable SNMP v1 and v2 check box.

The library ignores all remotely issued SNMP SET operations under any circumstance, which 
means that external applications cannot register themselves to receive SNMP traps from the 
library. However, the Trap Registration dialog box (Setup→ Trap Registration) enables you 
to perform this registration yourself by entering the necessary IP and port information. For more 
information about the Trap Registration dialog box, see the Scalar i6000 User’s Guide.

3 If you want to apply the changes, but you do not want to close the dialog box, click Apply. Otherwise, 
click OK to apply the changes and close the dialog box.

Note Port 427 is used for Service Location Protocol (SLP), which is used along 
with the Common Information Model (CIM) server.
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Configuring the Library
This chapter provides step-by-step instructions for configuring the library using the Library Management 
Console (LMC). The information in this chapter includes:

• Addressing Configuration Prerequisites on page 153

• Logging on to the Library on page 154

• Performing Basic Configuration on page 156

• Performing Advanced Configuration on page 163

• Working with Library Control Paths on page 180

• Creating Partitions on page 182

• Putting Physical Library and Partitions Online on page 220

• Configuring Drive Cleaning on page 223

• Saving the Library Configuration on page 228

• Logging Off on page 229

Before the library can be used, there is some basic configuration that must be done. Configuration varies 
depending on the type of library and the features that will be used. Before configuring the library, you should 
review all Technical Bulletins and Release Notes and Errata for the product.

Addressing Configuration Prerequisites

You must obtain the following information from the customer, before configuring the library.

• Proposed IP address of library 

• Subnet Mask for local network 

• IP address for the gateway on the local subnet 

• IP address of the SMTP server 

• Access account of SMTP server

Note Only one administrator can be logged on and performing library configuration 
at any one time. If another administrator attempts to log on, a message 
appears, warning that only one administrator at a time is permitted on the 
library. If a service user logs on while an administrator or regular users are 
logged on, the library automatically logs off those users.
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• Customer e-mail addresses (if they want e-mail notification)

Logging on to the Library

After the library has finished booting, you will see the Logon dialog box. Use the keyboard displayed on the 
touch screen to log on.

1 Position the cursor in the Name text box by tapping it. 

2 Use the keyboard to type the word admin in the Name text box.

3 Position the cursor in the text box below the Name text box by tapping it.

4 Use the keyboard to type the word password in the text box.

5 Select OK.

You must now decide which method you want to use to configure the library:

• If you want to perform a minimal configuration using the Setup Wizard, proceed to the instructions 
in Performing Basic Configuration on page 156.

Note Select the Shift key to access uppercase and special characters.

Note If you are logging on to the library for the first time using the default 
administrator account (admin), type password. After you log on, the library 
prompts you to change the default admin password. You must enter and 
confirm a new password. Passwords that are most secure include a 
combination of letters, numbers, and non-alphanumeric characters. 
Passwords must be eight or more characters in length. The word 
“password” is not available for use.

Note You can change the default password at anytime. This helps ensure 
security standards for the site.
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• If you want to perform the configuration manually using Expert Mode, proceed to the instructions 
in Performing Advanced Configuration on page 163.

Note You cannot create partitions that include mixed media using the Setup Wizard. 
You must perform the configuration manually using Expert Mode.
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Performing Basic Configuration

The minimal configuration can be performed using the Setup Wizard and then enabling notifications. The 
configuration items in the Setup Wizard are typically sufficient for customers running libraries without FC I/
O blades.

Before you can run the Setup Wizard, you must first delete a default partition that is created by the library 
during initial startup.

Setting up a library using the basic configuration includes the following procedures:

• Deleting the Default Partition on page 157

• Running the Setup Wizard on page 158

• Set up e-mail (optional see Setting up E-mail on page 170)

• Set up e-mail notification (optional see Setting up Notification on page 171)

For libraries that contain FC I/O blades and Ethernet Expansion blades, it is recommended that you bypass 
the Setup Wizard and use the instructions in Performing Advanced Configuration on page 163. 

The interaction between drive types and partitions include the following:

• If the library discovers two different domains of storage, it will allow you to create two partitions even 
if the license if for only one partition. This enables users to turn on a small number of minority slots. 
For instance, if the user has one DLT magazine and one DLT drive in a configuration that is almost 
totally LTO drives and cartridges.

• The discovery of two drive types should not trigger the same multi-partition behavior. For example, 
LTO-2 SCSI and LTO-2 Fibre Channel in the same library should not allow two partitions unless a 
multi-partition license is sold.

Proceed to Deleting the Default Partition on page 157.

Note You cannot create partitions that include mixed media using the Setup Wizard. 
You must perform the configuration manually using Expert Mode.

Note You cannot manage the library from a remote system until you have logged on 
locally and setup the library’s network connection. Once connected, you can 
perform all management tasks from a remote location. 
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Deleting the Default Partition
The library creates an initial partition on the initial start-up. If you need more than one partition in the library, 
this partition must be deleted before you can use the Setup Wizard to automatically create one or more 
new partitions. 

1 Click Setup→ Partitions→ Configure.

The Partitions dialog box appears.

2 Select partition1, the default partition.

3 Click Delete.

 a. If the partition is online, you will be asked whether or not it can be taken offline.You must answer 
Yes to continue the deletion process. If you answer Yes, the partition is taken offline.

 b. Click Delete.

The selected partition has been deleted. 

4 Click Close.

Proceed to Running the Setup Wizard on page 158.
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Running the Setup Wizard

Use the Setup Wizard to enable or modify:

• Licenses (See Enabling Licenses on page 164 for more information.)

• Library partitions (See Creating Partitions on page 182 for more information.)

• Device mapping and zoning (See Configuring Host Access on page 204 for more information.)

• Network configuration (See Setting Up the Network Configuration on page 165 for more 
information.)

• Date and time (See Setting Date and Time on page 169 for more information.)

For additional information on any of the steps, see the information in the Performing Advanced 
Configuration on page 163.

Follow this procedure to run the Setup Wizard:

1 Click Setup→ Setup Wizard.

The Setup Wizard dialog box appears.

2 In the Setup Wizard dialog box, click Next to continue.

Note You must first run the Setup Wizard or manually configure the library network 
configuration in order to manage your library remotely.
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3 In the Enter License Key box, type the appropriate license key.

License keys are not case sensitive and all inclusive. For example, J2BGL-22622-52C22. Click Next to 
continue.

4 If you deleted the default partition, you are given the choice of creating a partition automatically. (See 
Deleting the Default Partition on page 157for instructions for deleting the default partition.)
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5 Type the number of partitions for each drive type. 

6 Click Finish.

The Partition Setup dialog box appears.

7 Select the partition. 

8 Click Create to create the partition.

The LUN Mapping dialog box appears
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9 To configure the LUN mapping for the drives, select the type of drives you have.

Depending on the drive type you selected, see the following for detailed instructions:

• FC Host LUN Mapping on page 204

• SCSI Host LUN Mapping on page 209

10 Click Next.

In the Network Configuration dialog box, you can set the following configuration:

• If Dynamic Host Configuration Protocol (DHCP) is enabled on your network, select Enable. DHCP 
automatically configures the library network settings.

• If you do not have DHCP enabled on your network, select Disable and type the library name, IP 
address, subnet mast, and the IP address of the default gateway for your network.

• Under Port Settings, select Enable or Disable for Auto Negotiation and then select a Port 
Speed.
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11 Click Next.

The Date and Time dialog box appears. To set the date and time, either enter the iPv4 or iPv6 
addresses of the two NTP servers on your network or set the date and time manually.

12 When you reach the end of the Setup Wizard, click Finish to exit.

13 To log off, click Operation→ Log Off. 

14 Continue with the setup and configuration of the library:

• Optionally set up e-mail, using the instructions in Setting up E-mail on page 170.

• Optionally set up e-mail notification using the instructions in SSetting up Notification on page 171.

Once you have completed the configuration, proceed to Installing Cartridges on page 131.
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Performing Advanced Configuration

For libraries that will consist of more than one partition, configure the library in the following order:

• Enabling Licenses on page 164

• Setting Up the Network Configuration on page 165

• Setting Date and Time on page 169

• Setting up E-mail on page 170

• Setting up Notification on page 171

• Creating Partitions on page 182

• Configuring FC I/O Blade Ports on page 194

• Configuring FC Host Port Failover on page 198

• Configuring Datapath Conditioning on page 201

• Configuring Switch Zoning on page 204

• Configuring Host Access on page 204
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Enabling Licenses
At installation, the library is initially licensed for a default Capacity on Demand (COD) configuration of 102 
LTO or 100 DLT cartridge storage slots. You must enable the library’s license keys before you can use more 
storage slots and configure those parts of the library that are governed by additional licensing.

The characteristics of licensed functionality include:

• COD quantities are displayed as the number of slots licensed. 

• Partition quantities are displayed as the maximum number of partitions possible. 

• Other features not licensed by quantity are displayed as “1” in the Quantity column.

If you cannot locate the license keys shipped with the library, you can obtain them by contacting Quantum 
Technical Assistance Center at www.quantum.com/support

Follow this procedure to enable your licensed features:

1 If you are not already working from the physical library, select it from the View menu.

2 Click Setup→ Licenses.

The Licenses dialog box appears.

3 In the Enter License Key box, type the appropriate license key. License keys are not case sensitive 
and all inclusive. For example, J2BGL-22622-52C22 can be entered as j2bgl-22622-52c22.

4 Click OK.

Licensed features are shown with the status and expiration date for each feature.

Proceed toSetting Up the Network Configuration on page 165.
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Setting Up the Network Configuration
Make sure that your library is attached to the network before you use the Network Configuration 
command.

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View menu, select the name of the 
physical library.

3 Click Setup→ Network Configuration.

The Network Configuration dialog box appears. Then, depending on whether IPv6 is enabled or 
disabled and the protocol of the network connection you want to configure:

• If IPv6 is disabled, the IPv4 Network Configuration dialog box appears.  
Proceed to Setting up IPv4 Network Configuration on page 166. 

• If IPv6 is enabled, but you want to configure an IPv4 connection, click IPv4 Configuration on 
the Network Configuration submenu to display the IPv4 Network Configuration dialog. 
Proceed to Setting up IPv4 Network Configuration on page 166. 

• If IPv6 is enabled and you want to configure an IPv6 connection, click IPv6 Configuration on 
the Network Configuration submenu to display the IPv6 Network Configuration dialog. 
Proceed to Setting up IPv6 Network Configuration on page 167.

CAUTION
You must fully understand all network issues before you change the 
network configuration for an already configured library. It is 
recommended that you consult with your network administrator 
before changing your network configuration.

Note If you want to set up an  network connection, make sure that the IPv6 option 
is enabled on the Physical Library dialog.
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Setting up IPv4 Network Configuration
After completing steps 1 through 3 of Setting Up the Network Configuration on page 165, the IPv4 Network 
Configuration dialog box appears. 

The following table describes the elements on the Network Configuration dialog box.

Note The Network Configuration submenu only appears if you have enabled 
IPv6 for the physical library.

Element Description

In the Host Settings area:

DHCP If Dynamic Host Configuration Protocol (DHCP) is enabled on your network, 
select Enable to have DHCP automatically configure the library network 
settings. Enable makes the IP Address, Subnet Mask, and Default Gateway 
text boxes unavailable. Select Disable to make the IP Address, Subnet Mask, 
and Default Gateway text boxes available for you to manually set the library 
network settings.

Library Name The network name that you want to assign to the library.

IP Address The IP address of the library. This text box is available only if DHCP is disabled.

Subnet Mask The subnet mask. This text box is available only if DHCP is disabled.

Default 
Gateway

The IP address of the default gateway for your portion of the Ethernet network. 
This text box is available only if DHCP is disabled.
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The Cycle button enables you to cycle the external Ethernet interface without rebooting the library.

1 Make the appropriate network configuration changes, and then click OK.

2 A prompt appears that informs you that network connectivity will be temporarily lost and asks whether 
you want to proceed. click Yes.

Proceed to Setting Date and Time on page 169.

Setting up IPv6 Network Configuration
After completing steps one through 3 of Setting Up the Network Configuration on page 165, the Static IP 
tab of the IPv6 Network Configuration dialog box appears.

1 Use the Static IP tab to disable or to enable and specify a static IP address. Valid static IP addresses 
include link local, site local, and global unicast.

2 To display the DHCP tab, click DHCP.

3 As prompted, use the DHCP tab to enable or disable the Dynamic Host Configuration Protocol (DHCP) 
autoconfiguration function.

In the Port Settings area:

Auto Negotiate Select Enable to have the library automatically negotiate port speeds. Enable 
makes the Speed options unavailable. Select Disable to make the Speed 
options available for you to manually set the port speed.

Speed The port speed (10 Mbps or 100 Mbps). Speed options are available only if Auto 
Negotiate is disabled.

Element Description
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4 To display the Hostname tab, click Hostname.

5 Use the Hostname tab to specify a library name that can be used for remote connections to the library.

6 To display the Settings tab, click Settings.

7 Use the Settings tab to view the current IPv6 configuration settings.

8 After you make the appropriate network configuration changes, click OK.

9 A prompt appears informing you that network connectivity will be temporarily lost and asks whether you 
want to proceed. Click OK.

Proceed to Setting Date and Time on page 169.
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Setting Date and Time
1 Click Setup→ Date and Time. 

The Date and Time dialog box appears. 

2 In the NTP section:

• If you choose to enable NTP, click Enable. 

The Date and Time sections of the dialog box are grayed out.

• Type valid IP addresses for the Primary Server and optionally the Secondary Server.

• If the DNS Server has not been configured in the LMC, type valid numeric IP addresses 
that are accessible from the library (example 111.11.11.111). You have the option of using 
one or two IP addresses. Go to step 5. 

• If the DNS Server has been configured through the LMC (Setup→ DNS Configuration), 
type the valid alpha/numeric IP Addresses that are accessible from the library. You have 
the option of using one or two IP addresses. Go to step 7. 

• If NTP is enabled and you no longer want to use this setting, click Disable.

If you choose to disable NTP, you must manually set the date and time. Go to the next step.

3 Use the Date drop-down lists to select the month, date, and year.

4 Use the Time drop-down lists to select the hour, minute, and whether the time is A.M. or P.M.

5 Use the Time Zone drop-down list to select the appropriate time zone. 
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6 Click OK.

Proceed to Setting up E-mail on page 170.

Setting up E-mail
The library uses the e-mail settings on the Email Configuration dialog box whenever library e-mail services 
are used, such as when you use the Send command to e-mail snapshots or logs and when the library 
automatically sends e-mail notifications of library problems.

1 Click Setup→ Email Configuration. 

The Email Configuration dialog box appears.

2 Enter the following information into the Email Configuration Settings dialog box:

• SMTP Server—for example, 192.16.68.2 You can use either iPv4 or iPv6 addresses.

• Authentication—select either Password or None. If you select None, you will not be prompted for 
an Account or Password.

• Account—for example, Jay.User

• Password—for example, password

Note The default time zone is GMT. The time zone that you select appears only 
on your library information panel. Regardless of your selection for the 
library information panel, the system operates on the GMT zone.

Note You must identify the SMTP server by its server address.

Note The account specified must be a valid account at the named SMTP server.
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• Sender Address—for example, MyLibrary@MyCompany.com

The library uses this address in the “From” field of e-mail messages that it sends out, indicating the 
originator of the message. If you type, for example, “scalari6000”, the library appends the domain 
information (for example, “@mycompany.com”). If you type, for example, 
“scalari6000@mycompany.com”, the library does not append any additional information.

3 To test the e-mail configuration, type an e-mail address in the Recipient box of the Test Current 
Configuration area and click Test email.

4 Confirm that the library displays a message indicating that the test completed successfully and sends 
a test message to the specified e-mail address. 

5 The subject of the test message should be “Test email from Scalar i6000” and the message text should 
include the library name, version, and serial number, along with the date and time that the message was 
sent.

6 Click OK.

Proceed to Setting up Notification on page 171.

Setting up Notification
The Notification command allows you to send e-mail to specific individuals whenever certain conditions 
occur. The information in the e-mail notification provides details about the issue and the library conditions 
at the time of the error.

1 Complete the steps in Setting up E-mail on page 170, unless you have already done so.

2 Click Setup→ Notification→ System Setup.

The System Setup Notification dialog box appears with the Contact Information tab displayed.

Enter the contact information you want included in an e-mail notification if an error occurs in the library. 

Note The password specified must be valid for the specified account at the 
named SMTP server.
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3 Click Close.

4 Setup the rules.

 a. Click Setup→ Notification→ System Setup.

The System Setup Notification dialog box appears with the Contact Information tab 
displayed.

The Notification dialog box displays the Rules tab.

This dialog box shows all notification recipients that are set up currently in the LMC. By default, 
the only e-mail address to which the library sends e-mail notifications (severity level 1 [Failed] 
issues only) is techsup@quantum.com (Quantum technical support), as shown in this 
Notification dialog box example.

5 To set up a new e-mail notification recipient, click Create.

Note If you have previously saved a configuration, and you enter a configuration 
change, the system asks you to perform a Save Configuration operation.

Note • Even though you can remove the Quantum technical support e-mail 
address so that Quantum does not receive severity level 1 notifications, 
Quantum recommends that you do not remove it. Also, do not include the 
Quantum technical support e-mail address for severity level 2 or 3 
notifications.

• The remaining steps in this procedure guide you through setting up new 
e-mail notification recipients. To delete an existing e-mail address, click 
the e-mail address in the Send Email To column, and then click Delete.
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The New Email Notification dialog box appears.

6 In the Email Address text box, type the e-mail address that you want to receive notifications.

Do not enter multiple addresses into this box. To associate more than one e-mail address with events 
of a particular severity, repeat the Create process.
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7 Select the severity level that will be reported. 

Select level 1, “Failed,” to receive only emergency-related notifications. The severity levels are 
numbered from 1 to 3, with 3 being the least severe.

If working from the remote client, select multiple severity levels by holding down CTRL and clicking each 
choice.

8 Repeat Step 3 on page 171 through Step 10 on page 174 as often as necessary.

9 In the New Email Notification dialog box, click OK.

10 You are finished entering your specifications, click OK on the System Setup Notification dialog box.

Proceed to Enabling Logical Serial Number Addressing for Drives on page 175

Level Meaning Type of Information Reported

1 Failed • Library system has failed
• At least one partition (also referred to as a logical library), drive, 

or cartridge needs attention
• Service ticket has been posted to the LMC

2 Degraded • Library system is degraded
• Host operations should be possible, but admin should investigate
• Service ticket has been posted to the LMC

3 Warning • Library system is warning about an issue
• Host operations should be possible, but admin should investigate
• Service ticket has been posted to the LMC
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Enabling Logical Serial Number Addressing for Drives
The Physical Library dialog box enables you to set up the library to automatically assign logical serial 
numbers to drives in the library. Specifically, the library assigns a logical serial number to a drive in a specific 
location. This is not the serial number of the particular drive. If a drive is replaced by another drive in the 
same library location, the logical serial number remains the same. From the host’s perspective, the 
replacement drive is the same as the original one.

1 Log on as the service user.

2 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

3 Click Setup→ Physical Library.

The Physical Library dialog box appears.

The Logical SN Addressing area is available to service users only.

4 In the Logical SN Addressing area, select Enable to cause the library to automatically assign logical 
serial numbers to drives. Disable is the default setting.

5 Click OK.

Proceed to Using LDAP on page 176.
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Using LDAP
Lightweight Directory Access Protocol (LDAP) is the industry standard Internet protocol that provides 
centralized user account management. This library supports the Microsoft® Active Directory® LDAP server 
and user account information in the schema defined by RFC 2307. User password schemes must be 
encrypted using UNIX® crypt.

You can configure the Lightweight Directory Access Protocol (LDAP) settings any time after the initial library 
configuration. Once you enable and configure LDAP, you can view your current LDAP settings using the 
LDAP menu.

LDAP Server Guidelines
LDAP is the industry standard Internet protocol that provides centralized user account management 
subsystem. User account information is centralized and shared by different applications, simplifying user 
account management tasks. Administrative users can add, delete, and modify only local user account 
information. For more information concerning setting up user accounts, see the Scalar i6000 User’s Guide.

User and Group Access
For LDAP accounts with user privileges, access to library partitions is determined by group assignment on 
the LDAP server. Groups must be created on the LDAP server with names that correspond to the library 
partition names. Users without administrator privileges must be assigned to these groups on the LDAP 
server to have access to the corresponding partitions on the library. LDAP accounts with administrative 
privileges have access to all partitions and administrative functions and do not need to be assigned to 
partition-related groups on the LDAP server. 

OpenLDAP 2.4
You must install and run OpenLDAP 2.4 or later. The supported Objects in OpenLDAP 2.4 and above are 
of type “Person” or derived objects, and the group Objects must be of type “GroupOfNames”. 

OpenLDAP must be compiled with Overlay Support and requires the installation of “memberOf” overlay. 
More information can be found in the man pages of OpenLDAP with the “man slapo-memberof” command.

Note The Scalar i6.5 release provided enhancements to the Lightweight Directory 
Access Protocol (LDAP) features. For maximum ease of use of this feature, 
Quantum strongly recommends that you are running version i6.5 or greater.

Note Active Directory no longer requires Windows Services for Unix 2.5.

CAUTION
Any LDAP configurations from i6.3.1 and earlier will not import into 
the i6.5 LDAP configuration. You must reconfigure LDAP for the i6.5 
update.

Note Usernames and group objects must be in LDAP Distinguished Names formats.
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Configuring LDAP
1 From the Setup menu, click LDAP.

The LDAP Configuration dialog box displays with the General tab displayed.

2 In the General tab, you can enable or disable LDAP functionality: 

• To enable LDAP, select Enable LDAP. 

• To disable LDAP, clear the Enable LDAP check box. 

3 To configure or modify LDAP, use the appropriate tabs and set the following configurations:

General tab

• Server Configuration section

• Primary: You must provide a primary IP address or DNS name.

• Alternate: An alternate IP address or DNS name is optional.

• Secure: Use this check box to enable the setup options to access a secure LDAP server, 
which can be done using any port except 389. The default secure port is 636. If you enable 
this option, you must retrieve the Trusted Root Certificate from the server by clicking 
Retrieve TR. 

• Port: Enter the appropriate port in this field. The default port for non secure connection is 
389 – and 636 for secure (SSL) based LDAP connections. The port setting can be changed.

• Retrieve TR: Use this function to retrieve the Trusted Root Certificate from the LDAP 
server. A dialog box displays basic Trust Root certificate information, for example, subject 
name, MD5, and SHA 1 hashes. It is recommended that you verify this information 
independently on the LDAP server.

Note If you disable LDAP, single sign-on functionality will not be available on the 
library.
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• Search Information section 
 
The Search Information section allows you to enter on the LDAP server a user name and 
password for a user who has sufficient privileges to search for user names. The user name 
is specified in distinguished name format. To use this feature administrative user rights are 
not required, but you must have the right to search user names in the LDAP directory. 

4 Click the Access tab.

Use this tab to configure LDAP authentication.

• Context Information section

• User Context: This is a path in distinguished name format to the location used to search 
for the login users. You can search for a user in the context specified and all contexts below 
it.

• Group Context: This is a path in distinguished name format to the location used to search 
for the groups to which a user belongs. Only groups which are in the Group context or below 
are considered for library access.

• Library Access Groups section

• User: This field contains a fully distinguished name of the groups to which all the library 
non-admin users belong. 

• Admin: This field contains a fully distinguished name of the group to which all admin users 
belong.

CAUTION
The first time you use Retrieve TR, the process can take 5 
to 10 minutes. To connect to a secure LDAP server, you 
must complete the retrieval process.
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5 To validate your configuration, click OK or Test.

6 Click the Test tab.

You can use the Test functionality to simulate an LDAP login for a specific user and quickly discover 
what access rights the user has and to what partitions the user has access.

Test User section

• User: Type the appropriate User name.

• Password: Type the user password. 

7 To initiate the library authentication process to the LDAP server, click Test after providing the user name 
and password. 

A dialog box appears displaying what level of access the user is assigned, and to which library 
partition(s) the user has access.

8 After you have entered the LDAP configurations, click Test to verify the LDAP connection. 

A connection with the LDAP server(s) is established and the library determines whether the LDAP 
Distinguished Names specified in the Access tab are valid. 

A message box appears indicating that the success or failure of the LDAP connection.

• If the connection failed, the error message contains information that you can use to resolve the 
issue. 

Note Non-admin library users also need to be members of the groups that match the 
partition names for which they are granted access. These group names needn’t  
be specifically listed anywhere in the LDAP setup on the library. When user 
logins are validated during login, their group memberships for partition access 
are validated automatically. 
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Click OK to return to the LDAP Configuration dialog box. 

• If the connection was successful, in the message box, click OK and continue. 

9 To accept and save the library configuration, in the LDAP Configuration dialog box, click OK.

10 To validate your configuration, click OK or Test.

Proceed to Working with Library Control Paths on page 180.

Working with Library Control Paths
You must define a control path for each library partition. The control path is used to connect a partition to a 
host application. The Scalar i2000/i6000 does not automatically assign a control path when you create a 
partition. Each partition control path can occur through one of several different physical connection points 
depending on the hardware configuration of your library. The procedure for setting up and defining the 
control path for a partition depends on which physical connection point you choose to use.

Note If you have more than one FC I/O blade in the library, each FC I/O blade 
presents each partition--that does not have a tape drive as the control path -- 
as a target device to the host. Thus the host may see the same partition 
multiple times. To avoid confusion, configure host mapping so that each host 
sees each device only once.

CAUTION
Once a control path connection to a host is configured through a 
drive, that same host to control path connection will not be visible 
through a FC I/O blade and vice versa. Once the control path is 
established via one physical connection, it must be deleted before it 
can be set up through an alternate physical connection.
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The following table defines which procedures to use to complete setting up partitions and configuring a 
control path for each of the possible physical connection points. 

Table 7 Control Path Matrix

GUI Menu Path Procedure References
MCB Direct 
Connection FC I/O Blade 

Connection
LTO-5 
Connection

Setup > 
Partitions > 
Configure

Creating Partitions on page 
182

Step 1 Step 1 Step 1

Setup > 
Connectivity >

Configure FC IO Blade
• Configuring FC I/O Blade 

Ports on page 194
• Configuring FC Host Port 

Failover on page 198
• Enabling a Disabled 

Target Port on page 200
• Configuring Datapath 

Conditioning on page 201
• Configuring Switch Zoning 

on page 204

Step 2

Setup > Device 
> Access

Configuring Host Access
• FC Host LUN Mapping on 

page 204
• Channel Zoning on page 

208
• SCSI Host LUN Mapping 

on page 209
• LUN Mapping Wizard on 

page 211

Step 3

Setup > Device 
> Access

Step 1 on page 195 
Setup > Connectivity > Port 
Configuration

Step 2

Setup > 
Partitions > 
Control Path

Configuring Control Path on 
page 215

Step 2

Setup > Device 
> Access > 
SNW Drives

Selecting a Storage 
Networking Drive on page 
217 (s)

Step 3
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Proceed to the appropriate steps.

Creating Partitions
The ability to create multiple partitions is controlled by licenses. See Enabling Licenses on page 163 if you 
have not already configured your library’s licenses. 

You can create partitions automatically or manually. If you choose to configure a partition manually, you can 
allocate library resources to it using either Simple or Expert mode.

Creating Partitions Automatically
You can use the library’s automatic mode to create partitions within limits based on licensing restrictions 
and available resources. Because automatic mode is available only if no partitions currently exist, you must 
first delete the default partition that was initially configured on the initial boot-up.

1 Click Setup→ Partitions→ Configure.

The Partitions dialog box appears.

Setup > Device 
> Access

Configuring Host Access
• FC Host LUN Mapping on 

page 204
• LUN Mapping Wizard on 

page 211

Step 4

Setup > Device 
> Access > 
SNW Host

Configuring the SNW Host 
Device on page 218

Step 5

Table 7 Control Path Matrix

GUI Menu Path Procedure References
MCB Direct 
Connection FC I/O Blade 

Connection
LTO-5 
Connection
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2 Click Create.

The Partitions – Choose Creation Mode dialog box appears.

3 Select Automatic, and then click Next.

The Partitions – Automatic Creation dialog box appears.

4 In the Partitions column, type the number of partitions you want to create for each media/drive type.

The maximum number of partitions that you can specify is determined by the number of partitions you 
are licensed to create and the number of drives available. The library is licensed either for one partition 
or for the maximum of 16 partitions.

5 Click Finish.
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Creating Partitions Manually
Use manual mode to allocate specific drives, storage slots and I/E station magazines when creating a new 
partition. Manual mode provides two ways to allocate library resources: simple and expert modes. In simple 
mode, you can specify the quantity of each element you want assigned to the partition. The library assigns 
the next available elements to the partition. In expert mode, you indicate specifically by location which 
drives, storage magazines, I/E station magazines, or (if enabled) extended I/E station magazines to assign 
to the partition.

To create a partition with mixed media, you must use expert mode in the Partitions dialog box. 

1 Click Setup→ Partitions→ Configure.

The Partitions dialog box appears.

2 Click Create.

If no partitions currently exist, the Partitions – Choose Creation Mode dialog box appears.
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3 Select Simple and then click Next. 

If at least one partition is already configured, this dialog will not appear.

4 In the Choose Partition Properties dialog box, configure the following settings:

• In the Name box, describe the new partition.

• In the Drive Domain drop-down list, select the appropriate drive domain.

• From the Vendor ID, select the vendor.

• In the Product ID drop-down box, select the appropriate product type.

5 Click Next to proceed.
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6 In the Choose Policy Settings dialog box:

• Select whether or not to enable Media Type Checking. With a valid media type identifier present 
and the Media Type Checking setting enabled, which it is by default, a host is prevented from 
executing invalid media moves across differing media types. For example, a host can be prevented 
from moving LTO-3 media to an LTO-2 drive. If an invalid move is attempted, an error is returned 
to the host.

Regardless of whether or not partition media policies are enabled or disabled, the library always 
prevents host move-media commands that cross different media domains. For example, the library 
will never execute a host command to move an LTO cartridge from an LTO drive to a DLT storage 
slot, and vise versa.

• For Media Checking Policy, choose either Required or Not Required.

In Required mode, if the library does not find a valid media ID on a cartridge, the library does not 
allow it to be moved into or within the library. If the library finds a valid media ID, the library allows 
it to be moved from an I/E station into a partition that contains magazines matching the media 
domain of the cartridge (for example, LTO), but the library does not allow the cartridge to be moved 
from storage to a drive that does not have a matching type (for example, an LTO-2 cartridge will 
not be allowed to move to an LTO-1 drive).

In Not Required mode, if the library does not find a valid media ID on a cartridge, the library allows 
it to be moved into or within the library as long as the I/E station magazine, storage magazine, or 
drive matches the media domain of the cartridge. If the library finds a valid media ID, the library 
does not allow the cartridge to be moved from storage to a drive that does not have a matching type 
(for example, an LTO-2 cartridge will not be allowed to move to an LTO-1 drive).

• Configure the Return Media Identifier. With the Return Media Identifier setting, you can control if 
and where a media type identifier appears in the volume serial number that is returned to the host.
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Table 7 shows an example of how the return media identifier behavior works depending on which 
setting you choose: Disabled, Prefix, Suffix, and Pass Through. The bold, underlined portion 
represents the media identifier.

For more information on how media policies in the library work, see the library Scalar i6000 User’s 
Guide.

• For Automatic Drive Cleaning, click either Enable or Disable. This setting is enabled by default.

Enabling automatic drive cleaning allows the library to initiate drive cleaning each time a drive 
requests a cleaning operation. For automatic drive cleaning to function, you must first configure 
drive cleaning for the library. For more information about configuring drive cleaning, see 
Configuring Drive Cleaning on page 214.

7 Select Next to proceed.

8 In the Choose Resource Allocation Mode dialog box, select either Simple or Expert.

9 Select Next to proceed.

To continue in Simple mode, see Performing Simple Partition Resource Allocation on page 188.

To continue in Expert mode, see Performing Expert Partition Resource Allocation on page 190.

Table 8 Return Media Identifier Behavior Example

Actual LTO-1 Barcode Label ABC123L1

Behavior Volume serial number returned to Host

Disabled ABC123

Prefix L1ABC123

Suffix ABC123L1

Pass Through ABC123L1

Note Once a media volume serial number has been reported to a host, changing 
the Return Media Identifier setting may cause the host to not recognize 
media within the library.

Note Automatic drive cleaning should be enabled for partitions only if the host 
application does not support the coordination of drive cleaning. If drive 
cleaning functionality is enabled on the host application, do not enable 
automatic drive cleaning for any partitions in the library.
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Performing Simple Partition Resource Allocation
This procedure continues from Step 9 on page 187 on page 185 above.

1 In the Choose Resource Quantities dialog box, enter the number of elements to include in the partition 
by specifying:

• Number of drives

• Number of storage slots

• Number of I/E station slots

The quantity available for each type of resource element indicates resources not already assigned to 
existing partitions. Storage slot quantity is limited by the total slots authorized in the capacity on demand 
license.

2 Click Next to proceed.

3 In the Partitions – Summary Information dialog box, verify that the parameters you set are correct.
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4 To create the partition, click Create.

5 In the Partitions – Completed dialog box, review the information to make certain it is correct.

6 Click Finish.

The Partitions window appears, showing the new partition.

7 Optionally, click Next to identify and view the details of the drive or drives assigned to the partition.

8 Click Close to exit the Partitions window.
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Performing Expert Partition Resource Allocation
This procedure continues from Creating Partitions Manually on page 184.

1 In the Select Drives dialog box, select the location of the desired drive or drives. Make sure that you 
select the appropriate module, since the library can have drives in the control module and in any other 
expansion module.

2 To assign a drive, select its check box. You can identify a drive by its serial number and location 
coordinates.

3 Click Next to proceed.

4 In the Select Storage Slots dialog box, select the rack location of one or more storage magazines.
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5 Assign a storage magazine by selecting its check box. You can identify a storage magazine by its 
location coordinates. The number of slots available in the magazine is determined by the drive media 
type.

6 Click Next to proceed.

7 In the Select I/E Slots dialog box, select the location of one or more I/E station magazines. Make sure 
that you select the appropriate module, since the library can have I/E stations in the control module and 
in any of the eleven expansion modules.

8 Assign an I/E station magazine by selecting its check box. You can identify an I/E station magazine by 
its location coordinates.

9 Click Next to proceed.

Note You can only assign complete magazines to a partition.

Note You can only assign complete magazines to a partition.
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10 In the Partitions – Summary Information dialog box, verify that the parameters you set are correct.

11 To create the partition, click Create.

12 In the Partitions – Completed dialog box, review the information to make certain it is correct.

13 Optionally, click Next to identify and view the details of the drive or drives assigned to the partition.

14 In the Partitions dialog box, click Finish.

Viewing Partition Details
If you want to see settings and information for a partition but do not need to make changes, view partition 
details. Unlike modifying a partition, viewing details does not require you to take a partition offline.

1 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

2 On the menu bar, click Monitor→ Partitions.

The Partitions Status dialog box appears with a list of all logical partitions in the library and information 
about each partition.
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The following table describes the elements on the Partitions Status dialog box.

3 To see additional details for a partition, click the partition in the list, and then click Details.

Element Description

Name The name of the partition.

Status The status of the partition (Online or Offline).

Vendor Displays Vendor ID.

Product ID Displays the what type of library the system is reporting as.

Serial Number The serial number of the library.

Media Type The type of media used in the partition (LTO-1, LTO-2, LTO-3, LTO-4, 
LTO-5, or DLT).

Interface The type of interface used to connect to the host (FC or SCSI).

#Drives The number of tapes drives in the partition.

#Storage Slots The number of storage slots in the partition.

#I/E Slots The number of I/E station slots in the partition.

Media Type Checking The current setting for media type checking (Required, Not Required, 
or Disabled).

Media Identifier The current setting for return media identifier (Suffix, Pass Through, 
Prefix, or Disabled).

Drive Autolevel The current setting for drive firmware autoleveling (Enabled or 
Disabled).

Auto Drive Clean The current setting for automatic drive cleaning (Enabled or Disabled).

Encryption Reports whether the media is encrypted. The values are Application 
Managed or Library Managed.
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The Partition Details dialog box appears. This windows shows additional information about the 
partition, such as vendor, product ID, and serial number.

4 Click Close to close the Partition Details dialog box.

5 Click Close to close the Partitions Status dialog box.

Proceed to Configuring FC I/O Blade Ports on page 194.

Configuring FC I/O Blade Ports
Each FC I/O blade installed in the library has two ports reserved for connection to hosts or the SAN. These 
ports are FC-1 and FC-2. By default, ports FC-1 and FC-2 are in target mode. The other four ports (FC-3, 
FC-4, FC-5, and FC-6) are in initiator mode by default.

The default FC I/O blade ports are given in Table 9 on page 194.

Table 9 FC I/O Blade Default Port Settings

Port Loop ID Speed Frame Size Port Mode Connection 
Option Private/Public

FC-1 Soft Auto 2048 Target Loop preferred Public

FC-2 Soft Auto 2048 Target Loop preferred Public

FC-3 Soft Auto 2048 Initiator Loop preferred Public

FC-4 Soft Auto 2048 Initiator Loop preferred Public

FC-5 Soft Auto 2048 Initiator Loop preferred Public

FC-6 Soft Auto 2048 Initiator Loop preferred Public
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1 Click Setup→ Connectivity→ Port Configuration.

The Connectivity dialog box appears. All components that provide FC and SCSI ports show in the 
dialog box if they are detected.

2 Select a component to expand its list of detected connectivity boards and the ports on each.
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3 Click a port to highlight it, and then click Configure.

For an FC port on either the MCB or an I/O blade, the Fibre Channel Parameters dialog box appears.

You can configure two settings for an MCB connection and all settings for an I/O blade connection. The 
figure above shows an FC port configured for target mode and a loop preferred connection.

 a. In the Loop ID area of the Fibre Channel Parameters dialog box, selecting Soft acts as a 
toggle, checking and clearing the box. If the box is not checked, you can click a hard loop ID 
(within the range from 0 to 125) from the drop-down list. Some operating systems require hard 
ID settings. Consult your service representative before making changes to this setting.

 b. Select Auto to automatically set the interface speed. To configure the speed manually, clear 
the Auto check box and use a setting from the drop-down list. Because this setting is not 
configurable on the MCB, the Speed area does not appear on the Fibre Channel Parameters 
dialog box when configuring the MCB FC port. The MCB FC port speed is always 1 Gb/sec.

 c. FC Frame Size is specified by each receiving node and need not match any other node. The 
frame size is typically set to 2048. (You can use another frame size if it is required by a particular 
software application.)

 d. FC ports support Private and Public Fibre Channel attachments. The default port mode setting 
for FC ports 1 and 2 is Target Public, and the default port mode setting for FC ports 3 through 
6 is Initiator Public. With Public, the loop is scanned for Fabric devices and allows the Fabric 
to have access to all available target devices that are attached to it. With Private, the local loop 
is scanned for devices except for Fabric devices. In Target mode, the port is set to receive 
connections from another FC initiator, such as a host or FC switch. In Initiator mode, the port 
scans for storage devices. In Target and Initiator mode, the port operates in both modes 
simultaneously.
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 e. The default connection mode for both target and initiator ports is Loop Preferred. For target 
ports, other options include Loop and Point to Point. For initiator ports, other options include 
Loop and Loop Preferred. Therefore, if you want to change a target port that is set to Point-
to-Point to initiator mode, you cannot do it until you first change the port connection type to 
Loop or Loop Preferred. Consult your service representative before making changes to this 
setting.

4 After you finish selecting the port configuration settings, click OK.

5 A message appears that asks whether you want to make the change. Click Yes.

Proceed to Configuring FC Host Port Failover on page 198.
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Configuring FC Host Port Failover
Configure the optional FC Host Port Failover (HPF) feature so that an alternate “standby” target port on an 
I/O blade can assume the identity and LUN mapping configuration of the primary “active” target port if the 
primary port fails. HPF enables the library to continue operations without requiring you to reconfigure the 
host or the SAN.

To enable HPF, you must make sure that two ports on the I/O blade are in target mode and point-to-point 
connection. Use ports 1 and 2, which are ports that are traditionally configured to be host targets. I/O blade 
ports are numbered from bottom to top as the blade sits in the I/O management unit.

Both ports must be attached to the same SAN fabric to provide host access. The active primary port is used 
for host communications, while the passive standby port is kept idle. The way that you configure the 
recovery settings determines how the failed port behaves after it is restored from a failed state.

The library generates a ticket when port failover occurs. Examine the ticket and the repair page associated 
with the ticket to determine the reason for the failover.

To configure HPF, perform the following steps:

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

3 Confirm that there are two ports on the I/O blade in target mode and point-to-point connection. For more 
information, see "FC Host" in the Scalar® i6000 User’s Guide.

4 Click Setup→ Connectivity→ FC Host Port Failover.

The FC Host Port Failover dialog box appears, showing all the I/O blades found in the library. Each 
blade is identified by name and by location.
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5 Click a blade to highlight it, and then click Configure.

The FC Port Failover dialog box appears.

6 In the Feature Enable area, select Enable FC Host Port Failover, and then click Set to make the 
Configuration tab available.

7 Accept the recovery setting default values unless an authorized representative advises you otherwise.

Note On the Configuration tab, settings are unavailable if the current state of 
the tab is set to Disabled.

Be aware that there might be incompatibilities with channel zoning 
configuration on the I/O blade if you enable host port failover. Both target 
ports must have the same ports mapped.
Scalar i6000  Installation Guide 199



8 Configure the Primary Port by using the Select Primary drop-down list to select from the target ports 
that are online and available.

9 Click Set. If your configuration has errors, a warning message appears.

Enabling a Disabled Target Port
Use the Physical Ports tab to manually enable an online target port that was disabled because of a 
previous connection error. If the Intervention column displays "true," you must manually bring the 
recovered port back online using Enable. If the port state is "disabled," the port's connection is repaired and 
it is ready to be re-enabled. If the Configuration tab itself is disabled, the table on the Physical Ports tab 
will be empty.

To enable a disabled target port:

Note Before you set recovery settings, understand the following elements in the 
Recovery Setting area:

• Error count recovery mode sets the recovery scenario for all ports when 
port failure is caused by excessive errors on the port. The only setting 
option is Require Intervention.

• Link down error recovery mode sets the recovery scenario for all ports 
when port failure is caused by the port going offline for more time than the 
threshold specified in the Link down delay time text box. The only setting 
option is Require Intervention.

• Link down delay time sets the timeout threshold before link down status 
applies. The default value is zero (0) seconds. There is no maximum 
value.

Require Intervention means that a user must manually use the Physical 
Ports tab to bring a failed port that has recovered back online.

Note Only ports that are in target mode and point-to-point connection can 
participate in host port failover. The primary port becomes active by default 
and the alternate port will go on passive standby until a failover occurs. 
You must select a primary port. Current Active indicates the currently 
active port.

Note If the target port state is offline, the port's connection has not been repaired. 
The error condition that caused the port to fail still exists.
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1 On the FC Host Port Failover dialog box, click the Physical Ports tab. 
The tab lists each target port on the FC I/O blade, its state and the type of failure, if applicable.

2 Click the port you want to enable and click Enable.

3 To return to the main FC Host Port Failover dialog box, click Close.

4 Proceed to Configuring Datapath Conditioning on page 201.

Configuring Datapath Conditioning
For the library, target-side data path monitoring is performed automatically and proactively. The Datapath 
Conditioning dialog box enables you to set the level at which the data path is monitored between an I/O 
blade and the drive(s) connected to it. You also can set the time interval between monitoring checks (up to 
48 hours).

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

3 Click Setup→ Connectivity→ Datapath Conditioning.

Note Enable is available only if the port is disabled.

Note I/O blades must be present to access the Datapath Conditioning dialog box.
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4 The Datapath Conditioning dialog box appears, showing all the I/O blades found in the library. Each 
blade is identified by name and by geographic location.

5 Click a blade to highlight it and then click Configure.

The Datapath Conditioning Setting dialog box appears.

6 In the Level area, choose the appropriate level. The default level is Interface Test. To enable data path 
monitoring tickets, set the level to Device Datapath Test.

The following table describes the functionality for each data path monitoring level.

7 In the Enter new Interval text box, type the amount of time that should elapse between automatic 
monitoring checks. The interval can range from 1 to 2,880 minutes (48 hours). The default interval is 60 
minutes.

Level Name Functionality Description

Interface Test Performs tests to verify that Fibre Channel controllers on I/O blade are 
responsive to commands.

Device 
Datapath Test

Everything from Interface Test level, in addition to performing a device inquiry on 
each target device.
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8 To save your configuration and return to the Datapath Conditioning dialog box, click OK.

Proceed to Configuring Switch Zoning on page 204 if applicable. Otherwise, proceed to Configuring Host 
Access on page 204.

Note • The data path from I/O blade to the drive must experience problems for two 
period intervals before a problem is detected and a ticket is generated.

• The default time interval for Windows is five minutes. You must disconnect the 
drive for at least five minutes to know you have triggered the Ticket.
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Configuring Switch Zoning
If one or more FC switches is attached to the library, verify that proper switch zoning is configured.

Proceed to Configuring Switch Zoning on page 204.

Configuring Host Access
If your host(s) are connected through the management control blade or an FC I/O blade, run FC Host or 
SCSI Host, as appropriate, to allow the library to manage your media properly. See Configuring FC Host 
LUN Mapping on page 204 or SCSI Host LUN Mapping on page 209. 

If you are configuring your LTO-5 drives attached to Ethernet Expansion blades, go to Setting up Control 
Path and Storage Networking on page 215.

If your host(s) are directly connected to drives, configure your third-party tape handling software.

FC Host LUN Mapping
During device discovery, a particular partition or drive may map to a higher LUN space than is optimal for a 
particular application. The FC Host feature allows you to create a virtual private remapping of available 
LUNs for a specific Fibre Channel-attached host. LUN mapping is required to give hosts access to partitions 
and devices. You can also make devices appear to the host as if they were at lower LUNs in order to 
optimize library performance.

Depending upon host operating system constraints, it may be necessary to reboot or reconfigure the host 
as a result of device map changes resulting from the use of FC Host.

Proceed to Configuring Host Access on page 204.

Once connected, a host will persist in the FC I/O blade memory until it is manually deleted.

Configuring FC Host LUN Mapping
1 Click Setup→ Device→ Access→ FC Host.

The FC Host dialog box appears.

2 Select an FC host to configure.
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3 Click LUN Mapping. 

The LUN Mapping dialog box for the selected host appears. The LUN Mapping dialog box displays all 
partitions and drives connected to the blade that are attached to the host. 

The partitions that have not yet been manually reassigned to a new map position appear in bold in the 
Device column. The library treats partitions as devices. You must drag a partition to the LUN/Device 
column for the LMC to manage it and its media.

Compare the default view with the Show Details view shown in the following figure.
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In this figure, the Internal LUN column has been scrolled down. The Show Details view for partitions 
shows the partition name, product ID, vendor ID, and the serial number of the partition. For drives, LMC 
displays the device LUN, connection type, port connection, vendor ID, serial number, and the 
associated partition.

The following table describes the descriptors that appear in the Show Details view for partitions.

The following table describes the descriptors that appear in the Show Details view for drives.

In the default view, only the names of available partitions and the names of the devices (drives) are 
shown. LUN spaces from 0-255 are available. In the Show Details view, a partition that has not yet 
been manually reassigned to a new map position appears in heavy black type in the Internal LUN 
column. Partitions are treated by the library as devices. You must assign a partition to the LUN/External 
LUN column for the LMC to manage it and its media. In this example, the control LUN has already been 
remapped as shown in heavy black type in the LUN/External LUN column.

4 If you are working from the local touch screen, you must select an internal device LUN, select the left 
arrow, and then select the desired external LUN. If you are working from the remote client, you can use 
the select method or you can drag and drop the devices from the Internal LUN column to the 
appropriate LUN assignment in the LUN/External LUN column. Always use LUN 0 for command and 
control.

Descriptor Description

Partition Name Name assigned during partition creation process.

Product ID The Product ID setting controls the product ID string that is returned in a
standard SCSI INQUIRY response. The library can report that it is a Scalar 24,
Scalar i500, Scalar 100, Scalar 1000, Scalar i2000, Scalar i6000, or Scalar 10K. 
This feature can enable the library to be used with host applications that do not 
yet include the Scalar i6000 in a list of recognized devices. In addition, the 
various Microsoft Windows operating systems maintain a list of recognized 
devices. If the Scalar i6000 is not in an operating system list of recognized 
devices, the library will appear as an unknown device in device lists. You might 
prevent the library from being listed as unknown by setting Product ID to a 
library other than Scalar i6000. This setting does not cause any library 
operational changes other than the SCSI INQUIRY response.

Vendor ID ADIC or Quantum

Serial Number Partition ID as shown by System→ Monitor.

Descriptor Description

[Number] 
[Connection Type] 
[Port Connection]

[LUN] [Fibre or SCSI] [Port Number].

Vendor ID Drive manufacturer.

Serial Number Drive Serial Number.

Partition Name of the partition with which the drive is associated.
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In the following figure, all devices have been mapped manually.

The new map locations appear in heavy black type in the LUN/External LUN column. The previous 
(default) device map position of a remapped device is shown in gray type in the Internal LUN column.

5 Click OK.

The FC Host map is automatically saved as part of the configuration. For more information about device 
numbering in a SAN context, see related sections in the Scalar i6000 User’s Guide or use the Online 
Help.
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Channel Zoning
You can use channel zoning to restrict host access to specific ports on the FC I/O blade. In most cases, 
however, channel zoning should be left at default settings. Use the procedure below if you need to configure 
channel zoning as part of your initial library setup.

Configuring FC Channel Zoning
1 Click Setup→ Device→ Access→ Channel Zoning.

The Channel Zoning configuration box appears.

2 Select a blade and then click Configure.

3 To restrict access, clear the check mark in the cell where the target port and the initiator channel meet.

All combinations are possible with one exception. If a FC port is set to target & initiator mode, it will 
appear in both the horizontal row and vertical column. The FC port will not be allowed access to itself, 
however, in order to prevent “ghosting.” Ghosting is a condition where hosts can see storage in two 
places.

Be aware that an entire channel is zoned when the cell is checked. This effects any host that may be 
accessing the FC I/O blade.

4 Click OK to save your settings.
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SCSI Host LUN Mapping
During device discovery, a particular partition or drive may map to a higher LUN space than is optimal for a 
particular application. The SCSI Host feature allows you to create a virtual private remapping of available 
LUNs for a specific SCSI channel-attached host. With it, you can make devices appear to the host as if they 
were at lower LUNs in order to optimize system performance.

Depending upon host operating system constraints, it may be necessary to reboot or reconfigure the host 
as a result of device map changes resulting from the use of SCSI Host.

1 Click Setup→ Device→ Access→ SCSI Host.

The SCSI Host dialog box appears.

2 Select a SCSI port to configure.

The SCSI Host dialog box appears.

3 Select a SCSI port to configure.

4 With the port selected, click LUN Mapping.

The SCSI Host Map dialog box appears.

Note Use SCSI Host to map partitions when a SCSI channel host is connected to 
the MCB SCSI port.
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5 Drag the partitions that you want the SCSI host to manage from the Internal LUN column to the 
External LUN column.

6 Drag and drop the devices from the Internal LUN column to the appropriate LUN assignment in the 
External LUN column.

The right column of the SCSI host map dialog box, labeled Internal LUN, lists all available devices. The 
External LUN column on the left provides map space for IDs 0-15 associated with the selected SCSI 
Channel, and LUNs 0-7 associated with each ID. Drag and drop devices from the Internal LUN column 
into the boxes associated with particular LUN assignments in the External LUN column.

7 Click OK to save the mapping.

Proceed to Putting Physical Library and Partitions Online on page 220.
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LUN Mapping Wizard
LUN mapping is required to give hosts access to partitions and devices. You can also make devices appear 
to the host as if they were at lower LUNs in order to optimize library performance.

The LUN Mapping Wizard guides you through the setup of LUN mapping for your Fibre Channel hosts. 

The LUN Mapping Wizard automatically assigns sequential numbers for the external LUN of each mapped 
device, without any gaps between them per blade. When using the LUN Mapping Wizard, the LUN for 
some devices may change even if you did not specify the changes. If a control LUN is mapped, it is always 
assigned LUN 0.

Depending upon host operating system constraints, it may be necessary to reboot or reconfigure the host 
as a result of device map changes resulting from the use of the LUN Mapping Wizard.

1 Click Setup→ Device→ Access→ LUN Mapping Wizard.

The LUN Mapping Wizard – Overview dialog box appears. 

2 Review the LUN Mapping Wizard Overview, then click Next to continue.

The LUN Mapping Wizard – Select Host dialog box appears. All available hosts are listed on this 
dialog box.

Note If you want to manually assign a target LUN, or want to add/modify/delete the 
host, select Setup→ Device→ Access→ FC Host on the menu bar. For more 
information, see FC Host LUN Mapping on page 204.
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3 Select a host to configure and then click Next to continue.

The LUN Mapping Wizard – Select Partition dialog box appears. All available partitions on the 
selected host are listed on this dialog box.

4 Select a partition to configure and then click Next to continue. All available blades on the selected 
partition are listed on this dialog box.

The LUN Mapping Wizard – Select Blade dialog box appears.

5 Select a blade to configure and then click Next to continue.

The LUN Mapping Wizard – Map/Unmap Devices dialog box appears.
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6 Select the check box to map a device or clear the check box to unmap a device, then click Next to 
continue.

The LUN Mapping Wizard – What Next? dialog box appears.

7 Select one of the following and click Next to continue: 

• Map another blade – this allows you to map another blade on the same partition.

• Map another partition – this allows you to map another partition on the same host. 

• Map another host – this allows you to map another host. 

• Continue and preview all the changes – this allows you to view an online printout of the 
change report which presents a preview of all changes, showing whether you added, modified 
or deleted any devices.

If your configurations are complete, select Continue and preview all changes.

The LUN Mapping Wizard – Preview All Changes dialog box appears.
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8 Prior to finishing and saving your LUN mapping configuration changes, review your newly mapped or 
unmapped devices in this dialog box. 

• If you would like to create a report of your changes, click View Change Report. 

• If you are satisfied with your LUN mapping changes and want complete the wizard process, click 
Finish. Your LUN mapping changes are finalized, and then you have the option of viewing the LUN 
Mapping Report. For more information on reporting features, see the Scalar i6000 User’s Guide.

The LUN Mapping Change Preview Report – Print Preview dialog box appears. This dialog box 
displays what types of changes were made to all devices.

The changes on the report include: 

• Added Mapping – (A)

• Removed Mapping – (R)

• LUN Modified – (M)

On the LUN Mapping Change Preview Report – Print Preview dialog box, you can select the 
following:

• To save the report as a PDF file, click PDF. Specify a file path and file name, and then click 
Confirm.

• To print the report, click Print. Specify print options, and then click OK.

• To navigate through the pages of the report, click Back or Next.

• To increase or decrease the magnification of the report, click Zoom In or Zoom Out.

• To access the Online Help, click Help.
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9 After you have reviewed the LUN Mapping Change Preview Report, click Close to return to the LUN 
Mapping Wizard – Preview All Changes dialog box.

10 If you are satisfied with your LUN mapping changes and want to complete the wizard process, click 
Finish. Your LUN mapping changes are finalized, and then you have the option of viewing the LUN 
Mapping Report. 

Setting up Control Path and Storage Networking
If your library contains LTO-5 drives attached to Ethernet Expansion blades, use the following procedures 
to set up your LTO-5 SNW drives.

To use SNW features, you must install an SNW license. See Enabling Licenses on page 164.

For more information on Control Paths, see Working with Library Control Paths on page 180.

Configuring Control Path
Use the Control Path function to configure a partition and the appropriate drives to handle the host 
application’s control path commands. When you initially create the library partitions, you can configure the 
control paths and they are assigned. For more information, see the Scalar i6000 User’s Guide.

Follow the steps below to select a partition and configure the control path for your LTO-5 SNW drive.

1 Log on as an administrator.

2 From the main console, select Setup→ Partitions→ Control Path.

The Storage Networking Partitions dialog box appears. 

3 Highlight the partition you want to configure, and click OK.
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The Control Path dialog box appears.

4 In the CP Drive Selection field, select the drive you want to configure as the control path.

The primary Control Path Drive you selected is highlighted in yellow.

5 Click OK.
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Selecting a Storage Networking Drive
Use the SNW Drives command to the select the LTO-5 drives that you want managed using the SNW 
feature. You can configure your drives to allow or deny access to client hosts. Only LTO-5 generation or 
later drives support the SNW functionality. 

An SNW license is required for each drive using SNW functionality.

1 If you are not already working from the physical library, select it from the View menu. 

2 Click Setup→ Device→ Access→ SNW Drives.

The Storage Networking License Drive Configuration dialog box appears.

3 To select all drives, click the check box next to Select All Drives.

4 To select an individual drive, click the check box in the left column for the appropriate row.

5 Click OK.
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Configuring the SNW Host Device
Use the SNW Host commands to configure host access to the Storage Networking (SNW) drives. For more 
information on Host configuration, see the Scalar i6000 User’s Guide.

1 If you are not already working from the physical library, select it from the View menu. 

2 Click Setup→ Device→ Access→ SNW Host.

The Storage Networking Host Configuration dialog box appears

3 Select the host(s) you want to access by clicking the check box from the Host Configured table.
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4 Click Access.

The Host Access dialog box appears.

5 On the top portion of the screen, expand the HOST LIST folder, and highlight the host you want to 
change.

6 From the Select Partition drop down menu, select the appropriate partition. 

This action filters the drives in the Drive Access table and show only those drives that belong to the 
partition selected. By default all SNW drives will be displayed.

In the Partition Access section, the partitions are displayed.

7 Select drives.

To select all drives in the Drive Access table, click the Select All Drives check box; to select individual 
drives, select the check box for each drive.

When a drive check box is selected/unselected the color of the row in the table will change to indicated 
the change to the current drive configuration. The colors have the following meaning GREEN (access 
will be granted to the host selected in the HOST LIST), YELLOW (access will be denied to the host 
selected in the HOST LIST) and WHITE (no change has been made).

The drives that are presented in the Drive Access table have the following characteristics:

• The drives have a SNW license. 
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• The drives are LTO5 fibre drives.

• The drives are connected to a Ethernet Expansion blade.

8 Select partitions.

9 To select all partitions in the Partition Access table, click the Select All Partitions check box; to select 
individual partition, select the check box for each partition.  
When a partition is selected/unselected the table row color will change indicating the new configuration 
requested. The colors have the same meaning as the drive table described above.

The partitions that are presented in the Partition Access table have the following characteristics:

• The partitions contain one or more SNW licensed drives.

• The partitions have a Control Path drive configured. 

10 To make changes to a number of hosts, follow steps 6 through 9 for each host. 

11 Click OK to apply the changes.

The Host is now configured.

Putting Physical Library and Partitions Online

Individual partitions, as well as the physical library, must be online in order for a host to communicate with 
them.

Putting a Partition Online
1 Select the partition using the View menu.

2 Click Operations→ Change Mode. 

The Change Library Mode dialog box appears.

3 Select Online.

4 Click OK.

Putting the Physical Library Online
1 Select the physical library using the Change Library Mode menu.

2 Click Operations→ Change Mode. 
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The Change Library Mode dialog box appears.

3 Select Online.

4 Click OK.

Proceed to Configuring Screen Saver Preferences on page 226.
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Online and Offline Functionality
Some library functions require the physical library or partitions to be in a particular state (either online or 
offline) before they can be performed. If you choose a function that requires the library or partition state to 
be changed from its current state, you are prompted to do so.

Table 10 on page 222 summarizes the library functions that require the physical library or partitions to be 
either online or offline.

Table 10 Library Functions Requiring Online or Offline State

Function Physical Library Partition

Operations→ Import

Operations→ Export

Operations→ Drives→ Load

Operations→ Drives→ Unload

Operations→ Move Media

Operations→ Inventory (partition view)

Setup→ Partitions (create, modify, or delete)

Online Offline

Setup→ Device→ IDs

Tools→ Partitions Defragmentation

— Offline

Operations→ Inventory (physical library view)

Tools→ Teach

Tools→ Save/Restore (restore, revert, or rescue)

Tools→ Verification Tests (start test)

Tools→ Update Software (update or reinstall library 
software)

Service→ Manual Diagnostics

Offline —

Tools→ Update Software (set up autoleveling or 
update drive firmware)

Tools→ Update Drive Firmware

(Offline)

Current view (library or partition) must 
be offline
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Configuring Drive Cleaning

When you create or modify a partition, you can specify that tape drives in that partition be automatically 
cleaned each time the drive requests a cleaning operation.

For automatic drive cleaning to function, you must configure drive cleaning for the library. To configure drive 
cleaning, first assign cleaning magazines, and then import cleaning media. Designated cleaning media can 
also be used when manually cleaning drives. (Cleaning magazines and media are not part of any logical 
partition, and so are not visible to the host application.)

If cleaning magazines are no longer needed, you can unassign them. In addition, you can export expired 
cleaning media to remove it from the library.

Assigning Cleaning Magazines and Importing Cleaning Media
To configure the library for drive cleaning, first assign one or more magazines as cleaning magazines, and 
then import cleaning media.

1 Insert one or more pieces of cleaning media into the I/E station and close the I/E station door.

Use a standard barcode label for cleaning media. Barcode numbers do not require a specific prefix or 
suffix.

2 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

3 On the menu bar, click Setup→ Drive Cleaning.

The Drive Cleaning Configuration dialog box appears.

Click a magazine slot or a piece of media to select it. Details about the selected slot or media appear 
under Information, including the type of media, barcode number, location, and the number of times the 
media has been mounted in a drive.

If the library has more than one frame, click the arrow buttons to display the next or previous frame.

Note Automatic drive cleaning should be enabled for partitions only if the host 
application does not support the coordination of drive cleaning. If drive cleaning 
functionality is enabled on the host application, do not enable automatic drive 
cleaning for any partitions in the library.

For more information about enabling automatic drive cleaning for a partition, 
see Table  on page 182. For more information about manually cleaning drives, 
see the Scalar i6000 User’s Guide.

Note At least one magazine must be assigned for cleaning before you can import 
cleaning media. Also, only magazines that do not belong to a partition can be 
assigned for cleaning.
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4 To assign a magazine for cleaning, click any slot in the magazine to select it. Click Menu, and then click 
Assign magazine for cleaning.

The magazine is assigned for cleaning. Repeat this step to assign additional cleaning magazines.

5 To import cleaning media, click the cleaning media in the I/E station to select it, and then do one of the 
following:

• To import only the selected piece of media, click Menu, and then click Import <barcode number> 
as cleaning media.

• To import all media in the selected I/E station magazine, click Menu, and then click Import all tapes 
in magazine as cleaning media.

The cleaning media is moved to an available cleaning magazine, and can be used for automatic or 
manual cleaning.

6 Click Close to close the Drive Cleaning Configuration dialog box.

Note If you are working on the remote LMC, you can right-click a magazine slot or a 
piece of cleaning media to see a menu of available options.
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Exporting Cleaning Media
Cleaning media can be used a limited number of times. If a piece of media is expired, export it and remove 
it from the library

1 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

2 On the menu bar, click Setup→ Drive Cleaning.

The Drive Cleaning Configuration dialog box appears. If the library has more than one frame, click 
the arrow buttons to display the next or previous frame.

To determine if a piece of cleaning media has been used the maximum number of times, click the media 
to select it, and then check the Mount Count value under Information.

3 Click the cleaning media in a cleaning magazine to select it, and then do one of the following:

• To export only the selected piece of media, click Menu, and then click Export cleaning media 
<barcode number>.

• To export all media in the selected magazine, click Menu, and then click Export all cleaning media 
in magazine.

The cleaning media is moved to an available I/E station magazine.

4 Click Close to close the Drive Cleaning Configuration dialog box.

Unassigning a Cleaning Magazine
If a magazine is no longer needed for holding cleaning media, first export all cleaning media from the 
magazine, and then unassign it.

1 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

2 On the menu bar, click Setup→ Drive Cleaning.

The Drive Cleaning Configuration dialog box appears. If the library has more than one frame, click 
the arrow buttons to display the next or previous frame.

3 If the magazine you want to unassign contains cleaning media, export all cleaning media to the I/E 
station.

For more information on exporting cleaning media, see Exporting Cleaning Media on page 225.

4 Click any slot in the cleaning magazine to select it.

5 Click Menu, and then click Unassign magazine for cleaning.

The magazine is no longer assigned for cleaning.

6 Click Close to close the Drive Cleaning Configuration dialog box.

Note If you try to unassign a cleaning magazine that contains cleaning media, a 
message appears asking if you are sure you want to continue. If you click Yes, 
any media in the magazine is not accessible until you add the magazine to a 
partition or assign it again as a cleaning magazine.
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Configuring Screen Saver Preferences

Use the Screen Saver preferences tab to customize the images that display on the LMC screen when the 
library is not in use. The screen saver starts automatically if the library is idle for a specified amount of time.

1 From the menu bar, click Setup→ Preferences. 

The Preferences dialog box appears with the Screen Saver tab displayed. 

2 Do one of the following:

• Select Default to use the default Quantum screen saver with standard settings.

• Select Custom to change screen saver settings such as activation, movement, or images.

• Select Off to disable the screen saver. (The current settings are cleared.)

If you selected Custom, go to Step 3 on page 226. Otherwise, go to Step 6 on page 227.

3 Under Activation, enter a value in the Wait box to specify how much idle time must pass before the 
screen saver is activated.

The activation wait time can be 1–120 minutes.

4 Under Movement, specify the position and the motion of the screen saver image on the screen.

• Select Random to display the screen saver image in a variety of positions.

• Select Stationary to display a static screen saver image that does not move.

Note Screen saver preferences can only be configured remotely, not using the touch 
panel.
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• Select Linear to display the screen saver image as a floating image.

Enter values in the horizontal and vertical boxes to specify the movement of the screen saver 
image in pixels.

Enter a value in the Motion Delay box to specify the movement speed of the screen saver image.

5 Under Images, specify the image files to display for normal functions, warning notices, and failure 
notices. You must select image files for all three functions.

To specify an image file, click Browse. Select the image file and then click Open. The image file must 
be in GIF, JPEG, or PNG format, and cannot be larger than 1 MB. In addition, image resolution is limited 
to 600 x 800 pixels.

Click Preview to preview an image file.

6 Click OK to save the settings and close the Preferences dialog box.

Or click Apply to save the settings without closing the Preferences dialog box.

If you previously made system configuration changes, you are prompted to save the configuration 
changes. For more information, see Saving the Library Configuration on page 228.
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Saving the Library Configuration

Save a copy of the library configuration as a local rescue image and to a remote location as a restore image. 
See the Scalar i6000 User’s Guide for more details on library configuration saving.

1 Log on as an admin or service user on the remote client.

2 If you are not already working from the physical library, select the physical library from the View menu.

3 Click Tools→ Save/Restore.

The Save and Restore Library Configuration dialog box appears.

4 Click Save.

5 From the File Chooser dialog box, specify where to save the restore image on the remote file system. 
You need only to specify the path since the management control blade determines the image file name. 

6 Click Open when you are ready to proceed.

7 Click Yes, when you are prompted whether you want to generate a rescue image at the same time the 
remote image is saved. You are asked because no rescue image currently exists.

If the save operation is successful, a message dialog box appears indicating the name of the image file that 
was saved to the remote file system. The time stamp of the local rescue image will also appear on the Save 
and Restore Library Configuration dialog box.

If the save operation is not successful, a message dialog appears describing the error.

Proceed to Logging Off on page 229.

Note The Save/Restore command is not available from the library’s touch screen.

CAUTION
As a result of restore, rescue, or revert operations, the library shuts down. 
You must have physical access to the library to bring the library back up. If 
you are performing a restore, rescue, or revert operation using remote 
access, the library will remain shut down until the library is directly powered 
back on.
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Logging Off

Log off using the touch screen after you are finished with your management session.

Click Operation→ Log Off. 

You can also log off by clicking Log Off on the toolbar.

Clicking the Log Off command causes the Log On dialog box to appear. To return to library management, 
log on again.
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Adding Optional Hardware
This chapter describes how to add optional hardware to an existing library. The instructions include:

• Adding Drives to an Existing Installation on page 233

• Adding a Power Supply Chassis on page 240

• Adding a Redundant Power Supply on page 244

• Adding an I/O Management Unit on page 247

• Adding Blades to the I/O Management Unit on page 257

• Adding a 24-Slot I/E Station to an Expansion Module on page 269

• Adding a 72-slot I/E Station to an Expansion Module on page 281

• Adding Aisle Lights on page 297

Note The instructions in this chapter assume that you are adding optional hardware 
to an existing library.

If you are installing a new library, use the instructions in:

• Installing a Stand-Alone Control Module on page 19

-OR-

• Installing a Multi-Module Library on page 27
Scalar i2000 Installation Guide 231



Shutting Down the Library

Some optional hardware can be installed only if the library is powered off. If you are instructed to shut down 
the library, use the following procedure.

1 Log on as an admin or service user.

2 Make sure that you are viewing the physical library. From the View menu, select the name of the 
physical library.

3 Click Operations→ System Shutdown.

The System Shutdown dialog box appears with Shutdown selected as the default.

4 Click Yes to accept Shutdown as the default.

5 A message appears that asks you whether you want to continue. If you are sure that all I/O operations 
are finished, click OK.

When the shutdown process completes, the LMC display turns dark. The library is now ready to be 
powered off.

6 Turn off power to the library by pressing the Power button on the indicator panel.

Status indicator

Power indicator/button

Robotics Enabled
indicator/indicator

touch screen
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Adding Drives to an Existing Installation
The instructions in this section assume that you are adding optional drives to an existing installation.

• If you are installing drives in a new library, see the instructions in Installing Drives and Blades on 
page 97.

• If you are adding drives to an existing library, you must remove storage magazines and drive plates 
to gain access to the drive positions. You must also modify the partition to accommodate the 
changes to storage and drives. Adding Drives to an Existing Installation on page 233.

• If you are removing and replacing failed drives in an existing library, see the Scalar i2000/i6000 
Maintenance Guide.

If you are installing drives in expansion modules that have been added to an existing library you may need 
to replace all of the LBX cards in all modules as well as the LBX terminator with new versions that support 
the new configuration. For information on the LBX board and terminator versions, see LBX Board and 
Terminator on page 345. For information on replacing the LBX board and terminator, see "Removing and 
Replacing Satellite Boards" in the Scalar i2000/i6000 Maintenance Guide

If you are adding drives in an expansion module that has never contained drives, you must add a power 
supply to the expansion module. See Adding a Power Supply Chassis on page 240.

If you plan to connect drives to FC I/O blades in the I/O management unit, remember that each FC I/O blade 
supports up to 4 drives and that you may need to add FC I/O blades and CMBs. See Adding an I/O 
Management Unit on page 247, Adding Blades to the I/O Management Unit on page 257, and Installing a 
Control Management Blade on page 259.
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Drive Numbering Sequence
An example of the numbering sequence for drives is shown in Figure 23 below.

For information on the library’s coordinate system, see Storage Addressing System Overview on page 132.

Gaps between drive locations are not supported. Drives must be added to each module in the order shown 
in Figure 23 . The control module must be fully populated with 12 drives before adding any drives in the first 
expansion module. The first expansion module must be fully populated before adding any drives to 
additional expansion modules. Each additional expansion module must be fully populated before adding 
any drives to subsequent expansion modules.

Figure 23 Drive Sled Positions

1,1,1,12,1,1
1,1,1,11,1,1

1,1,1,9,1,1
1,1,1,8,1,1
1,1,1,7,1,1

1,1,1,10,1,1

1,1,1,6,1,1
1,1,1,5,1,1

1,1,1,3,1,1
1,1,1,2,1,1
1,1,1,1,1,1

1,1,1,4,1,1
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The following procedure provides instructions for adding drives to an existing library. See Installing Drives 
on page 105 for installing drives in a new library.

Required tools: 2.5 mm hex wrench, #2 Phillips screwdriver, ESD strap

7 Determine which magazines must be removed in order to add a drive and determine if the magazines 
are used in any partitions. 

8 Remove the magazines from each partition(s) using the following procedure: 

 a. Click Physical on the View menu.

 b. Click Setup→ Partitions→ Configure.

The Partitions dialog box is displayed.

 c. Select the partition that include the affected magazines and click Modify.

 d. Return the affected magazines to the physical pool.

 e. Repeat Steps a through d for each partition associated with the drive installation procedure.

9 On the operator panel, press the Robotics Enabled button to return the accessor assembly to the 
home position.

The power remains on for all other components.

10 Open the access door.

11 Remove the magazines in front of the lowermost vacant drive location to make room for the drive. To 
remove, push the magazine upward with both hands until it unsnaps, and then pull the magazine toward 
you.

CAUTION
All partition elements associated to this upgrade procedure must be 
modified before proceeding with this procedure.

Prior to modifying any partitions, you must understand your 
configuration changes and the potentially disruptive effects those 
changes can have on the host application(s). 

Care must be taken whenever you add or delete partition elements, 
which includes drives, storage magazines, and I/E station magazines.
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You might need to remove more than one magazine to create enough space for the drive you are 
adding. It is recommended that you remove all of the magazines in the column and remove them from 
the top down.

12 Use a 2.5 mm hex wrench to unscrew the retaining screws (two screws per plate) and remove the cover 
plates from the drive position. 

13 Reinstall the magazines above the new drive position.

Note Make sure that you fully seat each magazine by inserting each of the 
magazine’s four corner tabs into the available holes in the cover plate.

magazines

cover plates

two 2.5 mm hex screws
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14 Close the access door.

15 On the front panel, press the Robotics Enabled button and verify that the button’s status light 
illuminates in solid green state.  

16 Open the service door.

17 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

18 In the corresponding drive location, using the #2 Phillips screwdriver or your fingers, unscrew the 
retaining thumbscrews and remove the drive cover plates. You must remove two cover plates for each 
drive that you are adding.

19 Using the markings on the drive slot, insert the drive slowly so the guide rails engage. The drive should 
be flush with no gaps above or below it.

Use the bottom of the empty drive cluster as a guide if you are adding the drive to the Drive 1 or Drive 
7 position.

Note Before inserting drives, you must enable the robotics, otherwise the RCU 
cannot perform the necessary functions to add drives to the configuration.

thumbscrews on cover plates
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20 Use the #2 Phillips screwdriver or your fingers to tighten the two retaining thumbscrews of the UDS drive 
sled.

21 Add any additional tape drives in the lower drive cluster. When the lower cluster is full, add the next tape 
drive to the upper drive cluster.

22 Verify that the green LED on the back of the drive is on. If it is not on, the drive is not installed properly.

23 Observe the state of the green LED while the drive sled firmware automatically loads. It could take up 
to 20 minutes to complete the drive sled firmware download. When the green LED is solid on for three 
seconds, then blinks twice and repeats, the drive firmware is downloading. The drive sled firmware 
download is complete when the green LED blinks one time every second, the amber LED is off, and the 
blue LED blinks one time every 10 seconds. See Interpreting Drive Status LEDs on page 354 for a 
complete listing of the LED blinking codes.

24 Use the instructions in Cabling on page 111 to connect the new drives.

25 Detach the ESD strap and close the door.

The power is on.

26 From the LMC, click Tools→ Teach.

27 Click Configure, and then click Start. 

Note • After you add a drive, the robotics control unit ensures that the drive 
sled is loaded with the proper firmware. This firmware is based on the 
currently installed level of library firmware on the management control 
blade (MCB). If the autoleveling process fails, the drive sled becomes 
inoperable and the library creates a ticket to report the issue.

• If more than one drive is added into the library, when the library is 
already powered up, the RCS autolevels the drive after approximately 
30 seconds. The autolevel countdown restarts if another drive is added 
within 30 seconds of the last added drive. The RCS queues up all drives 
inserted before performing the autolevel. 

• Because UDS-2 and UDS-3 sleds require different application images, 
if your library contains both types of sleds, the RCS may need to 
autolevel twice.

cover plate

drive

glide rail
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The Working screen appears. Once the teach is completed, a message appears in the Results field, 
for example, “Command Completed.”

28 Add the new drive(s) to a partition using the following procedure:

 a. Log into the LMC as service user.

 b. Click Setup→ Partitions→ Configure.

The Partitions dialog box is displayed.

 c. Select the partition that include the affected magazines and click Modify.

 d. Select a partition and add the new drive(s).

29 To avoid confusion, add the affected magazines back into the appropriate partition. The partition should 
be the same size as the original partition.

 

Note Due to licensing requirements, the physical location of the affected magazines 
may not be available until the procedures completes. 
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Adding a Power Supply Chassis

Required tools: 7 mm socket wrench, ESD strap

1 Shut down the library.

For more information, see Shutting Down the Library on page 232.

2 Open the service door on the control module or expansion module where you are adding the power 
supply chassis.

3 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

4 On the power distribution unit(s), set the circuit breaker switch to the down (0) position.

5 Remove the four thumbscrews retaining the cover plate from the power chassis opening.

6 Remove the LBX cover plate.

7 Unpack the power chassis.

thumbscrews

thumbscrews
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8 Slide the power chassis into the module and attach it using the four 7 mm screws.

9 Install the power supplies and power distribution units.

Not all expansion modules will receive redundant power supplies, as those shown below.

10 Through the space the LBX occupied, connect all the cables to the top of the power chassis.

The connections include four white connectors and one gray ribbon cable (the LBX ribbon). You only 
need to connect the white connectors from the power chassis.

11 Connect the LBX ribbon cable.

7 mm screws

power supplies

power distribution units
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12 Insert and tighten the LBX/IEX cover plate using the thumbscrew.

connector: J48S 
plug: W5 to LBX

connector: J48AP 
plug: W17 to I/O
management unit  

connector: J48B 
plug: W13 to upper drive cluster

connector: J48A 
plug: W13 to lower drive cluster

LBX/IEX cover 
plate thumbscrew
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13 Insert the power cords into the power distribution units and turn them clockwise.

14 Plug the two power cords into the power source.

15 On both power distribution units, toggle the power switch to the up (I) position to turn on the power. If 
you have power coming to other modules of the library, they must be turned on as well.

16 Detach the ESD strap and close the door.

17 To turn on power to the library, press the Power button on the indicator panel.

The library begins to boot up. Within five minutes, the LMD display appears on the library’s touch 
screen. A library with only a few drives usually will be fully powered on and ready for use within 10 
minutes. However, if a library is large with a high number of drives, it can take more than an hour for the 
library to fully power on, complete its discovery process, and become ready for use. During the power-
on process, the Robotics Enabled indicator flashes. When the library is fully up and ready to receive 
commands, the Robotics Enabled indicator turns solid green.

plug the power cables into
the power distribution units

turn both power switches
to the on position (I)
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Adding a Redundant Power Supply

The library supports both non-redundant and redundant power configurations. The non-redundant 
configuration has a single power supply and power distribution unit. The redundant configuration has two 
power supplies and two power distribution units. 

This subsection provides step-by-step instructions for installing a second power supply into a module. 
These instructions work for both the control module and expansion modules.

Required tools: #2 Phillips screwdriver, ESD strap

1 Open the service door on the control module or expansion module where you are adding the power 
supplies.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Use the Phillips screwdriver to loosen the thumbscrews that retain the cover plate over the power supply 
slot. Discard the cover plate or leave them with the customer for future use.

4 Carefully unpackage the power supply and power distribution unit and remove them from the antistatic 
bags.

Note You do not need to take the library offline in order to add the second power 
supply for redundancy.

Power supplies are not used in expansion modules eight through eleven. Only 
the control module and first seven expansion modules support a power supply. 
A power supply in an expansion module powers the drives and, therefore, a 
power supply must be present for each module that has a drive.

thumbscrews
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5 Slide in the power supply and tighten the thumbscrew.

6 Slide in the power distribution unit and tighten the thumbscrew. 

power supply

thumbscrew

thumbscrew

power distribution unit
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7 Route the power cord through the cable access opening at the bottom of the module.

8 Connect the power cord to the power distribution unit.

9 Route and connect the AC power cord to the power source.

10 On the power distribution unit, toggle the circuit breaker switch to the On position (I) to turn on the 
power.

Note The power supply in the top position is represented as power supply 1 in 
the Library Management Console (LMC) and the power supply in the 
bottom position is represented as power supply 2.

cable access opening

power distribution unit

circuit breakers
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Adding an I/O Management Unit

Required tools: 7 mm socket wrench, Phillips screwdriver, ESD strap

1 Shut down the library.

For more information, see Shutting Down the Library on page 232.

2 Open the service door.

3 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

4 Use your finger or a Phillips screwdriver to loosen the thumbscrews on the cover plate where the I/O 
management unit will be installed.

5 Remove the vented cover plate from in front of the LBX board. The cover plate will be reused later in 
this procedure.

Note There must be a power chassis in the expansion module when adding an I/O 
management unit.

thumbscrews

thumbscrews
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6 Use your fingers or a Phillips screwdriver to unscrew the two tall covers next to the drive clusters and 
the mid-module cover plate. Remove the cover plates and set them aside. They will be reused later in 
this procedure.

7 Open the box containing the new I/O management unit.

8 Feed the I/O management unit’s cables into the space behind where the I/O management unit is 
installed. The cables must go downward towards the LBX board.

9 Insert the I/O management unit into the opening. Make sure the cables are not bent and continue going 
down towards the LBX board.

thumbscrews

thumbscrews

thumbscrews
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10 Use the 7 mm nut driver to secure the four retaining screws.

11 Through the space behind the LBX board, connect the W17 cable to the J48AP connection on top of 
the power chassis. This is the connection to the power distribution unit.

7 mm screws

connector:J48AP
plug: W17 to I/O management unit
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12 Connect the I/O management cables to the LBX board. This includes connecting the CAN cable (W7) 
to J13, connecting the Ethernet cluster cable (W11) to J10, and connecting power supply status cable 
(W16) to J16.

13 Insert and tighten the LBX/IEX cover plate using the thumbscrew.

Note For more LBX version information, see LBX Board and Terminator on page 
345.

connector: J13
plug: W7 to I/O
management unit
and CAN interface

connector: J10
plug W11 to I/O
management unit
and Ethernet

connector: J16 
plug: W16 to power
supply status cable
from LBX board 

LBX/IEX cover 
plate thumbscrew
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14 Insert and tighten the two tall covers next to the drive clusters and the mid-module cover plate.

15 Install the grated covers on the side and top of the I/O management unit.

tall top cover plate

mid-module cover plate 

tall bottom cover plate

thumbscrews

thumbscrews
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16 Use the 7 mm nut driver to attach the cable bracket.

17 Insert the I/O management unit cooling assembly and push the handle up to lock it in place. Use a #1 
Phillips screwdriver tighten the screw.

7 mm screws

Phillips screw 
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18 Evenly apply pressure to both ends of the control management blade (CMB) and slide it into bay 2 of 
the I/O management unit. As you insert the CMB, the latchhooks will begin to move towards the middle 
of the blade. Push the latchhooks towards the middle of the blades and into the lock position. You will 
feel the blade pins connect with the I/O management unit’s backplane as the blade locks into place.

Figure 24 I/O Management Unit Bay Layout

CAUTION
Forcing the blade into the bay can cause the pins to bend.
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19 Evenly apply pressure to both ends of the blades and slide them into the correct bay of the I/O 
management unit until the latchhooks begin to move towards the middle of the blade. Push the 
latchhooks towards the middle of the blades and into the lock position. You will feel the blade pins 
connect with the I/O management unit’s backplane as the blade locks into place.

20 Install cover plates over any bays that are not populated with blades.

CAUTION
Slots that are not populated with blades must contain a cover plate. If 
the cover plate is not installed, blade temperature errors will occur.

latchhooks

latchhooks

cover plate
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21 Connect the six-foot Fibre optical cables to the appropriate Fibre Channel connections on the blades. 
Ports 1 and 2 default to target and ports 3, 4, 5, and 6 default to initiator mode.

22 Route the cable through the cable keepers and down the right side of the module.

23 Insert the Fibre optical cable into the Fibre Channel connection on the drive. 

CAUTION
Fibre optical cables will be damaged if they are bent at more than a 
four inch arc. 

Fibre optic cable routed
through cable keepers

Fibre optic cable connected
to drive in drive sled position 1
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24 Gather the Fibre optical cables and put them inside the Velcro straps that are mounted on the right side 
of the module.

25 Detach the ESD strap and close the door.

26 To turn on power to the library, press the Power button on the indicator panel.

The library begins to boot up. Within five minutes, the LMD display appears on the library’s touch 
screen. A library with only a few drives usually will be fully powered on and ready for use within 10 
minutes. However, if a library is large with a high number of drives, it can take more than an hour for the 
library to fully power on, complete its discovery process, and become ready for use. During the power-
on process, the Robotics Enabled indicator flashes. When the library is fully up and ready to receive 
commands, the Robotics Enabled indicator turns solid green.

use Velcro straps
to secure cables
256 Adding Optional Hardware



Adding Blades to the I/O Management Unit

The instructions in the following subsections are to be used for upgrading existing library configurations. If 
you are installing blades in a new library, see Installing Drives and Blades on page 97 for instructions.

If you are adding blades to the I/O management unit, you must first install a cooling assembly if there is not 
one in the module.

Installing the I/O Management Unit Cooling Assembly
The I/O management unit cooling assembly contains the fans that regulate temperature for the I/O 
management unit.

Required tools: #1 Phillips screwdriver, ESD strap

1 Open the service door of the module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Use a #1 Phillips screwdriver to remove the cover over the slot where the I/O management unit cooling 
assembly will be installed.

4 Remove the I/O management unit cooling assembly from the packaging.

Note You do not need to take the library offline in order to install the I/O management 
cooling assembly, CMBs, or FC I/O blades. However, if the library is not taken 
offline RAS tickets will be posted.

cooling assembly cover
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5 Slide the I/O management unit cooling assembly into the top slot of the I/O management unit until fully 
seated.

6 Push the latch handle into the up position.

7 Use a #1 Phillips screwdriver to tighten the thumbscrew on the I/O management unit cooling assembly.

I/O management unit

cooling assembly

latch handle

Phillips screw
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Installing a Control Management Blade
Required tools: ESD strap

1 Open the service door of the module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Remove the cover plate from bay 2, the CMB slot.

4 Remove the CMB from the protective anti-static bag.

5 Press up and out to open the latchhooks on each side of the CMB.

6 Carefully align the CMB with the guide slots in bay 2. The LEDs will be on the top.

CAUTION
Forcing the blade into the bay can cause the pins to bend.

bay 2

CMB

LEDs
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7 Use your thumbs on each end of the blade to evenly apply pressure and slide it into the I/O management 
unit. When you feel the pins of the CMB lock into the backplane, push the latchhooks towards the middle 
of the blade and into the lock position. 

8 Detach the ESD strap and close the door.

Installing an FC I/O Blade
Required tools: ESD strap

1 Open the service door of the module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Remove the cover plate from bay where the FC I/O blade will be installed. The population order for the 
FC I/O blades is shown below.

4 Remove the FC I/O blade from the protective anti-static bag.

5 Press up and out to open the latchhooks on each side of the FC I/O blade.

CAUTION
Slots that are not populated with blades must contain a cover plate. If 
the cover plates are not installed, FC I/O blade temperature errors will 
occur.

Note Make sure you install the FC I/O blade into the correct bay. 
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6 Carefully align the FC I/O blade with the guide slots in the bay. The status LEDs must be at the top.

7 Use your thumbs on each end of the blade to evenly apply pressure and slide it into the I/O management 
unit. When you feel the pins of the FC I/O blade lock into the backplane, push the latchhooks towards 
the middle of the blade and into the lock position.

8 Remove and discard the white plastic covers from the FC connectors on the tape drives.

9 Remove and discard the necessary number of the black rubber protective covers from the ports on the 
FC I/O blades.

10 Carefully unwrap the six-foot Fibre optical cables and remove the two white plastic protective caps from 
each end of the cable.

CAUTION
Forcing the blade into the bay can cause the pins to bend.

CAUTION
Slots that are not populated with blades must contain a cover plate. If 
the cover plates are not installed, FC I/O blade temperature errors will 
occur.

CAUTION
Fibre optical cables will be damaged if they are bent at more than a 
four inch arc. 

FC I/O blades installed

status LEDs

in bays 3, 4, and 5
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11 Connect the Fibre optical cable to port FC-3 on the FC I/O blade that is installed in bay 3 of the I/O 
management unit. See Table 5 on page 114 for information about the cable connection requirements.

12 Route the cable through the cable keepers and down the right side of the control module or expansion 
module.

13 Insert the Fibre optical cable into the Fibre Channel connection on the drive. 

port FC-3 on the 
FC I/O blade in
in bay 3

cable connected to FC 3 on
FC I/O blade in bay 3 of the
I/O management unit

Fibre optic cable routed
through cable keepers

Fibre optic cable connected
to drive in drive sled position 1
262 Adding Optional Hardware



14 Repeat Step 10 on page 261 through Step 13 on page 262 for each drive that will be installed.

15 Gather the Fibre optical cables and put them inside the Velcro straps that are mounted on the right side 
of the module.

16 Detach the ESD strap and close the door.

Note The FC port and drive numbers will change according to Table 5 on page 
114.

use Velcro straps
to secure cables
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Installing an Ethernet Expansion Blade
Required tools: ESD strap

1 Open the service door of the module.

2 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

3 Remove the cover plate from bay where the Ethernet Expansion blade will be installed. The population 
order for the Ethernet Expansion blades is shown below.

4 Remove the Ethernet Expansion blade from the protective anti-static bag.

5 Press up and out to open the latchhooks on each side of the Ethernet Expansion blade.

Note Make sure you install the EEB into the correct bay. 
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6 Carefully align the blade with the guide slots in the bay. The status LEDs must be at the top.

7 Use your thumbs on each end of the blade to Figure 23 on page 234 evenly apply pressure and slide it 
into the I/O management unit. When you feel the pins of the blade lock into the backplane, push the 
latchhooks towards the middle of the blade and into the lock position.

8 Remove and discard the plastic covers from the Ethernet connector on the tape drives.

9 Remove and discard the protective covers from the ports on the Ethernet Expansion blades.

10 Carefully unwrap the EEB cables and remove the two plastic protective caps from each end of the cable.

CAUTION
Forcing the blade into the bay can cause the pins to bend.

CAUTION
Slots that are not populated with blades must contain a cover plate. If 
the cover plates are not installed, blade temperature errors will occur.

Ethernet Expansion blades installed

status LEDs

in bays 7 and 8
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11 Connect the cable to ETH 1 on the Ethernet Expansion blade that is installed in bay 7 of the I/O 
management unit. See Cabling on page 111 for information about the cable connection requirements.

12 Route the cable through the cable keepers and down the right side of the control module or expansion 
module.

port 1 on the 
EEB in
in bay 7

EEB cable routed
through cable
keepers
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13 Insert the EEB cable into the EEB port connection on the drive.

14 Repeat Step 10 on page 265 through Step 13 on page 267 for each drive that will be installed and 
connected to an EEB.

Note The EEB port and drive numbers will change according to Cabling on page 
111.

EEB cable connected
to drive in drive sled 1
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15 Gather the EEB cables and put them inside the Velcro straps that are attached to the right side of the 
module.

16 Connect the designated host to the port on the EEB.

17 Detach the ESD strap.

use Velcro straps
to secure cables
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Adding a 24-Slot I/E Station to an Expansion Module

This section describes how to upgrade an expansion module to include a 24-slot I/E station.

Required tools: #2 Phillips screwdriver, 2.5 mm hex wrench, disposable screw capture tool, wire cutters (for 
plastic ties), ESD strap

1 You must export all media from the access door being upgraded.

 a. Log into the Library Management Console (LMC).

 b. Click Operations → Export.

2 Before removing any magazines in the access door of the expansion module you are upgrading, 
determine if the magazines are used in any partitions. 

3 If the Automatic Teach mode is being used, disable it to perform this upgrade procedure.

4 Remove the magazines in the access door from each partition(s) using the following procedure:

 a. Click Physical on the View menu.

 b. Click Setup→ Partitions→ Configure.

The Partitions dialog box is displayed.

 c. Select the partition that include the affected magazines and click Modify.

 d. Return the affected magazines to the physical pool.

 e. Repeat Steps a through d for each partition associated with the access door you are upgrading.

5 Shut down the library.

For more information, see Shutting Down the Library on page 232.

Note You can add 24-slot I/E stations to the control module and any of the first seven 
expansion modules.
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6 Open the access door of the expansion module that is to receive the I/E station.

7 Remove the magazines in columns 1 through 4, sections 1 through 5 of rack 2 to access screws and to 
make room for the I/E station. Also removing the magazines in columns 3 and 4, section 6 provides 
additional space when installing the I/E station. 

Note Make a note of the target magazine location when it is removed. Keep this 
magazine within reach. You will need it to perform Step 26 on page 279 of 
this procedure.

If you are adding the I/E station to the control module, none of the 
magazines in column 4 will be present.
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remove all magazines
inside the boxed area 
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8 For each of the six screws on the top cover of the access door:

 a. Place the disposable screw capture tool over the screw.

 b. Insert the #2 Phillips screwdriver through the disposable screw capture tool until seated on the 
screw.

 c. Remove the screw and set it aside.

Note Be careful when removing the last screw that the skin does not fall off the front 
of the access door.

six #2 Phillips screws

top cover on
access door
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9 Use the 2.5 mm hex wrench to remove the six screws that hold the top-right magazine filler panel to the 
inside of the access door. 

10 Remove the filler panel. Set the screws aside.

11 From the inside of the access door, mount the I/E station by first inserting the top of the I/E station over 
the top rim flange of the door’s I/E station opening. Once the top is in place, the I/E station should hang 
in the opening with the screw holes cut in the sides of the I/E station lining up with the holes in the door.

2.5 mm hex screws

magazine filler panel
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12 Use a 2.5 mm hex wrench to attach the I/E station to the door using the six screws removed in Step 8 
on page 271.

13 Use a #2 Phillips screwdriver to mount the new expansion module skin onto the upper area of the 
access door next to the I/E station using three screws.

2.5 mm screws

three #2
Phillips screws
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14 Use a #2 Phillips screwdriver to insert and tighten the four screws that secure the I/E station panel cover 
onto the I/E station door.

15 Test the fit of the outer covers by opening and closing the I/E station. Adjust the door as necessary.

16 Cut and remove the two cable ties that hold the door interlock cables to the expansion module frame.

17 Open the service door of the expansion module. 

four #2 Phillips screws
I/E station door

cable ties
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18 Use a #2 Phillips screwdriver to remove the top drive cluster cover plate, the mid-module cover plate, 
the bottom drive cluster cover plate, and the LBX/IEX cover plate.

19 Connect cable W6 to the I/E station lock assembly and route the cable around the cable tray.

mid-module cover plate

bottom drive cluster
cover plate

LBX/IEX cover plate

top drive cluster
cover plate

I/E station lock
assembly

W6 cable
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20 Following the cutouts on the cable tray ramp, secure cable W6 to the cable tray using the eight Velcro 
straps provided.

21 Secure the cable to the expansion module frame and cable tray using the five cable ties provided.

Velcro straps

W6 cable

cable ties
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22 Plug the W6 cable into the I/E station and secure the cable using the plastic ties.

23 Route the I/E station cable (W6) from the I/E station lock assembly following the door interlock cable to 
toward the rear of the expansion module. Continue routing cable W6 through the drive cluster clamps 
down toward the LBX board.

24 Connect cable W6 to the J7 connector on the LBX board.

W6 cable

J7 connector

W6 cable
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25 Use a #2 Phillips screwdriver to replace the top drive cluster cover plate, the mid-module cover plate, 
the bottom drive cluster cover plate, and the LBX/IEX cover plate.

mid-module cover plate

bottom drive cluster
cover plate

LBX/IEX cover plate

top drive cluster
cover plate
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26 Reinstall the magazines you removed. Replace the upper target magazine in the column 2, section 1 
position on the access door. If the target magazine is not in the correct position, the library will fail 
calibration.

27 Install four magazines into the I/E station.
.

28 Detach the ESD strap and close the door.

29 Press the Power switch on the operator panel.

magazines 

column 2, section 1
magazine position 

install four magazines 
into the I/E station
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30 Log on to the library as service.

31 Run the Configure and Calibrate teach commands by clicking Tools→ Teach from the LMC. 

32 Select Configure and click Start. The WORKING screen appears. 

Once the teach is completed, a message appears in the Results field, for example, “Command 
Completed.”

33 For a library that is already configured, you must modify any existing partition that includes resources 
altered or removed by the change in the expansion module physical configuration to incorporate the 
new I/E station. 

In the LMC, click Setup→ Partitions to modify partitions and create new ones. See the Scalar i6000 
User’s Guide for more information about working with partitions.
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Adding a 72-slot I/E Station to an Expansion Module

This section describes how to upgrade an expansion module to include an access door with a 72-slot I/E 
station. The first seven expansion modules can contain 72-slot I/E stations.

Required tools: #2 Phillips screwdriver, 2.5 mm hex wrench, 3 mm hex wrench, wire cutters (for plastic ties), 
foot jack, M4x10 screws, ESD strap

1 You must export all media from the access door being replaced.

 a. Log into the Library Management Console (LMC).

 b. Click Operations → Export.

2 Before removing any magazines in the access door of the expansion module you are upgrading, 
determine if the magazines are used in any partitions. 

3 If the Automatic Teach mode is being used, disable it to perform this upgrade procedure.

4 Remove the magazines in the access door from each partition(s) using the following procedure: 

 a. Click Physical on the View menu.

 b. Click Setup→ Partitions→ Configure.

The Partitions dialog box is displayed.

 c. Select the partition that include the affected magazines and click Modify.

 d. Return the affected magazines to the physical pool.

 e. Repeat Steps a through d for each partition associated with the access door you are upgrading.

5 Shut down the library.

For more information, see Shutting Down the Library on page 232.

6 Open the service door of the expansion module that you are upgrading.

Note Make certain the firmware installed on the library system is the required version 
for the 72-slot I/E station functionality. Check Quantum site: 
www.quantum.com/osr for the lasted firmware information.

CAUTION
All partition elements associated to this upgrade procedure must be 
modified before proceeding with this procedure.

Prior to modifying any partitions, you must understand your 
configuration changes and the potentially disruptive effects those 
changes can have on the host application(s). 

Care must be taken whenever you add or delete partition elements, 
which includes drives, storage magazines, and I/E station magazines.
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7 Use a #2 Phillips screwdriver to remove the top drive cluster cover plate, the mid-module cover plate, 
the bottom drive cluster cover plate, and the LBX/IEX cover plate.

8 Identify which version of the IEX card is currently installed in the library, If the library contains an IEX2 
card (identified by a red sticker), skip to Step 12 on page 284. Otherwise, proceed to Step 9 on page 
283.

mid-module cover plate

bottom drive cluster
cover plate

LBX/IEX cover plate

top drive cluster
cover plate
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9 Use your thumb to unsnap the IEX1 board from the two standoffs.

10 Unplug the IEX board from the LBX board, and then remove the IEX board.

standoffs

IEX1 board

connection between IEX1 
and LBX boards
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11 Plug the IEX2 board into the LBX board.

12 Use your thumb to snap the IEX2 board onto the two standoffs

13 Determine if an I/E cable is already present and routed, if is present proceed to Step 16 on page 286. 
Otherwise, proceed to Step 14 on page 284. 

14 Connect the I/E cable W6 to the J7 connector on the LBX board.

Note To complete this upgrade procedure, you must replace the existing IEX1 
board with an IEX2 board. A small red label on the IEX2 board 
distinguishes it from the IEX1 board.

red sticker
mounting hole

standoffs

IEX2 board

W6 cableJ7 connector

I/E connection
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15 Route the W6 cable from the LBX board following the door interlock cable to the front of the expansion 
module, allowing the W6 cable to hang near where the I/E station lock assembly will be located.

W6 I/E station cabling

I/E W6 cable and
LBX board
connection 
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16 Use a #2 Phillips screwdriver to replace the top drive cluster cover plate, the mid-module cover plate, 
the bottom drive cluster cover plate, and the LBX/IEX cover plate.

mid-module cover plate

bottom drive cluster
cover plate

LBX/IEX cover plate

top drive cluster
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17 If there is an expansion module immediately to the right of the expansion module you are upgrading, 
open its access door for clearance. 

18 To avoid scratching the new access door on the door latches of the expansion module to the right, use 
a 3 mm hex wrench to remove the four door latches.

top latches

bottom latches
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19 To lighten the weight of the access door you are replacing, uninstall the magazines prior to removing 
the door.

20 If a 24-slot I/E station exists, disconnect the I/E station cable from the I/E lock and release the cable 
from the Velcro straps securing it to the cable carrier.

21 Use the supplied hex wrench to remove the two screws that secure the flex cable bracket to the top of 
the expansion module. The flex cable bracket will not be used with the 72-slot I/E station upgrade.

CAUTION
Use caution when removing the screws securing the spring-loaded 
flex cable bracket.

W6 cable

2 screws 2 screws
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22 On only the access door side, detach both the top and bottom door dampers. Slide the small flat-head 
screwdriver into the space under the spring clip of each damper and lift the spring clip to release the 
damper from the ball joint. 

23 Place the foot jack in front of the expansion module being upgraded. The right side of the foot jack 
should be in the down position which will allow it to pass under the access door

24 Close the door to a 45 degree angle and press one foot downward on the foot jack while carefully 
supporting the access door.

25 To raise the door off the hinge pins, gently swivel the access door clockwise and lift the door free.

26 Properly discard the old access door.

27 Carefully lift the new access door from the crate and position it in front of the expansion module at a 45 
degree angle.

28 Lift and mount the door onto the hinges.

29 Verify the door is seated upon all three hinge pins.

30 Reattach the two door dampers. For each damper, press the damper onto the ball joint. 

31 Install the twelve supplied magazines into the storage area beneath the 72-slot I/E station opening.

32 Install the two calibration targets on the storage magazines beneath the 72-slot I/E station opening. 

• Column 2, section 8

• Column 2, section 10

CAUTION
Removing the access door requires two people. The access door is 
heavy and may become unstable after it is freed from the hinge pins. 

Note Be careful when handling the door to avoid damaging its plastic cover (skin).

insert small flat-head
screwdriver in opening
and lift to release damper
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33 Mount the IEM1 circuit card onto the access door filter bracket and snap it over the four pegs on the 
bracket.

34 Use a 2.5mm hex wrench to install the M4x10 screw to secure the IEM1 card in place.

35 Insert the I/E cable into the slit of the protective cable sheath. Bend the cable sheath away from the I/E 
cable and gently press the cable into the sheath. 

36 Drape the I/E cable (W6) over the top damper and insert the cable’s connector into the top connection 
on the IEM1 card until it snaps into place.

37 Use a 2.5 mm hex wrench to secure the I/E cable to the door using a P clamp. 
Place the P clamp around the cable (not the sheath) and secure it to the upper damper bracket 
mounting hole.

38 Place the second P clamp around the I/E cable and secure it to the carrier bracket in the roof of the 
expansion module using a 2.5 mm hex wrench to install one screw to the right of the vacant cable carrier 
screw holes.

39 With the access door fully open, verify that the I/E cable has a small amount of slack.  
When the access door is closed the slack from the I/E cable forms a "U" shape and protrudes toward 
the firewall. See the following illustration.

40 Close the access door.

41 From an adjacent module, view the I/E cable and verify that the I/E cable is within 12.7mm (1/2 inch) 
from the frame cable bracket’s main surface and that the cable is flush within +/- 12.7mm from the edge 
of the frame cable bracket. See the following illustration.

M4x10 screw

roof p-clamp

p-clamp
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42 From inside the access door of the expansion module you are upgrading, position the I/E station so that 
its bottom edge rests on the bottom of the opening in the access door. 

43 Align the I/E station side flange mounting holes with those on the access door.

44 After testing the cable clearance, open the access door.

45 To initiate securing the I/E station to the door frame before mounting it to the door, use a 2.5 mm hex 
wrench to insert (do not tighten) the eight screws in the door.

Note To avoid scratching or damaging the I/E stations handle them with care.

"U" protrusion
small amount of slack

cable bracket’s main surface

edge of frame cable bracket
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46 After inserting the screws, tighten the screws to ensure the bottom edge of the shroud is flat against the 
cross bar of the door opening. Make certain there is no gap.

47 Repeat Step 40 through Step 45 to install the second I/E station.

Make certain bottom edge 
shroud is flat against the cr
bar and there is NO gap
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48 On the left I/E station door, attach the 12-pin connector end of the cable to the door lock connector and 
the 10-pin cable connector into IEM1 card.

49 On the right I/E station door, connect the 12-pin connector end of the cable to the door lock connector 
and the 10-pin connector end to the IEM1 card.

50 On the I/E station closest to the door hinge, tuck the cable behind the door gasket flange.

51 Open and close each I/E station door to ensure proper alignment. If the doors are not opening and 
closing properly, return to Step 42 on page 291. 

10-pin connector

12-pin connector

12-pin connector

10-pin connector

W6 I/E cable
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52 Install the supplied magazines into each of the I/E stations. 

53 Using a 3 mm hex wrench to reinstall the access door latches of the expansion module to the right of 
the new access door. Make certain the latches are positioned correctly.

storage

I/E station magazines

Top two

bottom 2 latches

latches have 
rollers pointing
down

have rollers pointing
up
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54 Close the I/E stations and all access doors.

55 Press the Power switch on the operator panel.

56 Log on to the library as a service user. See the Scalar i2000 / i6000 Maintenance Guide.

57 From the LMC, run Configure by clicking Tools→ Teach→ Configure.  
See the Scalar i6000 User’s Guide for more information.

58 After completing the configure process, run Calibrate click Tools→ Teach→ Calibrate. 

59 Run a complete Install Verification Test est to verify proper installation by clicking Tools > Verification 
Tests > Install. The results appear on the Verification Tests dialog box after the test is complete.

60 If using Auto Teach, make certain to turn this feature back on.

61 You must modify and configure any existing partitions that include resources altered or removed by the 
change in the expansion module physical configuration to incorporate the new I/E station. 

In the LMC, click Setup→ Partitions→ Configure to modify partitions and create new ones.  
See the Scalar i6000 User’s Guide for more information about working with partitions.

62 Assign the new I/E station and storage slot in the new access to their appropriate partitions.

63 If the magazines on the access door are assigned to partitions, you must import all the cartridges you 
removed from the previous expansion module access door to the appropriate partitions in the new 
access door. 

64 If there is not enough space for all the cartridges from the previous access door due to the larger I/E 
station, reassign the access door’s storage slots to appropriate partitions.

65 If appropriate, perform Partitions Defragmentation. Click Tools→ Partitions Defragmentation. 

The Partitions Defragmentation dialog box appears. This dialog box shows a graphical representation 
of the tape magazines in the library. Magazines are color-coded to indicate which partition they belong 
to. If the library has more than one module, click the arrow buttons to display the next or previous 
module. If one or more partitions are fragmented, you can defragment them. 

66 For more information on the I/E station features, see the Scalar i6000 User’s Guide.
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Adding Aisle Lights

This section describes how to install aisle lights into your i2000 / i6000 library.

Required tools: ESD strap, 7mm nut driver, wire cutters, Phillips #2 screwdriver

1 Shut down the library.

For more information, see Shutting Down the Library on page 232.

2 Open the access door.

Note The aisle light upgrade feature requires certain hardware levels be present in 
the i2000/i6000 library. Not all i2000’s in the install base have the necessary 
hardware features. 
To qualify for the aisle light option, your Control Module serial number in your 
i2000/i6000 library configuration must be at least 203102253 or begin with 
2631xxxxx. 

Any i2000 / i6000 system with the required serial numbers should have the 
proper hardware pre-installed.

Required hardware:

• Threaded studs in frame roof

• LBX2 Gen 2 (blue label) or LBX2 Gen 3 (red label)

If the library you are upgrading does not meet the required hardware criteria, do 
NOT attempt to work around or upgrade the system. Instead, escalate the 
situation through normal escalation paths. The customer must be contacted and 
notified that the system is not compatible with the aisle light feature option.
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3 Attach the ESD strap to your wrist and to an unpainted surface inside the door.

4 Start the nuts onto the threads but do not tighten them down.

aisle light assembly location

 front of library
access door
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5 Slide the aisle light assembly through the keyholes and push toward the front of the library.

6 Using a 7mm nut driver, tighten the 4 nuts snug against the keyholes.

4 nuts

aisle light assembly

keyhole

4 nuts tightened
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7 Route the cable into the P-clamp.

8 Plug the aisle light cable into the aisle light assembly connector.

9 Install the P-clamp to the bolt and partially tighten the nut.

10 Pull any excess aisle light cable through the P-clamp towards the front of library.

11 Completely tighten the P-clamp nut.

12 Run the aisle light cable along top panel of the frame, routing it with any cables that exist, and feed the 
cable through the rear access hole to the back side of the library.

aisle light cable
P-clamp

bolt

nut

aisle light assembly
connector

rear access hole
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13 Remove any cable ties along this route.

14 Install the three zip ties to secure the aisle light cable (and any other cables routed with it) in place along 
the frame.

15 Open the service door.

zip ties

rear access hole
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16 Use a #2 Phillips screwdriver to remove the top drive cluster cover plate, the mid-module cover plate, 
the bottom drive cluster cover plate, and the LBX/IEX cover plate.

17 Complete routing the cable through the back side of the library.

mid-module cover plate

bottom drive cluster
cover plate

LBX/IEX cover plate

top drive cluster
cover plate
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18 Plug the cable’s 1 x 2 connector end into the LBX board connector J19. For more information on the 
LBX board, see LBX Board on page 345. 

aisle light cabling

aisle light cable to
LBX board 

aisle light cable
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19 Use a #2 Phillips screwdriver to replace the top drive cluster cover plate, the mid-module cover plate, 
the bottom drive cluster cover plate, and the LBX/IEX cover plate.

20 Close the service and access doors.

21 Press the Power switch on the operator panel.

22 After the Robotics Enabled Indicator turns solid green, log in to the library.

23 Make sure that you are viewing the physical library. From the View menu, select the name of the 
physical library.

24 From the LMC, select Setup > Aisle Light Settings.

Note To avoid interference with the scanner, the aisle lights are automatically turned 
off whenever the Teach or Inventory functions are used. 
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25 The Aisle Light Settings dialog box appears.  

26 Initially to turn the lights on you must choose either 30 minutes or 1 Hour. If you choose Always Off 
the aisle lights will not come on.

27 Click OK.  
See the Scalar i6000 User’s Guide for more information concerning aisle lights.

28 Visually verify all the aisle lights in your system are on. You can view the aisle lights either through the 
top filter of each access door or you can look down the aisle of the system via the side windows.

29 Open and close any I/E station and verify that the aisle lights shut off automatically when the robot scans 
the I/E station.
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Installation Testing and Verification
This chapter contains testing procedures for performing the following:

• Verifying the Hardware Installation on page 307

• Installation Verification Test Overview on page 309

• Running the Installation Verification Test on page 325

• Completing the Installation Verification Checklist on page 332

Verifying the Hardware Installation

To verify the hardware, follow these steps:

1 Verify that the library is leveled based on the instructions in Installing a Stand-Alone Control Module on 
page 19 and Installing a Multi-Module Library on page 27.

2 Close the access door.

3 Verify that the Robotics Enabled and Status indicators above the Library Management Console (LMC) 
are illuminated in solid green state.

Robotics Enabled
indicator/button

Status indicator

Power indicator/button

touch screen
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4 Log onto the LMC as a service user.

5 Verify that the LMC is displayed and there are no yellow or red sub-system statuses. If there are yellow 
or red statuses, see the Scalar i2000/i6000 Maintenance Guide for corrective procedures.

6 For each partition, verify that all drives are online by performing the following:

 a. From the LMC, select the partition using the view menu.

 b. Click Monitor→ Drives and verify all expected drives are available.

7 From the LMC, click Tools→ Teach to perform a configuration and a calibration on the library.

The Teach dialog box appears. The default choice is Configure. 

8 Click Start.

Once the teach is completed, a message appears in the Results field, for example, “Command 
Completed.”

9 Select Configure and click Start. 

During the calibration teach process, the picker moves to the home position, which is X-Y coordinate 
position 0,0. It then moves to a magazine at the top and a magazine at the bottom on each side of each 
module, and stores those positions in coordinates relative to the 0,0 position. Teach results appear in 
the Results area when the process completes. If the calibration teach process completes successfully, 
the dialog box closes automatically.

Once you have verified the hardware using this procedure, go to the Installation Verification Test Overview 
on page 309 and proceed with those instructions.

If hardware verification indicates problems, consult the troubleshooting procedures in the Scalar i2000/
i6000 Maintenance Guide.
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Installation Verification Test Overview

The installation verification test enables you to verify that the library’s installation and configuration is 
complete and functioning correctly. The installation verification test runs the following individual tests:

• Library alignment test

• Picker assembly test

• I/E station assembly test

• Get/Put test

• Scanner fiducial test

These tests require that you log on as an admin or service user. The accessor assembly must be ready and 
functional, and the library must be powered on. In addition, the library must be in an offline state, and at 
least one scratch tape must be inserted in the I/E station.

The smaller library configuration will require about 1 hour and the larger configurations will require as long 
as 4 hours to run the installation verification test. The time to complete individual tests on an twelve module 
configuration is approximately:

• Library alignment test - 45 minutes

• Picker assembly test - 4 minute

• I/E station assembly test - 7 minutes for each I/E station

• Get/Put test - 2 hours and 45 minutes

• Scanner fiducial test - 75 minutes

Note These times do not include debug or repair time.
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Installation Verification Test Functions
Use the Verification Tests dialog box to run the installation verification test and view results. Figure 25  
shows the parts of the Verification Tests dialog box. To display the dialog box, click Tools→ Verification 
Tests.

Figure 25 Verification Tests Dialog Box

Library Alignment Test
The library alignment test performs the following tasks:

• Performs accessor X-axis and Y-axis travel test (also calls the FRU accessor assembly test)

• Calibrates library and checks calibration offsets by comparing them to the default values for the 
drives and I/E stations

• Checks magazine offsets

• Checks collected offset alignments for magazines, I/E stations, and drive sleds

• Checks joint alignment quality

test results area

selected test

start/stop test

display test logs

close window

view Help window

test report output

library inventory

drive inventory

blade inventory

refresh window
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Get/Put Test
The Get/Put test performs the following tasks:

• Performs a Get/Put of a scratch tape in the top and bottom slots of each magazine that supports 
the scratch tape’s media

• Performs a Get/Put of existing media if no scratch tape is found or if the top or bottom is occupied

• Moves a scratch tape to one row in each frame to test cross-frame alignment

• Uses a scratch tape to perform a Get/Put in each compatible drive

Picker Assembly Test
The picker assembly test performs the following tasks:

• Performs pivot left and right check

• Performs reach and retract five times

• If the LMC gets its side done, performs a Get/Put of the selected cell

• Scans the control module serial number to make sure the scanner is reading properly

I/E Station Assembly Test
The I/E station assembly test performs the following tasks:

• Locks and unlocks I/E station

• Calibrates each I/E station and check offsets collected

• Checks each magazine’s fiducial in the I/E station

• Performs Get/Put tests on all the I/E station cells

Scanner Fiducial Test
The scanner fiducial test performs the following tasks:

• Scans and checks each magazine fiducial

• Scans and checks each drive sled fiducial

• Tests the calibration sensor

• Calibrates and checks repeatability, up to three times for marginal and failed calibration targets

Library Inventory
This inventory list provides the following statistical information:

• Frame card serial numbers

• Power supply serial numbers

• Number of cartridges in the library

• Controller serial number and firmware information for the following:

• Management control blade

• Control management blade

• Robotic control unit or RCU

• Picker
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• I/E stations

Drive Inventory
This inventory list provides the following information about each drive:

• Drive sled locations

• Drive sled controller serial numbers

• Drive sled controller boot and application firmware versions

• Drive brick serial numbers and firmware versions

• Drive logical serial number if the library is configured for logical serial number addressing

Blade Inventory
This inventory list provides the following information about each Fibre Channel I/O blade:

• Location of each blade

• Serial number of the blades
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Test Results
The results of all subtests are displayed on the Verification Tests dialog box after each individual test is 
completed. See Table 11  for an explanation of test results.

Table 11 Test Results 

Test Results Explanation

PASSED Completed the test without reported errors.

MARGINAL Completed the test, but the system had to retry or had to skip part of the test. A 
MARGINAL result is considered PASSED, but the log should be checked to see if 
the marginality can be corrected.

FAILED An error has been found and needs to be corrected. A fatal error, or an error that 
causes a part of the system to become disabled, will halt the test.

INCOMPLETE This portion of a test was incomplete due to an interruption or a portion of the test 
was run (for example, no scratch tape was used so must only use existing tapes). 
An incomplete will occur when the door is opened, an abort command is issued, or 
when the Robotics Enable button is pressed.

SKIPPED This portion of the test was skipped. The cause is that either a scratch tape was 
not present or the library was not configured for the test.

WARNING A warning is additional information about the test that the user should know. For 
example, if a calibration failed, but the stored offsets are analyzed, a warning 
should be posted that states that the offset check might not be accurate.

STOPPED The test was interrupted. The log will show the result to provide a record of test 
interruption.

Note A single problem in the library can cause failed results in multiple tests. After 
taking action to correct a failed result, run tests that yielded marginal or failed 
results again.
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Verification Test Graphical Reports
Verification tests produce graphical reports that let you easily see if the test generated passed, marginal, or 
failed results. Each result is shown in a different color:

• P - passed (green)

• M - marginal (yellow)

• F - failed (red)

There are eight types of graphical reports. Each individual test generates two or more graphical reports 
(except for the scan barcode test, which does not generate graphical reports). The following sections show 
an example of each type of graphical report and actions to take to correct a marginal or failed result.

To view the graphical reports for a test, click Reports on the Verification Tests dialog box. Figure 26  
shows the parts of the report window.

Figure 26 Report Window

graphic showing P 
(passed), M (marginal), 
and F (failed) results

click to view the text log

click to close the report 
window
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click to save a copy of 
the results in PDF format

click to display results 
for a previously run test 
(results for the last five 
tests are retained)

click to view Online 
Help
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Joint Alignments
The joint alignment graphical report shows the results for tests of alignment between frames. It also shows 
the results for tests of accessor travel to all corners of the library.

• If the graphical report shows one or more failed results for joint alignment, realign the middle X-axis 
rail and check the alignment of the top and bottom X-axis rails at the location of the failure.

• If all the joints passed testing but accessor movement failed, manually move the accessor down the 
aisle in each direction to locate any places where motion of the accessor is not smooth or is 
restricted. Then realign the middle X-axis rail and check the alignment of the top and bottom X-axis 
rails at the location of the failure.

Figure 27 Joint Alignments Graphical Report
Scalar i6000  Installation Guide 315



Vertical Alignments
The vertical alignments graphical report shows the results for test of vertical alignment of tape magazines 
on the drive-side and door-side of each frame, and for vertical alignment of each I/E station.

• If the graphical report shows a failed result for the drive-side or door-side, make sure that all tape 
magazines are installed properly on that side and that the calibration targets are correctly snapped 
on to the magazines.

• If the graphical report shows a failed result for the I/E station, make sure the I/E station and front 
door are completely shut.

• If running the test again still generates failed results, realign the middle X-axis rail and check the 
alignment of the top and bottom X-axis rails at the location of the failure.

Figure 28 Vertical Alignments Graphical Report
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Horizontal Alignments
The horizontal alignments graphical report shows the results for tests of horizontal alignment of tape 
magazines on the drive-side and door-side across frames, and for horizontal alignment of I/E stations 
across frames.

• If the graphical report shows a failed result for the drive-side or door-side, make sure that all tape 
magazines are installed properly on that side and that the calibration targets are correctly snapped 
on to the magazines.

• If the graphical report shows a failed result for the I/E station, make sure the I/E station and front 
door are completely shut.

• If running the test again still generates failed results, realign the middle X-axis rail and check the 
alignment of the top and bottom X-axis rails at the location of the failure.

Figure 29 Horizontal Alignments Graphical Report

Note This graphical report is not generated for libraries with only one frame.
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Calibration Offsets
The calibration offsets graphical report shows the results for tests of tape magazine, drive sled, and I/E 
station offsets compared to predefined tolerances. Reports are generated for drive-side and door-side for 
all frames.

• If the graphical report shows a failed result for one or more tape magazines, make sure the 
magazines at the location of the failure are installed properly and that the calibration targets are 
correctly snapped on to the magazines.

• Make certain the magazines are fully seated in the I/E station.

• If the graphical report shows a failed result for the I/E station, make sure the I/E station and front 
door are completely shut.

• If running the test again still generates failed results, realign the middle X-axis rail and check the 
alignment of the top and bottom X-axis rails at the location of the failure.

Figure 30 Calibration Offsets Graphical Report
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Boundary/Accessibility
The boundary/accessibility graphical report shows the results for tests of the accessor while performing get, 
put, and scan functions for all tape magazines and drive sleds. (This tests whether magazines and sleds 
are within the maximum allowable movement range of the accessor.)

• If the graphical report shows a failed result for one or more tape magazines, make sure the 
magazines at the location of the failure are installed properly and that the calibration targets are 
correctly snapped on to the magazines.

• If the graphical report shows a failed result for the I/E station, make sure the I/E station and front 
door are completely shut.

• If running the test again still generates failed results, realign the middle X-axis rail and check the 
alignment of the top and bottom X-axis rails at the location of the failure.

Figure 31 Boundary/Accessibility Graphical Report
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Get/Put
The Get/Put graphical report shows the results for tests of the picker assembly while performing one get 
and one put function for each tape magazine. The picker will use the selected scratch tape or the existing 
tape if it finds one at the target.

• If the graphical report shows a failed result for one or more tape magazines, make sure the 
magazines at the location of the failure are installed properly.

• If there are multiple marginal results in an area, review the area to make sure it is not prone to 
problems. Also run the library alignment test (part of the installation verification or partial frame test) 
to make sure the library properly aligned.

• If there are a large number of issues, use rubbing alcohol to clean the picker fingers and the detents 
in the side of the tapes.

• If the problems persist, you may need to replace the picker assembly.

Figure 32 Get/Put Graphical Report
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Scan Fiducials
The scan fiducials graphical report shows the results for tests of the fiducial barcode on each tape magazine 
and drive sled, including the width, expected Y position (shift), and the number of hits the scanner receives 
while traveling up and down. (Only known magazines are tested.)

• If the graphical report shows a failed result for one or more tape magazines, replace the affected 
magazines.

• If there are multiple marginal or failed results, run the library alignment test (part of the installation 
verification or partial frame test) to make sure the library properly aligned.

• If the library is aligned and there are multiple marginal or failed results, the scanner should be 
inspected and replaced if necessary.

Figure 33 Scan Fiducials Graphical Report
Scalar i6000  Installation Guide 321



Picker Pivot/Reach
The picker pivot/reach graphical report shows the results for tests of the picker while performing rotation and 
reach/retract actions.

• If the graphical report shows one or more marginal or failed results, inspect the picker. It should 
rotate easily by hand, and the fingers should spring into a clamped position. Make sure both rotation 
axis belts are free of debris. Also make sure that the storage is correctly seated in the I/E station 
and that the I/E station and front door are completely shut.

• If the problems persist, you may need to replace the picker assembly.

Figure 34 Picker Pivot/Reach Graphical Report
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Verification Test Logs
Each verification test produces a test log that details all information and results from the individual tests and 
subtests. In addition, the log includes information to help you understand the test results and to help resolve 
any problems encountered. To view a test log, click Reports on the Verification Tests dialog box to display 
the report window, and then click the Text tab.

You can view results for the five most recent tests. Click Reports, and then click the test results you want 
to view.

This log file is appended with data as each test finishes. You can repeat the test if any problems are found 
and fixed. If the Verification Tests dialog box was not closed during the retesting, all results are contained 
in one log file.

To save the information that the test generates, click Send. If you are using the remote LMC client, you can 
choose to save the log to your hard drive. If you choose to save directly to your hard drive, the report listing 
and test log are combined into one text file.

Figure 35  shows an example of a test log. It provides the following information:

• The test output is from the library alignment test.

• The test title is always shown between rows of equal signs.

• A brief guide for understanding coordinates and offsets used in the test results is provided near the 
beginning of the log.

• The X-axis and Y-axis limits applied by this test are shown. MARGINAL output is placed between 
parentheses, and FAILED output is placed between brackets; for example, (30) and [45].

• The results of the subtest are displayed between dashed lines.

• Coordinates are represented as A (aisle), F (frame), R (rack), S (section), C (column), and R (row).

• All location values are in 0.1 mm.

• All results that you should review are identified with four arrows (>>>>) in the column to the left of 
the detailed results.

• At the end of every test, summary results of every subtest are given. The overall test result is 
displayed between asterisk lines, and a summary of subtest results follows. SeeTable 11 on page 
313 to determine the meaning of the results.
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Figure 35 Example Test Log Output
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Running the Installation Verification Test

When the installation verification test is running, no one else can log on to the library. The message, 
"Verification Test is Running," is displayed in the Activity area of the main LMC display.

1 Log on as an admin or service user.

2 Make sure that you are viewing the physical library. From the View menu, click the name of the physical 
library.

3 Click Tools→ Verification Tests.

The Verification Tests dialog box appears.

4 From the Select Test drop-down list, click Install.

5 Click Start.
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6 If prompted to take the library offline, click Yes.

The IVT Pre-Test Questionnaire appears.

7 Complete the pre-test questionnaire by clicking inside the box next to the questions.

You cannot continue with the installation verification test until you have completed and verified the 
question requests on this questionnaire.

Note Make sure you physically verify each of the questions on the questionnaire. 
Each of the items listed can cause the installation verification test to have 
unexpected behavior and unreliable results. The tests must be re-run if 
they fail.
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8 After you complete the questionnaire, click Next.

The following dialog box appears.

9 Insert a “scratch” cartridge into the I/E station, and then click Next.

The I/E station will be locked until the inventory is complete.

Note • Make sure that your scratch tapes are formatted and contain no data that 
cannot be overwritten. Scratch tapes must have barcode labels with valid 
volume serial (volser) numbers on them. Also, you might find it useful to 
write down the volser number so that you can identify your scratch tapes.

• This procedure will not damage any cartridges that are already installed 
in the library. You can load both LTO and DLT scratch cartridges if your 
library has mixed media.

• If the scratch cartridge becomes lodged in a drive or magazine, it must be 
manually removed from the library. If not removed, the cartridge will 
become part of the partition the next time the accessor assembly is 
enabled.
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10 Select a “scratch” cartridge of each media type listed on the following dialog box.

Note You can select one “scratch” cartridge per media type. Each test that 
requires a scratch cartridge will call the media types as needed.
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11 After you select the cartridges, click Finish.

As the tests run, the library will generate RAS tickets if problems are discovered. You must close the 
Verification Tests dialog box to view those tickets. Return to the Verification Tests dialog box to view 
test results.
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12 After the test is complete, click Reports to view the test results.

The report window appears with the Graphical tab displayed. Use the Graphical tab to view graphical 
reports and to quickly identify areas where marginal or failed results occurred.

Use the toolbar to navigate between graphical reports or to save the results in PDF format. For more 
information about how to work with graphical reports, see Verification Test Graphical Reports on page 
314.
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13 For more detailed test results, click the Text tab to view the test log generated by the LMC.

Review the test log to find marginal or failed test results, and to see troubleshooting information. To  
e-mail the test log or save it as a text file, click Send and then specify the output location. For information 
about how to interpret and save test logs, see Verification Test Logs on page 323.

14 To see the results for a previous test, click Reports, and then click a test. The LMC saves the most 
recent five test results.

15 When you are done working with the test results, click Close to close the result window.

If you are done performing verification tests, click Close to close the Verification Tests dialog box.
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Completing the Installation Verification Checklist

This Installation Verification checklist provides a convenient way to review the configuration of the library 
and, in some cases, document the settings as configured. Before leaving the site, perform the following 
checklist in the following sequence. Most of these procedures are performed in the Library Management 
Console (LMC).

❑ Verify that the proper library system firmware level and drive brick firmware level are loaded on the library. 
Review the Quantum Support site for current releases at www.quantum.com/osr/.

❑ Review all Tech Bulletins and Release Notes applicable to the firmware being loaded or running on the 
library. 

❑ Verify that there are no subsystems with a Failed, Degraded, or Warning status. If there are, open the 
RAS ticket and resolve according to the repair instructions.

❑ Verify all physical components, connections, and cabling.

• Visually inspect connections to ensure all cables are fully plugged in.

• Check the status and connection LED's on all blades to ensure proper functionality and 
connectivity

• Ensure power has been applied to all components.

• Ensure there are no RAS “amber” LEDs flashing or solidly lit indicating component error.

❑ Verify proper network configuration. 

1 Click Setup→ Network Configuration and verify all entries.

• Under Host Settings:

• DHCP Enabled OR Disabled per customer network ________________

• Library Name ________________

• IP Address ________________

• Subnet Mask ________________

• Default Gateway ________________

• Under Port Settings

• Auto Negotiate ________________

• Speed ________________

2 Have the customer system administrator ping the library. 

• From within the subnet

• From outside the subnet
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❑ Verify the proper Time and Date is established within the library. Click Setup→ Date and Time. The 
following entries are visible from this screen:

• NTP Setting ________________

• Server Address 1 ________________

• Server Address 2 ________________

• Date ________________

• Time ________________

• Time Zone ___________________

❑ Verify proper e-mail configuration. 

1 Click Setup→ Email Configuration to verify that the e-mail server is configured correctly.

2 Click Setup→ Notification. Each Severity has an associated list of addresses to send automatic 
notification messages. Severity 1 should contain techsup@quantum.com and any customer specified 
addresses. Severity 2 – 3 are optional and can be disabled in certain library firmware levels. (Note: 4 
columns are provided for convenience, there is no requirement for or limitation to 4 entries).

3 Send an e-mail to an address specified by the customer system administrator to confirm end-to-end e-
mail functionality. Go to Monitor→ System. Select Send and type in the e-mail address.

❑ Verify that the Physical Library is properly set up. The library’s default configuration is to Disable 
Automatic Teach and Automatic Inventory. This setting is recommended to save start up time during a 
library power on or a Robotics Enable. If a customer will be routinely performing bulk load operations or 
removing/installing media without using the I/E station, it is recommended that Automatic Inventory be 
enabled.

• Automatic Teach _____Enable______Disable

• Automatic Inventory_____Enable______Disable

• Logical SN Addressing_____Enable______Disable

• Automatic Drive Unload_____Enable______Disable

Table 12 Automatic E-mail Notification 

Severity e-mail 1 e-mail 2 e-mail 3 e-mail 4

1 techsup@quantum.com

2

3
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❑ Verify that all licenses installed per the customer's order are properly functioning. Click Setup→ 
Licenses. (Note: four licenses are listed for convenience, there is no requirement for or limitation to four 
entries).

❑ Verify partitioning. Click View, then select the partition you want. Verify that the information displayed for 
each Library Partitioning are correct. Make sure the partition’s status field states “Online.”

Table 13 Customer License Verification

License Key Feature Name Status Expiration

Table 14 Library Partitioning

Library Number of Drives Drive Type Number of Storage Cells I/E

Physical Library

Partition 1

Partition 2

Partition 3

Partition 4

Partition 5

Partition 6

Partition 7

Partition 8

Partition 9

Partition 10

Partition 11

Partition 12

Partition 13

Partition 14

Partition 15

Partition 16
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❑ Verify all FC I/O blade port configurations. Click Setup→ Connectivity→ Port Configuration. Select 
each installed FC I/O blade and one of the 6 ports. All FC I/O blades have the same port settings, as shown 
in Table 15 .

❑ Verify that the physical library and all partitions are online.

• In the LMC, click Operations→ Change Mode and verify that Online is selected. Repeat this for 
each partition that was created.

❑ Verify Host Type Settings.

• In the LMC, click Setup→ Device Access→ FC host and then click Host Type to verify the values.

❑ Verify all Host LUN Mapping.

• In the LMC, click Setup→ Device→ Access→ FC Host, and then click LUN Mapping to verify the 
values.

❑ Verify proper switch zoning, if one or more are connected to the library.

❑ Verify the host bus adapter (HBA) configuration and port settings on the host(s).

❑ Verify that the Media Changer and Devices appear in the device list for each host.

❑ Save the library’s configuration file onto a remote computer running the remote LMC client.

Table 15 FC I/O Blade Default Port Settings

Port Loop ID Speed Frame Size Port Mode Connection 
Option Private/Public

FC-1 Soft Auto 2048 Target Loop preferred Public

FC-2 Soft Auto 2048 Target Loop preferred Public

FC-3 Soft Auto 2048 Initiator Loop preferred Public

FC-4 Soft Auto 2048 Initiator Loop preferred Public

FC-5 Soft Auto 2048 Initiator Loop preferred Public

FC-6 Soft Auto 2048 Initiator Loop preferred Public
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Perform the following steps after verifying configuration and connectivity:

1 Store both library door keys for each module in a safe location. There is the key that opens the access 
and service doors (FRU ID 401) and the key that opens only the service door (FRU ID 402). The key 
that opens the access door should be given to the system administrator to load the storage racks with 
cartridges. The key that opens the service door should be given to the operator to reconfigure the 
library.

2 Store the library tools, manuals, and miscellaneous items (for example, tools and spare fuse box). Keep 
them available for service activity.

Note The access door key works on the access and service door, the service door 
key works only on the service door.
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Testing and Calibrating the Digital Level 
This appendix provides step-by-step instructions for performing the following:

• Testing the Digital Level on page 337

• Calibrating the Digital Level on page 339

Testing the Digital Level

Perform this test before each use of the Pro 3600 digital level and any time the digital level has been 
dropped or is being used in an environment that varies ±9°F from the environment in which it was last 
calibrated. If the digital level fails the accuracy test you must recalibrate the level before use.

Follow this procedure to test the digital level:

1 Turn on the level by pushing the ON/OFF button. Position the level with the display facing you and the 
text on the face of the level right-side up. Ensure that the level is on a clean, flat, and horizontal surface. 
This surface does not have to be exactly level. Wait 10 seconds for the level to completely settle and 
take note of the angle on the display.
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2 Rotate the level end-for-end so the display is facing away from you. The screw on the back of the level 
should be on the left side. Be sure to set the level in the exact spot as in Step 1. Wait 10 seconds for 
the level to completely settle and take note of the angle on the display.

3 Roll the level toward you so that the display is facing you, but the lettering on the face of the unit is 
upside down. Be sure to set the level in the exact spot as in Step 1 on page 337. Wait 10 seconds for 
the level to completely settle and take note of the angle on the display.

4 Rotate the level end-for-end so the display is facing away from you. The screw on the back of the level 
should be on the right side. Be sure to set the level in the exact spot as in Step 1 on page 337. Wait 10 
seconds for the level to completely settle and take note of the angle on the display.

5 Compare the level display readings that you captured from Step 1 through Step 4. If any of the four 
readings vary from one another more than 0.1 degree, you must recalibrate the level. For more 
information, see Calibrating the Digital Level on page 339. If the variance between the readings are 
within the 0.1 degree limit, the level is within compliance and is ready to be used.
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Calibrating the Digital Level

This section describes how to calibrate the Pro 3600 digital level.This procedure re-calibrates the level 
through its entire 360 degree range by recording four horizontal and four vertical settings. You should 
perform this procedure whenever the accuracy test shows a variance larger than ±0.1 degree.

Follow this procedure to calibrate the digital level:

1 Turn on the level by pushing the ON/OFF button. Place the level on a flat surface free of dust or debris. 
You can use any horizontal surface within 10 degrees of level and any vertical surface within 10 degrees 
of plumb to perform the calibration. You must use the same surface(s) throughout the entire calibration 
process. If at any time the calibration process fails or will not continue, you can turn the level off and on 
and then restart the calibration procedure from Step 2.

 

2 Press and hold the HOLD and ALT ZERO buttons simultaneously until SUP is displayed; this usually 
takes three seconds. Release the buttons once SUP is displayed. SUP will display for a few seconds 
and then the [ 0 ] is displayed. The level is now ready to be calibrated.

Note Each time you position the level during the calibration process, wait a minimum 
of 10 seconds before pressing the HOLD button to advance to the next step. 
Also ensure that the level is placed in the same position each time it is moved. 
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3 Place the level so that the display is facing you and lettering on the face of the level is right-side up. 
Mark the position of the level so you can place the level back in the same spot when you move it during 
this calibration process. Wait 10 seconds for the level to completely settle. Without moving the level, 
gently press the HOLD button until [ 1 ] appears on the display.

4 Rotate the level so that it faces away from you and the screw on the back of the level is on the left side. 
Ensure that the level is positioned in the same spot as Step 3. Wait 10 seconds for the level to 
completely settle. Without moving the level, gently press the HOLD button until [ 2 ] appears on the 
display.

5 Roll the level towards you so the display is facing you but the lettering on the face of the level is upside 
down. Ensure that the level is positioned in the same spot as Step 3. Wait 10 seconds for the level to 
completely settle. Without moving the level, gently press the HOLD button until an upside down [ 3 ] 
appears on the display.
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6 Rotate the level so that it faces away from you and the screw on the back of the level is on the right side. 
Ensure that the level is positioned in the same spot as Step 3. Wait 10 seconds for the level to 
completely settle. Without moving the level, gently press the HOLD button until an upside down [ 4 ] 
appears on the display. At this time, all of the horizontal calibration settings are done.

7 Stand the level on its end so the display is facing you and the text on the face of the level can be read 
from bottom to top. Mark the position of the level so you can place it in the same spot when you move 
it during this vertical calibration process. Wait 10 seconds for the level to completely settle. Without 
moving the level, gently press the HOLD button until a [ 5 ] appears on the display.
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8 Turn the level around so the display is facing away from you and the screw on the back of the level is 
at the top. Ensure that the level is positioned in the same spot as Step 7. Wait 10 seconds for the level 
to completely settle. Without moving the level, gently press the HOLD button until a [ 6 ] appears on the 
display.

9 Rotate the level end-for-end so the display is facing you and the text on the face of the level can be read 
from top to bottom. Ensure that the level is positioned in the same spot as Step 7. Wait 10 seconds for 
the level to completely settle. Without moving the level, gently press the HOLD button until a [ 7 ] 
appears on the display.
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10 Turn the level around so the display is facing away from you and the screw on the back of the level is 
at the bottom. Ensure that the level is positioned in the same spot as Step 7. Wait 10 seconds for the 
level to completely settle. Without moving the level, gently press the HOLD button until an [ 8 ] appears 
on the display. If this last step is performed correctly the [ 8 ] will display for a short amount of time and 
then the level will display the current angle measurement that it detects. The level is now calibrated and 
is ready for use.
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LBX Board and Terminator
This appendix describes the LBX board and terminator.

LBX Board

A module may contain one of three versions of the LBX board shown in Figure 36. 
For information on the LBX terminator, see LBX Terminator on page 349.

• Library configurations of four modules or fewer may contain LBX2 Gen 1 or Gen 2 boards.

• Library configurations of five to eight modules must contain LBX2 Gen 2 boards.

• Library configurations of nine to twelve modules:

• Modules one through seven must contain LBX2 Gen 2

• Modules eight through twelve must contain LBX2 Gen 3

• If you are adding one or more expansion modules to an existing eight-module library, and the LBX 
board is an earlier version, you must remove the LBX board from expansion module seven (position 
eight) and replace it with the new version, LBX2 Gen 3. 

For instructions on removing and replacing the LBX board and terminator, see the Scalar i2000/i6000 
Maintenance Manual.

Note Red stickers identify the LBX2 Gen 3 board required in the expansion 
modules added to a library configuration greater than eight modules.
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Figure 36 Comparison of LBX Board Versions

note connector position

blue label
on both connectors

connector rotated 90°

LBX2 Gen 01 LBX2 Gen 2

LBX2 Gen 3

J19 rotated and moved beside connector J9

red label
on both connectors
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Figure 37 LBX Connections (LBX2 Gen 2)

connector: J14
plug: W3 to lower drive cluster

connector: J1 
plug: W1 to BPI or
from previous LBX

connector: J4 
plug: W2 to BPI or
from previous LBX

connector: J8 
plug: IEX board 

connector: J15
plug: W3 to upper drive cluster

connector: J11

connector: J7
plug: W6 to I/E station

plug: W15 to door interlock

connector: J10
plug: W11 to I/O management unit;

connector: J16 
plug: W16 to I/O management unit

connector: J13
plug: W7 to I/O management unit;

connector: J9 
plug: W5 to power enclosure

connector: J2
plug: W1 to LBX extended

connector: J3 
plug: W2 to J4 of next LBX

connector: J17 
plug: LBX terminator 

CAN interface

Ethernet

connector: J19
plug: aisle light
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Figure 38 LBX Connections (LBX2 Gen 3)

connector: J14
plug: W3 to lower drive cluster

connector: J1 
plug: W1 to BPI or
from previous LBX

connector: J4 
plug: W2 to BPI or
from previous LBX

connector: J8 
plug: IEX board 

connector: J15
plug: W3 to upper drive cluster

connector: J11

connector: J7
plug: W6 to I/E station

plug: W15 to door interlock

connector: J10
plug: W11 to I/O management unit;

connector: J16 
plug: W16 to I/O management unit

connector: J13
plug: W7 to I/O management unit;

connector: J9 
plug: W5 to power enclosure

connector: J2
plug: W1 to LBX extended

connector: J3 
plug: W2 to J4 of next LBX

connector: J17 
plug: LBX terminator 

CAN interface

Ethernet

connector: J19 
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LBX Terminator

For information on the LBX board, see LBX Board on page 345. For information on interpreting the LBX 
terminator LEDs, see Interpreting LBX Terminator LEDs on page 362

Figure 39 Comparison of LBX Terminator Versions

Figure 40 LBX Board and Terminator Installed

Note • Any LBX board version LBX2 Gen 1 located in the last module in the library 
must be terminated using LBX terminator version 01 shown in Figure 39.

• Any LBX board version LBX2 Gen 2 located in the last module in the library 
must be terminated using LBX terminator version 03 shown in Figure 39.

• Any LBX board version LBX2 Gen 3 located in the last module in the library 
must be terminated using LBX terminator version 03 shown in Figure 39

Version 01 Version 03

LBX board

LBX terminator
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Interpreting LED Codes
Blade status and Fibre port link LEDs can provide you with useful information to help you assess the state 
of a library component. The primary library LEDs can be broken down into four groups based on behavior. 
LEDs can help you assess the state of a library component. The primary library LEDs can be grouped as 
follows:

• Interpreting Blade Status LEDs on page 351

• Interpreting Drive Status LEDs on page 354

• Interpreting Fibre Port Link LEDs on page 356

• Ethernet Expansion Blade LEDs on page 359

• Interpreting MCB Port LEDs on page 360

• Interpreting LBX Terminator LEDs on page 362

• Interpreting Power Supply LEDs on page 364

Interpreting Blade Status LEDs

Each of the following library blades has a set of green, amber, and blue LEDs that indicate blade processor 
status, health status, and power control status:

• Management control blade (MCB)

• Control management blade (CMB)

• Fibre Channel (FC) I/O blade

• Robotics control unit (RCU)

• Library motor drive (LMD)
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Figure 41 shows the locations and colors of the status LEDs of the five blades that can be in the library.

Figure 41 Locations and Colors of Blade Status LEDs

Blade status LEDs provide troubleshooting information that you can use in conjunction with tickets that the 
library creates. However, the LEDs might not directly correspond to tickets. The LEDs can indicate a 
firmware or hardware problem so severe that the library cannot create or display a ticket. For example, if 
the MCB firmware becomes inoperable, the amber LED flashes at 1 Hz, but the library might not be able to 
display any related tickets.

For a description of each LED color and what its state might mean, see Table 16. For a description of how 
the blade status LEDs appear under normal conditions, see Table 17.

Table 16 Explanations of Blade Status LED States 

LED Color Represents Possible States and Explanations

Green Processor status • Solid off — blade’s main processor is not operating (or blade 
is booting)

• Solid on — blade’s main processor is not operating 
(however, this does not apply to the LMD; solid on indicates 
that the LMD’s main processor is operating normally)

• Blinks one time every second (1 Hz) — blade’s main 
processor is operating normally

• Blinks 10 times every second (10 Hz) — identify mode
• Solid on for three seconds, then blinks twice at 1 Hz, and 

then repeats — blade firmware is downloading

blade LEDs
- left = green
- middle = amber
- right = blue

blade LEDs
- left = blue
- middle = amber
- right = green

management control blade
robotics control unit
library motor drive

control management blade
FC I/O blade
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Actions Based on LED States
When the RAS system is operating properly, service actions should be based on tickets first and foremost. 
However, some situations occur when the amber LED indicates problems that are not detected by the ticket 
system. You should always act on any amber LED that is solidly on, which indicates that the blade’s power 
and control subsystem has failed. In this case, replace the blade.

When you replace a blade FRU or escalate a problem based on LED states, perform the following steps:

1 Observe and report the timing pattern of the blue, amber, and green LED group. Spend at least 30 
seconds observing the LEDs and record the results in the service request (SR) and on any equipment 
failure report form that is returned with the part. Proper reporting of all LED states is critical for 
determining the root cause of the failure.

2 Capture a system snapshot and send it to technical support for analysis.

Amber Health status • Solid off — blade’s power and control subsystem is 
operating normally

• Solid on — blade’s power and control subsystem has failed 
 
Solid on also can mean that the blade’s power and control 
subsystem firmware is autoleveling. In conjunction with the 
blue amber LED blinking one time every 10 seconds, this is 
a normal condition. Autoleveling takes about three minutes 
for each blade, and blades within an I/O management unit 
autolevel in series. It can take as long as three minutes for 
the power and control subsystem to download. Never 
remove a blade when the amber LED is solid on unless it has 
been on continuously for at least 10 minutes.

Blue Power control status • Solid off — blade is not receiving power
• Solid on — blade is powered down; ready to be replaced 

(swap mode)
• Blinks one time every 10 seconds (flash) — blade is powered 

on; operating normally

Table 17 Explanations of Blade Status LED States Under Normal Conditions 

LED Color State and Explanation

Green Blinks one time every second (1 Hz) — blade’s main processor is operating normally 
(however, this does not apply to the LMD; solid on indicates that the LMD’s main 
process is operating normally)

Amber Solid off — no errors are detected; blade’s power and control subsystem is operating 
normally

Blue Blinks one time every 10 seconds (flash) — blade is powered on; operating normally

Table 16 Explanations of Blade Status LED States (Continued)

LED Color Represents Possible States and Explanations
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Interpreting Drive Status LEDs

The library reports all drive issues that can affect customer operations. In addition to examining library 
reports, you should observe drive sled link LED and status LED activity.

Figure 42 shows the locations of the status LEDs and the Fibre Channel link LED on the rear of a UDS-2 
drive sled.

Figure 42 Rear View of Fibre Channel Drive Sled (UDS-2)

Note The blinking codes described in Table 18 on page 355 are the same for Fibre 
Channel and SCSI drives in the UDS-2 drive sleds.

Note SDLT-600 Fibre drives do not have a Fibre Channel link LED.

FC link LED

fibre port

- top = blue
- middle = amber
- bottom = green

status LEDs:
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Figure 43 shows the locations of the status LEDs and the Fibre Channel link LED on the rear of a UDS-3 
drive sled.

Figure 43 Rear View of Fibre Channel Drive Sled (UDS-3 LTO-4 and LTO-5 Drives))

Table 18 describes how to interpret the drive sled status LED activity that you might see on the rear of a 
UDS-2 or UDS-3 drive sled. For a description of how the blade status LEDs appear under normal conditions, 
see Table 19 on page 356. For information about interpreting the drive link LED, see Drive Sled Fibre 
Channel Link LED on page 356.

Table 18 Explanations of Drive Sled Status LED States (UDS-2 and UDS-3) 

LED Color Represents Possible States and Explanations

Green Processor status • Solid on / solid off — tape drive’s main processor is not 
operating

• Blinks one time every second (1 Hz) — drive sled’s main 
processor is operating normally

• Two quick blinks within 1.25 seconds; then on solid for 1.25 
seconds; repeat — tape drive sled firmware is downloading

• Three quick blinks within 1.25 seconds; then off for 1.25 
seconds; repeat — tape drive is activating.

• Ten blinks in 1.25 second; then off for 1.25 seconds; repeat 
— tape drive firmware is downloading

• Ten blinks per second — identify mode

Amber Health status • Solid off — drive sled’s controller (drive DC to DC converter 
[DDC]) is operating normally

• Solid on — drive sled’s DDC has failed

- top = blue
- middle = amber
- bottom = green

status LEDs:

fibre ports

1 2
EEB port 

fibre port

LTO-4

LTO-5
Scalar i6000  Installation Guide 355



Interpreting Fibre Port Link LEDs

A fibre port link LED shows the state of the Fibre Channel link and whether the link is ready to transmit 
commands.

Drive Sled Fibre Channel Link LED
The Fibre Channel link LED for a drive sled is located on the rear of the drive sled. Figure 42 on page 354 
shows the location of the Fibre Channel link LED on the rear of the UDS-2 drive sled, and Figure 43 on page 
355 shows the location of the Fibre Channel link LED on the rear of the UDS-3 drive sled.

Table 21 describes how to interpret the Fibre Channel link LED activity that you might see on the rear of the 
UDS-2 drive sled. Table 22 on page 357 describes the Fibre Channel link LED activity on the rear of the 
UDS-3 drive sled.

Blue Power control status • Solid off — drive sled is not receiving power
• Solid on — drive brick is powered down; ready to be 

replaced (swap mode) or varied on
• Blinks one time every 10 seconds (flash) — drive brick is 

powered on; operating normally

Table 19 Explanations of Drive Sled Status LED States Under Normal Conditions 

LED Color State and Explanation

Green Blinks one time every second (1 Hz) — drive sled’s main processor is operating 
normally. The green LEDs for all drive sleds that are operating normally blink together.

Amber Solid off — no errors are detected; drive sled’s controller is operating normally.

Blue Blinks one time every 10 seconds (flash) — drive sled is powered on; operating 
normally.

Table 20 Explanations of Ethernet Port LED States 

LED Color Possible States and Explanations

Green • Solid on — the link is up; data can be sent or received through the Ethernet port
• Solid off — the link is not up; data cannot be sent or received through the Ethernet port

Amber • Flashes at irregular intervals — data activity is occurring through the Ethernet port
• Solid off — no data activity is occurring through the Ethernet port

Note SDLT-600 Fibre drives do not have a Fibre Channel link LED.

Table 18 Explanations of Drive Sled Status LED States (UDS-2 and UDS-3) (Continued)

LED Color Represents Possible States and Explanations
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FC I/O Blade Fibre Port Link LED
The link LED for an FC I/O blade fibre port is located next to the port. On the FC I/O blade faceplate, black 
lines indicate how each link LED belongs to a port. Figure 44 shows the locations of the I/O blade Fibre port 
link LEDs.

Table 21 Explanations of Fibre Drive Sled Link LED States (UDS-2) 

LED Color Represents State and Explanation

Green LIP and 
activity

• Solid on — loop initialization protocol (LIP) has occurred.
• Blinks at irregular intervals — host command/data activity is occurring.

Amber Online and 
light detected

• Solid on — the library has enabled the drive data bus; it can detect light 
through a fiber optic cable.

No color • Solid off — the drive brick is varied off or the drive cannot detect light 
through a fiber optic cable (equivalent to no fibre cable plugged in). If 
the drive brick is varied off, the blue status LED will be solid on.

Table 22 Explanations of Fibre Drive Sled Link LED States (UDS-3) 

LED Color Represents State and Explanation

Green LIP and 
activity

• Solid on — loop initialization protocol (LIP) has occurred.
• Blinks at irregular intervals — host command/data activity is occurring.

Amber Online and 
light detected

• Solid on — the library has enabled the drive data bus; it can detect light 
through a fiber optic cable.

• Blinks at regular intervals — the library has enabled the drive data bus, 
but light is not detected through the fiber optic cable.

No color • Solid off — the library has not enabled the drive data bus or the drive 
brick is varied off. If the drive brick is varied off, the blue status LED will 
be solid on.

Note A UDS-2 drive with no fiber optic cable plugged in is healthy if the link LED is 
solid off. A UDS-3 drive with no fiber optic cable plugged in is healthy if the LED 
is amber and blinking at regular intervals, indicating that the library has enabled 
the drive data bus, but no light is detected.
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Figure 44 Locations and Colors of I/O Blade Fibre Port Link LEDs

Table 23 describes how to interpret the link LED activity that you might see. There are two different models 
of I/O blade: 6404 and 7404. LED behavior varies based on which model is installed in the library.

Table 23 Explanations of I/O Blade Link LED States 

Blade Model Possible Green LED States and Explanations

6404 • Solid on — the I/O blade has established a proper link and is ready to use. The 
blade FC port detects light through the fiber optic cable.

• Blinks slowly — the link is up and currently transporting commands.
• Blinks rapidly — when the I/O blade is beginning to reboot or power up, all I/O blade 

link LEDs, along with the I/O blade’s green status LED, blink rapidly to indicate that 
the blade is starting the Power On Self Test (POST).

• Blinks with other link LEDs in a racetrack pattern — when all of the I/O blade link 
LEDs blink consecutively in a clockwise order, the blade is booting up. This pattern 
stops when the blade is powered and ready. If the pattern doesn’t stop, the blade 
is unable to completely boot up. In this situation, follow the repair page instructions.

• Solid off — the I/O blade does not detect light through the fiber optic cable.

7404 • Solid on — the I/O blade has established a link but is not currently transporting 
data.

• Blinks — the link is active and is currently transporting data.
• Solid off — the I/O blade has not established a link OR the link is active and is 

currently transporting a large amount of data.

Note For the 7404 I/O blade, fibre port LEDs are off while the blade is booting up.

FC I/O blade link LEDs
- left = green (belongs

to port below)
- right = green (belongs

to port above)
358 Interpreting LED Codes



Ethernet Expansion Blade LEDs

The status LEDs for an Ethernet Expansion blade are located at the top of the EEB above ETH 6. Figure 
45 shows the locations of the I/O blade Fibre port link LEDs.

Figure 45Location and Colors of Ethernet Expansion Blade Status LEDs

Table 24 Explanations of Ethernet Expansion Blade LED States 

Blue Green Amber Description

Off Off Off No power

1 Hz Off Off Powered Down - Ready for removal

Off Off On Booting

Flash 1 Hz Off Normal

Flash 10 Hz Off Normal - Identify

Table 25 Explanations of EEB Ethernet Port LED States 

LED Color Possible States and Explanations

Green • Solid on — the link is up; data can be sent or received through the Ethernet port
• Solid off — the link is not up; data cannot be sent or received through the Ethernet port

Amber • Flashes at irregular intervals — data activity is occurring through the Ethernet port
• Solid off — no data activity is occurring through the Ethernet port

EEB LED status

Port LED status
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Interpreting MCB Port LEDs

The MCB has LEDs for the Ethernet, Fibre Channel, and SCSI ports.

MCB Ethernet Port LEDs
The LEDs on the MCB Ethernet port indicate status and activity. Figure 46 shows the locations and colors 
of the MCB Ethernet port LEDs.

Figure 46 Locations and Colors of MCB Ethernet Port LEDs

Table 26 describes how to interpret the Ethernet port LED activity that you might see.

Table 26 Explanations of MCB Ethernet Port LED States 

LED Color Possible States and Explanations

Green • Solid on — the link is up; data can be sent or received through the Ethernet port
• Solid off — the link is not up; data cannot be sent or received through the Ethernet port

Amber • Flashes at irregular intervals — data activity is occurring through the Ethernet port
• Solid off — no data activity is occurring through the Ethernet port

MCB Ethernet
port LEDs
- top = green
- bottom = amber
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MCB Fibre Channel and SCSI Port LEDs
The LEDs for the MCB Fibre Channel and SCSI ports are shown below. Figure 47 shows the locations and 
colors of the LEDs.

Figure 47 Locations and Colors of MCB Fibre Channel and SCSI Port LEDs

MCB port LEDs
- left = green (belongs to

SCSI port below)
- right = green (belongs 

to FC port above)
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Interpreting LBX Terminator LEDs

The LBX terminator has two versions. Version 01 has four LEDs and Version 03 has six LEDs. For more 
information, see LBX Board and Terminator on page 345.

LBX Terminator Version 01 LEDs
The LBX terminator has four green LEDs that indicate the presence of modules in the library. Figure 48 
shows the locations of the LEDs. Table 27 describes how to interpret LED activity on the LBX terminator.

The terminator must be located in the LBX of the last expansion module. The LED status should reflect the 
physical installed module count of the system.

Figure 48 Locations of LBX Terminator LEDs (Version 01)

Table 27 Explanations of LBX Terminator LED States (Version 01) 

LED On/Off Combinations
Explanation

1 2 3 4

Off Off Off Off Robotics are disabled, the access door is open, or the LBX 
terminator is misaligned.

On Off Off Off The library has one control module and no expansion modules.

On On Off Off The library has one control module and one expansion module.

On On On Off The library has one control module and two expansion modules.

On On On On The library has one control module and three expansion modules.

On Off On On The library has one control module and four expansion modules.

On On Off On The library has one control module and five expansion modules.

On Off On Off The library has one control module and six expansion modules.

On Off Off On The library has one control module and seven expansion modules.

1

2

3

4
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LBX Terminator Version 03 LEDs
The LBX terminator version 03 has six green LEDs that indicate the presence of modules in the library. 
Figure 49 shows the locations of the LEDs. Table 28 describes how to interpret LED activity on the LBX 
terminator.

Figure 49 Locations of LBX Terminator LEDs (Version 03)

Table 28 Explanations of LBX Terminator LED States (Version 03) 

LED On/Off Combinations
Explanation

1 2 3 4 5 6

Off Off Off Off Off Off Robotics are disabled, the access door is open, or the LBX 
terminator is misaligned.

On Off Off Off Off Off The library has one control module and no expansion modules.

On Off Off On Off Off The library has one control module and one expansion module.

On Off Off On On Off The library has one control module and two expansion modules.

On Off Off On On On The library has one control module and three expansion modules.

On Off Off Off On On The library has one control module and four expansion modules.

On Off Off On Off On The library has one control module and five expansion modules.

On Off Off Off On Off The library has one control module and six expansion modules.

On Off Off Off Off On The library has one control module and seven expansion modules.

On On Off Off Off Off The library has one control module and eight expansion modules.

On On Off On Off Off The library has one control module and nine expansion modules.

On On Off On On Off The library has one control module and ten expansion modules.

On On Off On On On The library has one control module and eleven expansion modules.

1 2 3 4 5 6
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Interpreting Power Supply LEDs

Power supply problems are reported in tickets. To physically identify a power supply, note the power supply 
number and module number in the ticket details. Modules can have up to two power supplies each. The top 
supply is #1 and the bottom supply is #2.

Figure 50 shows the locations and colors of the power supply LEDs.

Figure 50 Locations and Colors of Power Supply LEDs

Table 29 describes how to interpret LED activity that you might see.

Note The library can be physically configured to include up to eleven expansion 
modules. The first seven expansion modules can contain power supplies if 
drives are present.

Table 29 Explanations of Power Supply LED States 

LED Color Represents Possible States and Explanations

Green
(top LED)

AC OK • Solid on — power supply’s AC input is above minimum requirements 
to operate

• Solid off — power supply’s AC input is below minimum requirements 
to operate

Green
(middle LED)

DC OK • Solid on — power supply’s output voltage is within specifications
• Solid off — power supply’s output voltage is outside of specifications

Blue (bottom 
LED)

Fault • Solid on — indicates any of the following conditions:

•Power supply output is outside of specifications
•Current limit has been exceeded
•Temperature limit has been exceeded
•Fan failed while AC input is present and above minimum operating 

voltage
•AC input is below minimum operating voltage
•PDU is on, but the Power button on the library’s indicator panel is off

• Solid off — no faults are detected

power supply LEDs
- top (AC OK) = green
- middle (DC OK) = green
- bottom (FAULT) = blue
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Glossary
This glossary consists of terms unique to the library along with some storage industry terminology.

Access door 
Refers to the doors on either the control module or expansion module from which you can access the 
magazines and accessor assembly.

Capacity on demand (COD) 
A Scalar library feature that enables users to have a large physical library, but users pay only for what 
capacity they are currently using. License upgrades enable more capacity to be added without a system 
interruption.

Control management blade (CMB) 
A version of the MCB that has no I/O ports for Ethernet, SCSI, serial, or Fibre Channel. It is the controller 
board for the I/O management unit.

Control module  
The first module of the library. It consists of an library management module, cartridges, drives, power, and 
an I/E station.

Data path 
One of the many possible paths that data can move over in the storage area network environment, 
potentially involving many components or connections between initiators and targets that have been set 
since the initial configuration occurred.

Drive pooling 
Drives to be held in a pool (or pools) of drives. You can specify policy settings for the drive pools to configure 
how each pool will react to a drive failure and load balancing.

Drive sled position 
A slot where a Fibre Channel or SCSI drives reside in the control module or expansion module in one of the 
two drive clusters. There are six drive sled positions in each of the two drive clusters.

Encryption Key Management (EKM) 
A generic term used to encompass any encryption key management solution.

 (EEB) 
Provides Ethernet connectivity to 6 Ethernet drives. This connectivity is to the library's internal Ethernet and 
should not be connected to an external Ethernet source.

Expansion module 
Expansion modules enlarge the library configuration by adding modules for additional media storage. You 
can add up eleven expansion modules to a library configuration. The first seven expansion modules may 
contain optional hardware, such as additional drives, I/O blades, and I/E stations.
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I/E station 
A door on the access door of the control module (or expansion modules) that contains magazines into which 
cartridges can be imported into or exported out of the library.

All single door I/E stations are numbered starting with 1 at the control module. All double door I/E stations 
are numbered with a number and a letter—for example 2A and 2B—the module number (1–8), with A as 
the left I/E station and B the right.

I/O management unit 
A management and connectivity interface for the library. The control module and first seven expansion 
modules can have I/O management units installed. The I/O management unit may contain a CMB, FC  
I/O blades and Ethernet Expansion blades. 

Latchhook 
The latches used to lock the printed circuit blades into place when they are inserted into the I/O 
management unit or library management module (LMM).

Library Management Console (LMC) 
The management software client for the library. You can use the LMC either locally from the touch screen 
operator panel on the control module or remotely through a web browser running a Java applet.

Library management module (LMM) 
The connectivity interface for the three blades that provide intelligence and connectivity to the library 
through the control module. The management control blade (MCB), robotics control unit (RCU), and library 
motor drive (LMD) blades are installed in the LMM.

Library management partition (LMP) 
Partition in the i6000 that is like any other partition, except it is not visible to any backup applications or 
hosts. Allows the library to be able to manage the partition, rather than the backup application managing the 
partition. Use the LMP partition as a workspace for library to do value-added features outside environment—
like MeDIA (automated data integrity checking routine).

Linear Tape-Open (LTO) 
A media technology that is open format. LTO comes in two formats, Accelis and Ultrium. Accelis is the fast 
access implementation, while Ultrium is the high capacity implementation.

Management control blade (MCB) 
The library controller board, which resides in the LMM. The MCB has I/O ports for Fibre Channel, Ethernet, 
serial, and SCSI.

Partition 
A partition is a logical portion of the physical library that is viewed by the host as if it is a complete library. 
Partitions present the appearance of multiple, separate libraries for purposes of file management, access 
by multiple users, or dedication to one or more host applications. 

Picker 
The robotic hand portion of the accessor assembly that handles cartridges.

Quantum Encryption Key Manager (Q-EKM) 
Quantum's encryption key management solution that supports IBM LTO-4 and LTO-5 FC tape drives.

Scalar Key Manager (SKM) 
Quantum's encryption key management solutions that supports HP LTO-4 and LTO-5 FC tape drives.

Service door 
The door on either the control module or expansion module that provides access to the I/O management 
unit, LMM, power supplies, drive sleds and other components.

Storage area network (SAN) 
A SAN is a dedicated, high-performance network whose primary purpose is the transfer of data along FC 
or high-speed Ethernet connections between servers, interconnect devices, and storage peripherals.
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Storage networking (SNW) 
A licensable feature that allows you to take advantage of the control path failover and host access 
configuration features of 8 Gbps/LTO-5 tape drives, without those drives being connected to a 4 Gbps/Fibre 
Channel I/O blade.

Universal drive sled (UDS) 
A sheet metal case that houses LTO or SDLT drives in the drive clusters.

WORM 
The Scalar i6000 library supports write once, read many technology in LTO-3 and greater tape drives. 
WORM allows non-erasable date to be written once and provides extra data security by prohibiting 
accidental data erasure.

X-axis 
The horizontal position of the accessor assembly.

Y-axis 
The vertical position of the accessor assembly.
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